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Overview

F4 Overview

This PDF documentation covers version 7.1. To view the documentation of previous versions please refer to the PDF files
available in the Downloads section of our website:
http://www.objectiflune.com/OL/Download/DownloadCenter.

Icons used in this guide

Some icons are used throughout this guide in order to catch your attention to certain particular information.

.+ Notes: This icon shows you something that complements the information around it. Understanding notes is not crit-
ical but may be helpful when using PrintShop Mail Suite.

. Warnings: This icon shows information that may be critical when using PrintShop Mail Suite. It is important to pay
= attention to these warnings.

W
l “8 . Technical: This icon shows technical information that may require some technical knowledge to understand.

Other Documentation

For other related documentation , please see the drop-down menu at the top-right corner of this page.
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About PrintShop Mail

£4 About PrintShop Mail

Developed to simplify the production of variable data printing (VDP) jobs, PrintShop Mail Design is the perfect application for
digital print operations and is a standalone application.

Pre-designed PDF or EPS files are imported into the application and variable information from a database file is overlaid by a
simple drag-and-drop operation. Business rules can be added, and the data can be formatted and sorted using an expression

wizard.

On the output side, PrintShop Mail Design caches static elements of the print job, which results in an optimized print stream
that minimizes network congestion, decreases ripping time and allows digital printers to run near or at rated speed.

A VDP assembly technology, PrintShop Mail Design removes the need to use plug-ins to graphics design tools. Users can
simply take the provided designs and overlay the variable data and variable images.

For more information about the possibilities of PrintShop Mail, please visit http: //www.printshopmail.com/
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Getting Started

L4 Getting Started

Installing PrintShop Mail . . 11
Hardware Key and LiCeNSe . . 12
Upgrading PrintShop Mail L 13
Installing @ Printer DriVer . 14

This section will get you started with the installation and setup of PrintShop Mail, as well as its activation procedure.

Installing PrintShop Mail

Before you start

If you are installing PrintShop Mail on a computer with Windows 2000, XP, 2003 or Vista, make sure you are logged in with full
administrative rights before running the installation program.

Installing in Windows

Rom" refers to the download location of the software and "Setup.exe" refers to a file that may be called

| Your installation file may have been delivered digitally or downloaded through our website. In this case, "CD-
"PrintShop Mail Suite 7.exe"

1. Locate the setup.exe file on the CD-ROM.

2. Double click this file to start the installation wizard.

The installer loads the setup (this may take a few minutes).

Select the language you want to use for the installation then click OK.

4. If your computer is missing prerequisites necessary for PrintShop Mail to be installed, a dialog appears and indicates

that they will be installed.

Click Next to download and install the required components.

6. Awarning is displayed indicating that PrintShop Mail Web will be installed with a demo license, if it is installed. Click

OK to dismiss the message.

Click Next. The License Agreement page is shown.

8. When you have read and understood the license agreement, click on I accept the terms of the license agree-
ment. Click Next.

w

b

N

|£. You must accept the terms of the license agreement to continue.

9. Check the features that you want to install with PrintShop Mail. You cannot unselect PrintShop Mail itself, but can choose

not to install its optional components. If you want to install PrintShop Mail Web, check that option. Click Next.

10. The Destination Folder screen displays the drive and folder where PrintShop Mail Suite will be installed. To install the
software elsewhere, click Change... and navigate to the desired folder.

11. The Program Folder name determines the name that appears in the Start Menu. Keep the default name or change the
name as desired, then click Next.

12. Click Next to start copying the files and install the software. The Setup Wizard starts installing the files.
When the copying is complete, the final window appears.
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Getting Started

You may check Check for Updates to check for updates after the installation has finished (recommended).
13. Click Finish to complete the installation of PrintShop Mail Suite.

Installing on Mac OS

l '/~ PrintShop Mail 5.4 is supported on Mac OS 10.4.11 through 10.9.X.

Locate the PrintShop Mail 5.4.x.dmg file on the CD-ROM or download location.

Double click on this file.

Select the language you want to use for the installation.

Read the license agreement and select " Agree". (If you select " Disagree" , the installation will be canceled).
A window will be displayed " Opening PrintShop Mail 5.4.x.dmg".

You can drag the PrintShop Mail icon to the Applications folder or to any other location on your computer.

ounhrwwnN =

Hardware Key and License

Without a hardware key, also known as "Dongle", PrintShop Mail runs in Designer mode. In this mode, all PrintShop Mail func-
tions are available, but you can only print up to 25 records per session and a watermark is printed over each layout output.

You can use each credit on your hardware key to print one record.

To install the hardware key
This is a picture of the USB hardware key (though your key may differ slightly in appearance).

-

s

-

The Hardware Key
Windows

« Attach the hardware key to the USB port on your computer.

Though Windows should recognize your key by default and install it without intervention, in some cases it may not be
able to do so. In these cases, you will need to manually download and install the Aladdin HASP key drivers, available
online at: http://www.aladdin.com/support/hasp/enduser.aspx

Mac OS

Attach the hardware key to the USB port on your computer.
Start PrintShop Mail

From the Help menu, select Install Dongle Software...
Follow the instructions on the screen

PN
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To activate the hardware key

Windows

1. Attach the hardware key to the USB port on your computer.
2. Start PrintShop Mail Suite
3. From the Help menu, select Activate Upgrade. The Activate Upgrade dialog appears.

After you have received an activation code, you can copy/paste it
in the box below and press "Activate”

Activation code:  |==2984%hg%hn3doyrhtgoHiwh 3 3awe4857ag
odthisisafakecode4s /dorteventnit 3730

Activate l [ Cancel

4. Copy and paste the Activation code that was provided to you when you redeemed your voucher, in the Activation
code box.
5. Click on Activate

To view credit information on the hardware key:

1. Start PrintShop Mail.
2. From the Help menu, select Credit Information.

The Credit Information dialog will also display your License type, Serial Number, remaining credits as well as the Features
included in your dongle. The Features are usually the OL Care Maintenance agreement end date and other possible features
depending on the version.

Upgrading PrintShop Mail
The hardware key contains the license information of the PrintShop Mail application.
To view the license information, select Help/Credit Information.

To use certain features in PrintShop Mail, your license must be upgraded before you are allowed to use this feature. This count
for the amount of credits, CARE, automated printing and multi user licenses.

Credits

Unlimited or Production version, allows unlimited records to be printed.
Limited or Standard version, allows 200,000 records to be printed.
CARE

The care date determines which PrintShop Mail version is licensed. Each PrintShop Mail version has an own release date,
which is compared with your care date. If your care date is equal or newer than the release date, the application will run as
licensed, otherwise the application will run in demo mode.
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Cross Platform

All current PrintShop Mail dongles are cross platform and any user that has a valid OL Care contract can request a voucher for
a cross platform license.

PrintShop Mail upgrade options

The Upgrade options are only enabled when the PrintShop Mail hardware key is attached to the computer where the upgrade
procedure is performed.

To upgrade your hardware key
From the Help menu, you can select from three different upgrade menu items:

« Voucher: If you have a PrintShop Mail voucher number, click on the "Voucher" option. A PrintShop Mail voucher web
page will open. Here you need to enter the voucher number and some additional information to confirm the request.

. Upgrade request: If you want to add credits, upgrade the version, add OL CARE or another option, click on the
"Upgrade" option. The PrintShop Mail Upgrade page will open. Here you select the options you want and some addi-
tional information to confirm the request.

« Activate dongle: If you have received an Authorization code back from your voucher or upgrade request (by email),
you have to copy that code into the Activate dongle screen. Then click "Activate".

Installing a Printer Driver

PrintShop Mail is capable of generating PostScript and non PostScript output.
PostScript output

To generate PostScript output, PrintShop Mail must communicate with a PostScript printer driver. The PrintShop Mail installer
installs a PostScript printer which will be used by the application to generate PostScript output.

We recommended that you use either the Adobe or Microsoft printer driver in order to install your own printer.
Adobe PostScript Driver

Printer installation using the Adobe PostScript driver requires the AdobePS installer and a PPD (PostScript Printer Description)
file.

For more information about Adobe PostScript Driver, please visit www.adobe.com.

Microsoft PostScript Driver (Windows only)

You can install a printer using the Microsoft PostScript driver with the Add Printer wizard in the Windows Control Panel.
The wizard prompts for an INF file containing printer specific information.

Non PostScript output

When you want to print to a non PostScript printer, you just have to select the printer driver for that printer. PrintShop Mail will
print through that printer driver non optimized output. Printing and spooling time will be significantly slower compared to other
print technologies like Optimized PostScript.
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£4 The PrintShop Mail program interface

The PrintShop Mail Program Window . . 15
PrintShop Mail Toolbars . . 16
Dockable Panels . L 22
Properties Panel . 26
Manipulating ObJects . 34
Formatting TeXt il 40
The Preferences WINAOW .. L 46
Layout BasiCs 61
Supported Image FOrmats . 65
Windows Shorteuts . .. 65
Macintosh Shorteuts .. 67

The PrintShop Mail Program Window

The PrintShop Mail Program Window is divided into multiple sections:
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The PrintShop Mail program interface

® Untitled * - PrintShop Mail
'o B e Dest e Yot et Dedes Sl

Jlepes. @ oo ‘;i‘o' v ="

e BAT AN (10) S 2, VDT T —

For Help, press F1 Layout: 1/1  29.55% Tray: Aukomatically Seleck T 371215,90 % 279,40 mm

The PrintShop Mail Program Window and its components: (1) The Menu contains all of the useable menus referred to in this
documentation. (2) The "Standard Toolbar" (page 17) lets you manipulate documents as well as clipboard functions. (3) The
"Text Formatting Toolbar" (page 17) lets you set text and paragraph styles and formatting. (4) The "Objects Toolbar" (page
18) lets you manipulate object properties. (5) The "Text Link Toolbar" (page 19) lets you set links for text objects. (6) The
"Tools Toolbar" (page 19) lets you add and manipulate objects in your document. (7) The Layout area is where your doc-
ument and its objects appear. (8) The "Dockable Panels" (page 22) display various utilities such as your layouts, variables,
data fields and more. (9) The "Warnings Panel" (page 24) displays warnings about errors in your document. (10) The "View
Toolbar" (page 20) lets you change how you see your document by zooming in and out. (11) The "Database Toolbar" (page
21) lets you navigate through the records in your database.

PrintShop Mail Toolbars

The PrintShop Mail Program Window contains multiple toolbars that can be moved and customized. This section looks at each
toolbar and its buttons.

Main (Top) Toolbar:
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The PrintShop Mail program interface

« Standard Toolbar
« Text Formatting Toolbar

« Objects Toolbar
o TextLink Toolbar

Objects Toolbar:
« Tools Toolbar
Bottom Toolbar:

« View Toolbar
« Database Toolbar

Standard Toolbar

FREE" NN N B WEERS . W S

The Standard Toolbar and its button.
Button Function

1 |Create a new document, based on a blank layout.

Open an existing document.

Save your current document.

Preview the current document.

Print the current document.

Cut the selected object(s).

Copy the selected object(s).

=

=

fe3

=

@ |publish templates to PrintShop Web.
LB

IEE|

£

Paste the selected object(s).

~ |Undo the last action.

L‘!?
™~ |Redo the last action.

I '/~ Toundo or redo multiple actions at one time, click the drop-down button next to the arrow.

Text Formatting Toolbar

Text Formatting

Times Mew Roman 12 ~|B I U|A-~

I
1]
il
(]
&
4L

The Text Formatting Toolbar and its button.
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The PrintShop Mail program interface

Click this button... To do this...

Times: Mew Roman ~ |Select the font name

12 - Select the font size.

B Make the selection bold.

Make the selection italic.

| ~

=

Underline the selection.

Select the font color.

Left align text.

Center text.

Right align text.

Justify text.

Change the text to "Right to Left".

Lax | =\ To o L) ) [

Vertical Layout

Objects Toolbar

= o vy
Obiect - o
| LR . e iy

3 hdr Bh-==0-

To do this...

& Add or Remove anchor.

I= Align left edges to the left edge of the last selected object.

= Align right edges to the right edge of the last selected object.

i Align top edges to the top edge of the last selected object.

Align bottom edges to the bottom edge of the last selected object.

42 Rotate the object 90 degrees counter-clockwise.

Sk Rotate the object 90 degrees clockwise.
v Select the fill color.
= Specify the border width (or no border).
EE Specify the border style
&= Select the border color.
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Text Link Toolbar

TextLink « X

The Text Link Toolbar and its button.
Click this button... To do this...

== Create Forward Text Link.

Break Forward Text Link.

Il

Select Previous Text Box.

E= Select Next Text Box.

Not only can multiple text boxes can be linked together with text flowing between them, they can also be linked
across layouts. See "Linking Text Objects" (page 38) for more details.

Tools Toolbar

Windows

ms _’ AI %{ f. Ed A [l @ m = Q«fﬂ

The Tools Toolbar and its button.

Click this L 10 this...

button...

Q
B

Activates the Select tool. Click on an object to select it.

Activates the Pan tool. You can then click and hold within the design area and move the mouse to pan the area
in all directions (best used when zoomed in).

Activates the edit text tool. Click on an existing text object to edit it (same effect as double-clicking a text
object).

Activates the zoom tool: left click to zoom in, right click or hold down CTRL to zoom out.
Lets you pick a Fill, Text, or Border color based on the RGB values of any pixel on the screen.
Places a PDF file. See Place PDF.

= Places a static image. See Image Object.

2 Places a text object. See Text Object.

E Places a barcode object. See "Barcode Properties" (page 32).

E Places a variable image object. See Image Object.

E Lets you rotate an object to any angle by dragging the mouse cursor.

E Places a "DirectSmile Object" (page 91).

| 4l
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The PrintShop Mail program interface

Click this

button... To do this...

IE' Places an AcceptGiro object.

Mac 0OS

r:{ .

A,

The Tools Toolbar and its button in Mac OS.
Click this button... To do this...

Select the tool.

‘ »

1
1
S EmeE

Select the edit text tool.

|

ek’
1

Select the place variable image tool.

R
R
. et

-|'
|
|

e Place a static image.

Q Select the zoom tool.

View Toolbar

[:@'m ..@ g Ji‘:ﬂ-‘t{’ :.{, -“:":IZ = ﬂ- ISIDAE'. -53?

The View Toolbar and its button.
Click this button... To do this...

Display the Layout Actual Size

i@ Go to the first layout.

[4] Go to the previous layout.
Go to the next layout.

@ Go to the last layout.

= Fit Layout Width

e Display Whole Layout

©2016 Objectif Lune Inc -20- PRINTSHOP MAIL |



The PrintShop Mail program interface

Click this button... To do this...

&, Zoom In
=, Zoom Out
100% *  |Specify the zoom level
1l Show or hide Formatting Marks.
@ Toggle Preview mode.
[l Show or hide the rulers.
Rl Show or hide a specific toolbar.
Database Toolbar
LI - Record 1 of 25

The Database Toolbar and its button.
Click this button... To do this...

e Go to the first record.
* Go to the previous record.
R Go to the next record.
N Go to the last record.
Record 1 Go to the current record.
of 235 Display the total number of records in the database.
) Open the Find Record dialog (see below)
The Total number of records edit box is read-only when a database is open.
When no database is open, you can change the total number of records, in the Database toolbar. To do this, enter the

' desired number of records and press Enter.

The Total number of records edit box is read-only when a database is open.
'+~ When no database is open, you can change the total number of records by entering the desired number of records
and pressing Enter.

Find Record

The Find Record feature is available from the Database menu, the database toolbar or via its shortcut key (CTRL+F). Itis only
available when a database is open, and will be grayed out otherwise.

Though not part of the Database Toolbar, a very useful feature for open databases is the Find Record feature. This feature is
available from the Database menu, or via its shortcut key (CTRL+F). Itis only available when a database is open, and will be
grayed out otherwise.
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The find record dialog appears with the following options:

« Find what: Enter a term (word, phrase, character) to search for.

« Look in: Click the drop-down to select the database field in which to search.

« Match whole word only: Only match if the word is separated. For example, if this is selected the word tom would
not be found in the word tomatoes. If it is not selected, words part of others will be matched.

« Match case: Click to force a match only if each letter of the word is in the same case. For example, if this is selected,
Tom will not be matched with tom or ToM. Otherwise, the search is case insensitive.

« Direction: Select whether to look forward in the records (down) or backwards in previous records (up).

« Find Next: Click to find the next occurrence of the search term.

« Cancel: Closes the dialog.

Dockable Panels

The PrintShop Mail Program makes it easy to view the correct information precisely when you need it, by dividing that inform-
ation into different panels. These panels will change depending on the situation.

These panels can be undocked and moved in order to customize the interface to your liking.

Layouts Panel

The Layouts panel contains the layout(s) and their object(s). The objects are listed as a part of the layout in a tree view.

Layouks
Object M ame Detailz
=l Layout 1
: = Text 2
[ﬂ Image 2 Blue hillz. jpg
. ~l Barcode 6
S Layout 2
[ag Text 3

_] Layou... | 3be variables | gl DataF... | B Fonts | g verific...

The Layout Panel, showing two layouts and a few objects.

Variables Panel

The Variables panel shows the list of variables, the Name, Expression and calculated Resuilt.
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The PrintShop Mail program interface

: Variables o x
Mame % Expression Result
Zipcode [Zipcode] DB 34567
Telephone [Telephone] 321-0958-4557
Prefix [Prefix]
Language [Language] EMGLISH
Initials [Initials] PLM.
Gender [Gender] F
From_sales [From_sales] C, van der Biil
From_bran [From_bran] Branch Den Helder
Firm [Firm] Page Design
Faxnumber [Faxnumber] 321-098-7554
Contactprs [Contactprs] Faoemaker
City [City] Database City
Address [Address] 735 Example Road
l _] Lay... |absVari.. | dbat... | A War. .. | i Verif... |ﬁ:‘Prnp... |

The Variables panel, showing the name, expression and result for each variable.
To edit a variable:

1. Double click on the variable. This will open the Expressions Editor ("The Expression Editor" (page 119)).
2. Modify the expression, then click OK.

To edit a variable's properties and change its category:

1. Click on the variable.
2. Click on the Window menu, then Properties.
3. Change the properties of the variable (see "Variables Properties" (page 31))

To add a Persistent Variable (See "Working With Variables" (page 91) for information on persistent vari-
ables):

1. Right-click anywhere in the Variables Panel, then click on Add Variable.
2. Type the name you want for the variable.
3. Click OK to create it.

To delete a Persistent Variable:

1. Right-click on the variable you want to delete.
2. Click Delete Persistent Variable.

To copy a variable's expression:

Right-click on the variable.

Click Copy Expression.

Right-click on another variable where you want to paste the expression.
4. Click Paste Expression.

wn =

For detailed information about how to format variables, see "Variables Properties" (page 31).

Data Fields Panel

The Data Fields panel will show the field names , database name of the opened database and the number of records it con-
tains.
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The entries you will find in the Data Fields panel in PrintShop Mail, represent data fields that occur in the document. These
fields are either referred to in expressions (for variables or layout conditions, without the need to directly being linked to a
database), or they refer to actual database fields (when the document is already linked to a specific database).

When a data field is used in the PrintShop Mail document, it will have a check mark in the Data Fields panel.
To create a Data Field without opening a database:

Create a variable: @variable@.

Enter the Expression Editor by double clicking on the @variable@ in the Variables panel.
Type: [My data field].

Click OK.

PN

You can browse the records in the database by clicking the browse buttons in the Database toolbar, or by making the following
selections from the Database menu:

« FirstRecord (ALT+Up)

o Previous Record (ALT+Left)

« NextRecord (ALT+Right)

« LastRecord (ALT+Down)

« Record...Allows you to select a specific record.

The following information is displayed for each data field in the database:

I y These Data Fields properties are only relevant for PrintShop Web, they will not affect the behavior of PrintShop
Mail.

« Checkmark: A checkmark will be visible if the data field is used somewhere in your document. If no checkmark is
present, the data field is not used anywhere in your document.

« Name: A unique identifier, either automatically generated or corresponding to the field name in the database. You can-
not modify this value here.

« Value: The value of the field for the current record.

« Type: Displays the type of data in the data field. "Default" means that at the moment no data source is available for
this field. Once there is a data source available, the Type column will display the data type for that field, as specified in
the data source, like number, text, etc.

Warnings Panel

While you are working, PrintShop Mail will dynamically check for any possible errors on the layout and will display any occur-
ring errors in the Warnings panel.

= 5

| Warnings {7) x|

. | Layout  Record = Description
I Object iz not entirely placed on the layout
Object iz placed beyond the printable area
1 Mo image specified
Object iz placed beyond the printable area
Text does not fit in ks bounding box
Yarable "DATE" iz not inked to an expresszion
1 Image "Branch Den Helder"' not found

* Warni... _',_j.. Werific, ..

i)
i)
i)
S
Y
N
fy
]

B3 B3 3 — — —

I

The Warnings Panel, showing any warning that occurs in your document.

Layaouts | abc Yariables | E j Data Fi...
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Fonts Panel

The Fonts panel will show the fonts used in the PrintShop Mail document and any missing font.

Fonts a x
L) This list is only up-to-date For the current record | IJpdate |
_NEIII‘IE QCours in Status
Arial Texk 1 Available
PSMC128Bwr3P720hTE Text 2 Mis=ing
Tahoma Text 4 Hevailable

_] Layouts  sbevariables |y ]DataFi.. | B Fonts| ) verffica...

The Fonts Panel, showing any all the fonts used in your document.

Verification Result Panel

When you select from the Layout menu, Verify Document a progress bar will be displayed, showing the amount of
records being checked. The warnings for the whole document will be listed in the Verification Result panel.

: Verification result (17} o ox

Lapout = Record | Description

Object iz not entirely placed on the lavout
Object iz placed beyond the printable area
Object iz placed beyond the printable area
Tewrt dogs nat fit in its bounding box
Yariable "DATE" iz nat linked to an expression
Image "Branch Den Helder'" nat faund
Ma image specified
Ma image specified
Ma image specified
Ma image specified
Ma image specified
Ma image specified
Image "Branch Leiden' nat faund
Ma image specified
Ma image specified
Ma image specified

1] Ma image specified

alalalalpalal ol ol al o bR LRad LR LR |

e o e et e o e et e ol e e e o e b e e e e e
— D 0D T e L o — =

| _] Layouts |%E§ Yariables |,__j Dnata Fields | B Warnings (73 | _} Yerification res... |—

The Verification Results Panel, showing the results of the Verify Document procedure.

Itis possible to save messages displayed in the Warnings panel and the Verification Results panel by right clicking on
the message and Copy/Paste the text to a text file.
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Properties Panel

You can change the properties for any object in the Properties Panel. The properties of each type of object is separated into
groups.

The following groups are common to all (or most) objects:

Object Group

Option  Description

Name The unique name that identifies an object.

The following limitations apply to "objects name":

« No white spaces leading or trailing.
o Maximum 255 characters.
« Not editable when multiple objects are selected.

Frame Group

Option Description

Lock Pos-
ition
Bounding | Displays the dimensions of the bounding box using the location of the top left corner, and the height and width.
Box These values can also be entered manually.

Locks the position, size and rotation attributes of this object.

Snap Snaps the frame to the proportions of the content.

Frame to | When this option is set to "Yes", the object’s bounding box (frame) will automatically resize to the dimensions
Content | of theimage or resize vertically to accommodate larger amounts of variable text that would otherwise not fitin
(Windows | the text box. When set to "No", a verification warning will be shown, when variables do not fit in the box.
Only) Note: When using text linking, Snap Frame to Content is only allowed for the last object in the chain.

Border Change the border size. You can choose from hairline width, or a pixel width (1-12px). You can also create a
Size Custom Size.

Border You can choose one of the standard colors, or create your own custom RGB, CMYK, Gray or Spot color for the
Color border. To learn more about PrintShop Mail Spot Colors click "Specify Spot Colors" (page 74).

Choose the border style. The following options are available:

« Solid

Border . Squaredot......
Style « Dash—————
(Windows « DashDot—-—-—-
Only) « LongDash—— ——

» Long Dash Dot——-——-

« Long Dash DotDot——--——--
The fill color can be transparent, or it can be set to a solid fill color. The standard Windows palette is available,
Fill Color | butyou can also create your own custom RGB, CMYK, Gray or Spot color. To learn more about PrintShop Mail
Spot colors click "Specify Spot Colors" (page 74).
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Option Description

Rotation |Shows the current rotation applied to the item.

Master Object: Master object name to anchor to.
Anchor Horizontal: Horizontal aspect of the master object to anchor to.
Vertical: Vertical aspect of the master object to anchor to.

Printing Group

Option Description

Print Specifies whether the object will be printed or previewed only.
Global
Scope . . . .
for Specifies whether an image should get Global Scope. Images with a Global Scope can be reused on the printer
across multiple PPML or PPML/VDX jobs. When set to "Yes" images will be stored in a specified Environment and
PPML . — . . . .
. can be reused in others print jobs. This property will be ignored for other technologies.
(images
only)

Text Properties

The Text Properties lets you change all of the properties for any text object in your document. The options available are dif-
ferent in the Windows and Mac OS versions of the software.

To open the text properties in Windows

1. Click on the text object of which you want to display the properties.
2. Click in the Window menu, then click Properties.
3. The Properties window appears or, if it is already present, is brought to the front and selected.

To open the text properties in Mac 0OS

1. Click on the text object of which you want to display the properties.

2. Click on Items, then Show Object Properties. You can also right-click on the text object and select Show Object Prop-
erties from the drop-down menu.

3. The Object Properties dialog appears.

Available Options

All objects share some properties. To see these shared properties (the "Object", "Frame" and "Printing" groups), see Prop-
erties Panel.

Content Group

Option Description ‘
Alignment horizontal |Horizontal Text alignment (Left, Centered, Right, Justified).
Alignment vertical Vertical text alignment (Top, Centered, Bottom)

Copy fitting is a feature that will automatically shrink text by redu-
cing the font size when there is more text than the text box can hold.
The font size will be reduced to the font size needed to fit the textin
the text box. However, text will not be shrunk beyond the specified
minimum font size. When the text needs to be resized, all text will be

Copy fitting
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Option Description ‘
resized step by step until the text fits or the minimum font size is
reached.

Minimum font size: When Copy Fitting is enable, the minimum
size the font can reach is 1, by default the minimum font size is 8.
Allow line breaks is a feature which automatically replaces some
of the blank spaces between words by line breaks, in a way that each
line fits in the viewable window. In PrintShop Mail "Allow line breaks"
is set to Yes by default.

When Copy Fitting is set to "Yes", individual words can be broken due
to word wrap.

When Copy Fitting is set to "No", text only fit if the individual words
are not broken. Text will break on spaces only.

Note: Copy Fitting is not allowed for linked objects.

This setting allows you to remove empty lines in a text box.

When set to "No", empty lines will be shown in the text box. This is
useful where the variable is for instance an address and some
records in the database have empty fields. If you select this function
the empty lines caused by the empty field(s) will be preserved.

When set to "Yes", both empty lines which are caused by empty
fields in the database and white lines which are manually inserted will
be removed.

When set to "Only in variables", all empty lines will be removed in the
variables only, static empty lines will be preserved.

Remove Empty Lines

This setting is specifically designed for vertical text with Asian char-
acters which need to be printed vertically, other characters will

Vertical Layout simply be rotated 90°.
This feature is supported under Windows XP, Windows 2003 and Win-
dows Vista.
LR Mac OS Note: The "Remove Empty Lines" feature can be switched on using a checkbox in the Expression Editor
Tt .
Window.

Data Field Properties

The Data Fields Properties will let you change the properties of data fields that have been defined in a linked database, or
defined manually in an expression. Note that these options are only used when uploading a document to PrintShop Mail Web
as they determine how to collect the information. When using only PrintShop Mail Design, they are ignored.

To open the data field properties

1. Open the Data Fields panel. To do this, click the Window menu, then click Data Fields.

2. Click on the data field of which you want to change the properties.

3. Click in the Window menu, then click Properties.

4. The Properties window appears or, if itis already present, is brought to the front and selected.

Available Options
Data Field Group
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« Name: A unique identifier, either automatically generated or corresponding to the field name in the database. You can-
not modify this value here.

. Default Value: You can set a Default Value here, this will be a string value that will be displayed in PrintShop Web,
once the document is published, as a placeholder when no data source is available (yet) for this Data Field. You will find
this string value back in PrintShop Web, after the document has been selected (before the stage where a data source is
provided).

« Remarks: You can define a Remark here, this will be a string value that will be displayed in PrintShop Web once the
document is published. You can use this, for example, to give clients a hint about this variable data field.

Publication Group

« Source: The data source can be either "Database", a database uploaded by the PrintShop Web client, or "User input”,
data provided by for example a web form.

Image Properties

The Image Properties lets you change all of the properties for any image object in your document. The options available are
different in the Windows and Mac OS versions of the software.

To open the image properties in Windows

1. Click on the object of which you want to display the properties.
2. Click in the Window menu, then click Properties.
3. The Properties window appears or, if it is already present, is brought to the front and selected.

To open the image properties in Mac 0OS

1. Click on the object of which you want to display the properties.

2. Click on Items, then Show Object Properties. You can also right-click on the object and select Show Object Properties
from the drop-down menu.

3. The Object Properties dialog appears.

Available Options

All objects share some properties. To see these shared properties (the "Object”, "Frame" and "Printing" groups), see "Prop-
erties Panel" (page 26).

Content Group

Set this option... To specify...

Alignment horizontal | Horizontal alignment of the images (Left, Centered, Right).

Alignment vertical Vertical alignment of the images (Top, Centered, Bottom).

Here you can specify options on how the image is resized relative to
the bounding box.

Original size: The image is always shown in its original size, regard-
less of the size of the frame. Original size resets the image content to
Scale (Windows) 100%.

Clipping (Mac 0S) Fit in Frame: The image will be resized to fill the frame, maintaining
the image aspect ratio, showing the actual scale percentage of the
image. Images are not clipped.

Crop to Frame: Proportionally scales the images filling the entire
frame. Images may be clipped.
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To specify...

Image Filename

Displays the image filename. The contents can only be changed
through the Expression Editor.

Image Folder

This points to the path where the variable images are stored. Clicking
on the icon allows you to browse to a different search folder.

Search Subfolders

Specify whether PrintShop Mail should only look for files in subfolders.
When set to "No" PrintShop Mail will only look in the current folder.
When set to "Yes" PrintShop Mail will look in subfolders as well.

Page Number

The PDF page number represents the page number in the original PDF
file, ranging from one to the number of pages in the PDF. An image
object can be linked to a single PDF file. As a PDF can contain multiple
pages you can specify the page(s) to be used in your document
through an expression (TOTALPAGES), in that case you can use vari-
able pages within that PDF file. If the page number refers to a non
existing page, a warning will be shown in the warnings panel:"Page
number X is invalid; this file contains Y pages only.

Two Color
(Windows only)

Convert to Two Colors: When set to "No" images will shown it's
original color. Setting this option to "Yes" will convert the image to two
colors.

Threshold: Lets you specify at which luminosity percentage to con-
sider the background color to be transparent. The default value is
50%, values are 0% to 100%.

Background Color: Convert background color to specified color.
Foreground Color: Convert foreground color to specified color.

The following limitations apply to "Two Color" option for images:

« The Two Color option does not support the image format EPS.

« Two Color option will be disabled when using the Print Technology specific options, OPI, APR and Do no send images

(VIPP).

« The Print Technology PPML support the Two Color option, when you check "Embed Images in PDF" in the Print Dialog.

PrintShop Mail for Windows preserves the color space in images format EPS, TIFF and JPEG. To learn more about

Color Management, click "Color Settings" (page 47).

PrintShop Mail for Macintosh converts the color space that is embedded in the image to the color space of the printer
driver. You can check the color space of the printer driver, selecting from the File menu, Print/ColorSync.

Layout Properties

When you select a layout in the Layouts panel, the following properties will be displayed:

Option Description

Layout Name of the selected layout.
Name
Layout Size Size of the selected layout.

More information about this topic , can be found in Specify the Layout Size.

Description | Select a standard size: Fit to Page (Default), Fit to Objects, Custom Size, A3, A4, A5, B5, US Letter, US Legal.
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Option Description

Width Enter custom width. This setting is editable if you select "Custom Size".
Height Enter custom height. This setting is editable if you select "Custom Size".
Paper Size Size and orientation of the paper for the current layout.
P More information about this topic can be found in Page Setup.
_ Select the paper size for the selected layout. The paper size depends on the printer driver selected in the Page
Description )
Setup dialog.
Width The width of the page.
Height The height of the page.

If your printer supports different paper trays and your document consists of multiple layouts, you can send dif-
Paper Tray [ ferentlayouts to different trays.
More information about this topic can be found in Select Paper Trays

The action to be performed for this layout, PRINT, BLANK or SKIP.
More information about this topic can be found in Use Layout Condition.

Action

Number of | Number of copies to be printed for the selected layout, must be at least one.
copies More information about this topic can be found in Number of Copies.

Variables Properties

The Variables Properties lets you change all of the properties for any variable used in your document. This panel is only avail-
able in the Windows version of PrintShop Mail.

To open the variables properties

1. Open the Variables panel. To do this, click the Window menu, then click Variables.

2. Click on the variable of which you want to change the properties.

3. Click in the Window menu, then click Properties.

4. The Properties window appears or, if it is already present, is brought to the front and selected.

Available Options
Variable Group:

« Name: This value can only be changed for global variables (it cannot be changed for variables created by objects, or
typed in a text box).

« In Use: This value cannot be changed, it displays whether or not the variable is used by any text object.

« Persist: Indicates whether or not the variable is persistent. For more information on persistent variables, see "Work-
ing With Variables" (page 91).

Format Group:
. Category: Sets the category of the variable. Changing the category will change the rest of the available options.
Text Category: This category does not have any options. Text variables have no special formatting and are displayed as-is.

Email Category: This category does not have any options. Email variables will only accept values that correspond to a valid
email address: [identifier]@[domain].[tld]

Date Category: This category is used for dates used in your documents, and has the following options:
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« Locale: Specify the locale and language used for the date.
. Date Format: Specify the exact format of the date (available options depends on the locale)

Currency Category: This category is used for amounts in your local currency, and has the following options:

« Locale: Specify the locale and language used for the currency display.

« Currency Symbol: Specify what symbol will be used for currency.

« Positive Format: Specify how positive currency amounts will be displayed.

« Negative Format: Specify how negative currency amount will be displayed.

« Decimal Symbol: Specify what character is used to separate the amount with its decimals (for example, dollars and
cents)

. Decimal Places: Specify how many decimal places to display after the decimal symbol. Note that the amount will be
rounded to the last decimal displayed.

« Digit Grouping Symbol: Specify what character is used to separate groupings (for example, a space or comma to
separate thousands, millions, billions)

« Digit Grouping: Specify how many digits to group together (for example, 3 for north-American currencies).

Number Category: This category is used to display numbers. It has the same options as the currency, except for the fol-
lowing options:

« Positive Format is not displayed

« Currency Symbol is not displayed

« Leading Zeroes is added: Specify how many leading zeroes to add at the end of the decimal places, up until the num-
ber specified by the decimal places option.

Barcode Properties

The Barcode Properties lets you change all of the properties for any barcode object in your document. The options available
are different in the Windows and Mac OS versions of the software.

To open the barcode properties in Windows

1. Click on the object of which you want to display the properties.
2. Click in the Window menu, then click Properties.
3. The Properties window appears or, if it is already present, is brought to the front and selected.

To open the barcode properties in Mac 0S

1. Click on the object of which you want to display the properties.
2. Click on Items, then Show Object Properties. You can also right-click on the text object and select Show Object Prop-

erties from the drop-down menu.
3. The Object Properties dialog appears.

Available Options

All objects share some properties. To see these shared properties (the "Object", "Frame" and "Printing" groups), see Prop-
erties Panel.

Content Group

A The Content group options may change depending on the barcode. The greatest majority of barcodes have the fol-
lowing options only.
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Option Description

The expression used as data for the barcode. Please refer to the doc-
umentation for your barcode reader or the barcode itself to learn
which information is supported for any particular barcode. See "The.
Expression Editor" (page 119). Note that the data should never con-
tain barcode functions such as onecode() or postnet() , as the bar-
code object itself takes care of formatting the string.

Select the encoding type, either String or Hexadecimal. Refer to
the barcode reader documentation to know what option to choose.

Horizontal: Select whether the barcode itself is aligned at the left,
center or right of the barcode object.

Vertical:Select whether the barcode itself is aligned at the bottom,
center or top of the barcode object.

Data

Encoding

Alignment

Barcode Group

A_. The Barcode group options may change depending on the barcode. The greatest majority of barcodes have the fol-
lowing options only.

Option Description

Specifies the barcode type that will be printed. For a list of available
Type barcodes in PrintShop Mail, see "Barcodes Supported by PrintShop
Mail" (page 86).

Specifies the width of the barcode object (and not the barcode itself).
It can be automatic or manually entered.

Module Width

Aligns and resizes the barcode in order to correctly fit your print area.
Align to Pixel Raster |This ensures a more precise output at the printer since the barcode
bars will now precisely fit within your printer's output resolution.

Dot gain occurs when ink bleeds or spreads as it is absorbed by

paper, enlarging the pixels. The amount of dot gain varies for each
printer and depends on ink coverage on the printing press. You can
compensate for the effect by specifying a value between 0 and 100 for
the Dot Gain Compensation property (0 disables the feature).

Dot Gain Com-
pensation

The quiet zone is the blank margin on either side of the barcode that's
Quiet Zone used to tell the barcode reader where a barcode's symbology starts
and stops. You can specify any value in points in this box.

Indicates whether you want a human-readable

(alphanumerical) string to appear below or above the barcode, or
none at all. This option is only visible on barcodes that support
human-readable text.

Human Readable Text

Specifies the font size for the human-readable text, when it is avail-

F ,
ont Size able.

Specifies the check digit method to calculate the barcode's check digit.
Select Automatic to use the default for this barcode, or select another
check digit method. Refer to your barcode reader's documentation to
know which option to enter here.

Check Digit Method
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'“‘?LE,. Mac OS Note: PrintShop Mail 5 for Mac OS still uses fonts to create its barcodes.

DirectSmile Properties

The DirectSmile Properties lets you change all of the properties for any DirectSmile object in your document. The options avail-
able are different in the Windows and Mac OS versions of the software.

To open the DirectSmile properties in Windows

1. Click on the object of which you want to display the properties.
2. Click in the Window menu, then click Properties.
3. The Properties window appears or, if it is already present, is brought to the front and selected.

Available Options

All objects share some properties. To see these shared properties (the "Object”, "Frame" and "Printing" groups), see Prop-
erties Panel.

DirectSmile Group

Option Description

The IP, network computer name or domain name of a server where
Host DirectSmile Generator is installed. Clicking on this opens the Dir-
ectSmile Editor window.

The image set used to generate the image, from a list of available sets
Image Set on the DirectSmile Generator server. Clicking on this opens the Dir-
ectSmile Editor window.

These expressions determine the text that will appear in the Dir-
Text on Layer X ectSmile image that is being generated. The number of available prop-
erties (X) is determined by the image set and will be one or more.

LR Some DirectSmile templates may not be designed to support all characters of a language. In this case, a warning may
== pop up, or the generated image may contain no personalization.

Manipulating Objects

You can manipulate objects that are on the page easily using the tools in this section. For more information on the different
types of objects you can use, see "Objects in PrintShop Mail" (page 83).

Selecting Objects
There are several ways to select objects.

« Select a first object then press SHIFT or CTRL while clicking on another object on the layout.
« Drag a selection box (lasso) around more than one object.
« From the Edit menu, choose Select All or press CTRL+A (Windows) or Command+A (Mac OS)
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To select underlying objects

If you cannot select an object with a mouse click because it is covered by another object, repeatedly press the TAB key to
cycle through the objects on the visible layout.

Press SHIFT+TAB to select the previous object.
To extend a selection
There are several ways to extend a selection. You can:

o Press and hold SHIFT or CTRL to ensure that any active selection is not cleared.
« Toextend the current selection, press and hold SHIFT while left clicking on additional objects.
« Totoggle an object selection state, press and hold CTRL while left clicking on the object.

| “:;l_i, You can also combine the use of SHIFT and CTRL with the lasso object to add multiple objects at once.

Moving and Resizing Objects
To move objects using the mouse
Windows

1. Select one or more objects.
2. Leftclick on the selection and drag it to the new location.

| '/~ While dragging, the objects will be snapped to any nearby guide line.

Mac OS

1. Select one or more objects.
2. Click on the selection, hold down the mouse and drag it to the new location.

To move objects using the keyboard
Windows

1. Select one or more objects.
2. Use the arrow keys on your keyboard to nudge the selection to a new location on the layout. (Each nudge offsets the

objects by one pixel.)
To move objects by entering the new coordinates (to place an object at a specific location)
Windows

1. Select the object.
2. Inthe Properties panel/ Bounding box, enter the desired Left and Top position.

Mac OS
1. Select the object.
2. From the Item menu, select Show Object Properties, or press Shift and double click.
3. InPosition, enter the X and Y coordinates.
4. Click OK.
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To resize an object using the mouse

1. Select the object.
2. (Windows): Left click on one of the sizing handles.

(Mac 0S): Click on the sizing handles and hold down the mouse button.
3. Drag the handle to resize the object.

For static images, resizing always maintains the original aspect ratio of the image. For any other object, resize pro-
'+ portionally by holding down the CTRL key while dragging. While dragging, the sides of the objects that you are res-
izing will be snapped to any nearby guide line.

To resize an object by entering the new dimensions
Windows

1. Select the object.
2. Inthe Properties panel/ Bounding box, enter the new Width and Height.

Snap Frame to Content
Snap the frame to the proportions of the content.

When this option is set to "Yes", the object bounding box (frame) will automatically resize according to its contents. In case of
animage it will resize to the dimensions of the image. In case of text (static or variable) it will resize vertically to accom-
modate larger amounts of text that would otherwise not fit in the text box. When set to "No", a verification warning will be
shown at printing time, when objects do not fit in the box.

| ‘-~ When you have linked text boxes, Snap Frame to Content will only work for the last text box in the chain.

Mac OS

Select the object.

From the Item menu, select Show Object Properties, or press Shift and double click.
In Position, enter the new Width and Height.

Click OK.

AN

Copying Objects
To copy objects using the mouse

1. Rightclick and drag one or more selected objects to another location.
2. Release the mouse button.
3. Onthe menu, choose Copy Here to create duplicates of the selected objects.

To copy objects using the clipboard

1. Select one or more objects.
2. From the Edit menu, select Copy or press CTRL+C in Windows, COMMAND+C in Mac OS.

To paste an object in the clipboard

1. Go to the layout where you want to paste the object.
2. From the Edit menu, select Paste or press CTRL+V in Windows, COMMAND+YV in Mac OS.

| '+~ You can paste the contents of the clipboard to any layout, even in a separate instance of PrintShop Mail .
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To paste objects to multiple layouts
If your document consists of more than one layout, you can create multiple copies throughout your document. Choose either:

. Edit, then Paste To and then Entire Document to paste the contents of the clipboard to every layout in your doc-

ument.
« Edit, then Paste To and then Remainder of Document to paste to the remainder of your document (for example,

to every layout, starting with the next layout).

l 4 Ifthe current layout happens to be the last layout in your document, the option Remainder of Document is not
available.

Aligning Objects

You align the edges of the objects in the selection to the object LAST selected. You can align to the left, right, top or bottom
edges of the object.

To align objects:

« In Windows:
1. Select the objects which you want to align, ending with the object you want to align to.
2. Either use one of the alignment buttons in the Tools toolbar, or go to the Object menu then Align Edges and
click one of the options.
« InMacOS:
1. Hold down the Shift key while you select the objects you wish to align, or draw a box (lasso) that encloses all
objects that need to be aligned.
2. From the Item menu, select Align.
3. Select one of the available options from the submenu. (see figure below)

Mac OS Alignment options:

Alignment Option Description

Left Edges To align the selected objects along their left edges.

Right Edges To align the selected objects along their right edges.

Top Edges To align the selected objects along their top edges.
Bottom Edges To align the selected objects along their bottom edges.
Horizontal Centers | To align the selected objects along their horizontal edges.
Vertical Centers To align the selected objects along their vertical edges.

.+ Ifyou don'tknow which object you selected last, for example if you selected everything with Select All or pressing
—— CTRL+A, reselect the object to align to, while holding down the SHIFT key.

Arranging Objects
You can move objects in front or behind each other.

1. Select the object.
2. From the Object menu, select Arrange. You can also right click on the selection and select an option from the sub-

menu under Arrange.
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3. Select the appropriate option:
« Bring to Front: To move the object in front of all other objects.
« Bring Forward: To move the object one position forward.
« Send Backward: To move the object one position backward.
« Send to Back: To move the object behind all other objects.

Locking Objects
Locking an object, protects it from accidental changes in size or position. The text in a text box remains editable, however.
To lock an object

1. In Windows:
« Select the object.
« From the Object menu, select Lock Position. Alternately, right click the object and choose Lock, or from the

Properties panel change Lock Position to Yes.
2. In Mac OS:
« Select the object.
« From the Item menu, select Show Object Properties, click on Unlocked. Alternately, from the Item

menu select Lock Position.
To unlock an object

1. In Windows:
« Select the locked object.
« From the Object menu, select Unlock Position. Alternately, right click the object and choose Unlock, or
from the Properties panelchange Lock Position to No.
2. In Mac OS:
« Select the object.
« From the Item menu, select Show Object Properties, click on Locked. Alternately, from the Item menu

select Unlock Position.

Linking Text Objects

Multiple text object can be linked together in order to have text overflow between them.

Text objects can be linked within a page, but they can also be linked between pages (Page Overflow).
To link text objects

Make sure the destination text object(s) to which you want your text to flow towards already exists.

Select the first text object.

From the Text menu, select Create Forward Link, or on the Text Link toolbar, click the Create Text Link button.
Point with the mouse cursor to the text object where you want your text to overflow towards (the destination object).

AN

When you move the mouse over a text object which can be linked to, the border of this object will become green if it is pos-
sible to link to this object, and red if this is not possible.

Anchored Objects

Anchored objects are items, such as images or text boxes, that are connected to each other in such a way that a change in pos-
ition or size of the Master object will affect the position of any number of Child objects.
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An example use of this technique is to add a signature at the bottom of a letter. If the letter has a height that changes between
records, the text box could potentially be too small (the signature is too far down) or too large (the text goes over the sig-
nature). This can happen if, for example, your text box contains a variable that displays the content of a database field with
text that can vary in size. Using the Anchor tool, you can force the signature (Child) to lock to the bottom of your text box
(Master) , moving up and down as the height of the text object changes.

L}
Dear Customer. 1

The rising start of digital printing
stechniques. ... B

[Kind Regards,

Two anchored objects: (1) the Anchor Master, (2) Distance between the Master and Child, (3) Anchored Child.
To anchor two object through the "Objects Toolbar" (page 18)

Select the object to be anchored (anchor Child).

In the Object toolbar, click on the “Add or Remove Anchor” button.

Move the mouse over ancther object (anchor Master).

Left click on this object that serves as anchor Master to link the two objects together.

PN

To anchor two object through the "Properties Panel" (page 26)

1. Select the object to be anchored (anchor Child).
In the Properties panel, click on the Anchor property, to expand the Master Object property.
3. Select the name of the anchor Master object.

N

l '/~ When anchoring objects, the object will be highlighted in green if it is a valid anchor Master or in red if it is not.

To remove anchoring through the "Objects Toolbar" (page 18)

« Select the anchored object (anchor Child).
« Inthe Objects toolbar, click on the “Add or Remove Anchor” button, to remove the anchor.

To remove anchoring through the "Properties Panel" (page 26)

« Select the anchored object (anchor Child).
« Inthe Properties panel, click on the Anchor property, to expand the Master Object property.
« From the drop down menu, select the “empty” option.

.+ AChild object can only have one Master, but a Master can have more than one Child. To change the Master of a Child
object, start by removing the anchor for the Child, then add a new anchor to the other Master.
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Anchor settings
Anchor settings can be changed in the Properties panel of the object.
Horizontal anchors:

« Left: The anchor Child position will be relative to the left side of the anchor Master.
« Right: The anchor Child position will be relative to the right side of the anchor Master.
« Width: The anchor Child width will be relative to the width of the anchor Master.

Vertical anchors:

« Top: The anchor Child position will be relative to the top side of the anchor Master.
« Bottom: The anchor Child position will be relative to the bottom side of the anchor Master.
« Height: The anchor Child height will be relative to the height of the anchor Master.

Default Setting:
These defaults will be selected when you first create the anchor between a Child and Master, depending on the position:

« Ifthe anchored Child is positioned to the left of the anchor Master, the Horizontal position will be set to Left.

« Ifthe anchored Child is positioned to the right of the anchor Master, the Horizontal position will be set to the Right.
« Ifthe anchor Master is positioned under the Child, the Vertical position will be set to Top.

« Ifthe anchor Master is positioned above the Child, the Vertical position will be set to Bottom.

When resizing or moving an anchored Child, itis possible to modify the distance between two anchored objects.

When an anchor Master object is deleted, the link between the Master and Child objects is broken. In the Properties panel of
the Child object, Master Object property, will get the suffix “Unresolved”. To re-establish the anchor, you can either link the
Child to a new Master, or create a new object and call it the same name as the previous Master.

Formatting Text

Text formatting in PrintShop Mail can be applied in three different ways. You can apply styles directly to part of your text (see
"Text Style" (page 40)), apply formatting to a paragraph (see "Paragraph Style" (page 42)), or use "Rich Text File" formatting
by using the Text_File function and an external .RTF file (see "TEXT_FILE" (page 153)).

Text Style

You can change the text style (for example, font name, size, color, and style properties) of any part of the text in a text object
or for multiple text objects.

PrintShop Mail offers multiple ways of formatting your text. These styles can be combined for better control.

« Bold (example)

« Underlined (example)
« Italic (example)

« Superscript (ex@mpley

» SUbSCript (eyample)
« Strikethrough (example)

You can also modify the following text properties:
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« Font: Change the fonts using available system fonts (see PrintShop Mailk Fonts section below)

. Font Size: Allows you to make the fonts look bigger or smaller.

« Font Color: Allows you to change the color of a font.

« Kerning: Selects whether special character pairs (such as A and W) are detected and placed closer together, in order
to conserve space. Note that not all fonts support kerning, and that this feature is not supported on Windows 2000.

« Tracking: Allows a uniform adjustment of spacing between all characters in the text. Lower tracking compresses text
together, while higher values spreads the text apart.

LR In MacOS, the terms Kerning and Tracking are reversed than in Windows. For simplicity's sake, we use the Windows
== names in this documentation.

To change the styles and properties, first select either a text object, multiple text objects, or any number of characters within a
text object. Then use one of the following options:

e In Windows:
« The Text menu allows you to change the following styles: Font Size, Bold, Italic, Underline, Font Color, Kern-
ing, Tracking.
« The Font dialog (menu Text -> Font...) allows you to change the following styles: Font, Font Size, Bold,
Italic, Underline, Font Color, Superscript, Subscript, Strikethrough
« The Font toolbar allows you to change the following styles: Font, Font Size, Bold, Italic, Underline, Font Color
e InMac OS:
« The Text menu allows you to change the following styles: Kerning, Baseline (subscript/superscript), Bold,
Italic, Underline, Font Color.
« The Fonts dialog (menu Text, Font, Show Fonts) allows you to change the following styles: Font, Font
Size, Bold, Italic, Underline.
« The Font Toolbar allows you to change the following styles: Font, Font Size, Bold, Italic, Underline, Font
Color.

You can also use keyboard shortcuts to control some of the styles:

o CTRL+B (Windows) or COMMAND+B (Mac OS): triggers Bold
o CTRL+I (Windows) or COMMAND+I (Mac OS): triggers Italic
o CTRL+U (Windows) or COMMAND+U (Mac 0S): triggers Underline

Note: The text style of a variable depends on the style of the first delimiter, the character marking the beginning of a variable.
(Applying style to variable = apply style to first marker)

Note: The precision of a font size is up to 0.5 points. For example, a font size of 10.5 points is allowed, but 10.3 is rounded to
the nearest half (10.5).

PrintShop Mail Fonts

PrintShop Mail, just like any other software on your system, enables you to use any font installed in your system folders. Addi-
tionally (in Windows only), PrintShop Mail can also read any font file located in the same folder as the PrintShop Mail Docu-
ment, or a Fonts subfolder located in the same folder as the PrintShop Mail Document.

Windows Only: Font reading priority: If you have fonts of the same name in all three possible locations, the priority in which
PrintShop Mail reads the fonts is as such: Fonts in the same folder as the document are checked first. Fonts in the Fonts sub-
folder are checked second. Fonts in your operating system fonts folder are checked last.

Fonts can always be used by multiple PrintShop Mail Documents.
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Paragraph Style
A paragraph is a contiguous range of characters sharing formatting properties such as:

« Alignment

« Margins

« Indentation

« Tabstops

« Formatting marks
« Copy Fitting

Paragraphs are separated by carriage returns. To start a new paragraph, press ENTER while you are typing text.
To align text
To apply alignment to all paragraphs in one or more text objects:

1. Select the objects.
2. (Windows): Click an alignment button in the Text Formatting toolbar. Alternatively in the Properties Panel, select

Alignment.
(Mac 0S): Click an alignment button in the Text Formatting toolbar. Alternatively from the Text menu, select Align-
ment.

To apply text alignment for a specific paragraph:

1. Double click in a text object to enter Edit mode.

Select a paragraph.

3. (Windows): Click an alignment button in the Text Formatting toolbar. Alternately, from the Text menu, select Para-
graph. In the dialog box, you can specify alignment, margins and first line indentation values. An appearance sample
is provided to preview the current settings.

N

2| Faragraph x

General

alignrment; -LEHI b

Indentation

Left: 0 = , il First line: | 0 s mm
Right: 0 :J mm
Previgw

[The quick browmn fox pumps over the lamy dogz. The quek browm fox punps over
the lazy dog.

ok | | cCancel |
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(Mac 0S): Click an alignment button in the Text Formatting toolbar. Alternatively from the Text menu, select Align-

ment.

Text direction

To apply text direction.

1.
2.

Double click in the text box to enter in Edit mode.
In the Text Formatting toolbar, click on the Right to Left button.

Windows

About tab stops

Tab stops enable you to line up text to the left, right or center.

You can select the following tab stops:

EI LeftTab  Textextend to the right from the tab stop.

El Center Tab Text is centered at the tab stop.

EI Right Tab Text extends to the left from the tab stop until the tab's space is filled, and then the text extends to the right.

To set and change tab stop positions

To change default tab stop positions:

1.
2.
3.

To set and remove custom tab stop positions, there are two methods available:

From the Text menu, select Default Tab Stops.
Choose your interval value.
Click OK.

« Use the Tab Stops dialog box.
« Use the horizontal ruler.

To use the Tab Stops dialog box:

1.
2.
3.

Double click in a text object to enter Edit mode.

Select a paragraph.

From the Text menu, select Tab Stops.

Tab stop positions are relative to the left side of the text object.
To add a position, type a value in the edit box and click Set.

To add alignment, you can select:

Left: Left text extends to the right from the tab stop.

Center: Center text is centered at the tab stop.

Right: Right text extends to the left from the tab stop until the tab's space is filled, and then the text extends to the

right.
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6. Toremove a position and alignment, select it in the list box and click Clear.

| Tab Stops x
| mm
B - Alignment
[ &0 | eft
Center
Right
| Clear || Clearall |
| 0k | | Cancel |

Formatting marks

PrintShop Mail enables you to control whether formatting marks are hidden or visible in text objects. Formatting marks are
newlines, tabs, and spaces. By default, after starting PrintShop Mail, all formatting marks will be hidden.

You can tell PrintShop Mail to show formatting marks by selecting from the View menu Formatting Marks, or by using the
button "Show or Hide Formatting Marks" on the View toolbar. This works as a toggle for all text objects.

Formatting marks are just a visual aid, they will not be printed. The marks will scale to the zoom factor of your document, and
they will scale to the font size of the surrounding text. They will also be visible while you're editing text.

New line symbol:

Space symbol: .

Tab symbol: (right arrow)
Copy Fitting

Copy fitting is a feature that will automatically shrink text by reducing the font size, when there is more text than the text box
can hold. The font size will be reduced to the font size needed to fit the text in the text box. However, text will not be shrunk
beyond the specified minimum font size. When the text needs to be resized, all text will be resized step by step until the text
fits or the minimum font size is reached.

Minimum font size

When Copy Fitting is enabled, the minimum font size the font can reach is 1; by default the minimum font size is 8. The downs-
izing of the text in the box stops if one of the containing font sizes reaches the minimum value or if the text fits.

Allow line breaks

By default the Allow line breaks feature is set to Yes.

When Allow line breaks is set to "Yes", the texts only fit if the individual words are not broken. Text will break on spaces
only. It can occur that lines are broken at spaces, but individual words won't be broken.

When Allow line breaks is set to "No”, the text won't break at spaces, only at returns. The text will be downsized until it fits
(or gives a warning if it still doesn't fit)

To change this option:
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Select the text box. If you have multiple text boxes, you can select all of them.
Inthe Properties Panel/ Content, select Copy Fitting.

Set Reduce Font Size to Yes.

Change the Minimum Font Size to the desired value.

PN

Mac 0OS
To change Paragraph settings

You can set the space between lines of text by using the Spacing pop up menu on the PrintShop Mail ruler when a text box is
in edit mode.

' Spacing I-'-‘*]

! ¥ Single
Couble

Other...

To set the line spacing, double click on the text object and select the text you want to adjust and choose Single, Double, or
Other from the Spacing pop up menu.

If you chose Other, choose options for:

« Line height: Distance from the top of a line to the top of the line below it.
« Inter-line spacing: Distance from the bottom of a line to the top of the line below it.
« Paragraph spacing: Distance from the bottom of a paragraph to the top of the first line in the paragraph below it.

Line height multiple 1.0 : times
:, Exactl Yy
! 0.0 : points
Line height ™ At least A
] At most 0.0 . points
Inter-line spacing 0.0 : points
before 0.0 :1 points
Paragraph spacing :;
after 0.0 : points

'J_ Cancel 1 [ ok Y

To change default tab stop positions:
You can set margins, paragraph indentation, and text tabs by using the ruler in the edit mode of the text box.

There are four kinds of tab stops and two types of margins, each indicated by a differently shaped icon:
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« Arightfacing triangle indicates a tab stop at which text will be left justified.

« Adiamond indicates a tab stop at which text will be centered.

« Aleftfacing triangle indicates a tab stop at which text will be right justified.

« Acircle indicates a decimal tab stop at which numbers will be justified around a decimal point.
« Adownward facing triangle indicates a page margin.

« Ahorizontal rectangle indicates the indentation of the first line of a paragraph.

To use the horizontal ruler:

1. Leftclick on the horizontal ruler to add a paragraph marker.
The marker type depends on the state of the paragraph marker button in the intersecting area of the two rulers (top-
left).

2. Leftclick the paragraph marker button to cycle through all possible paragraph marker types, including first line indent-
ation, or right click this button to select a marker type from the menu.

Note: You can also use the horizontal ruler to specify left and right margins. To do this, left click on the position of either the
left or right side of the text box and drag the margin to the desired location.

Copy Fitting
To change this option:

Select the text box.

From the Item menu, select Show Objects Properties.
In the Object Properties, change Copy Fitting to Yes.
Change the Minimum Font Size to the desired value.

PN

The Preferences Window

The Preferences window lets you set up preferences and settings for PrintShop Mail as well as for the currently opened doc-
ument. This section demonstrates each section of the Preferences window and its features.

Program Settings

,+ The Program Settings section applies to your whole PrintShop Mail Design software, not just to this document. When
changing these options, they will remain the same between all your documents and templates.

1. (Windows): From the Edit menu (CTRL+K), select Preferences.
W (Mac 0S): From the PrintShop Mail menu (Command,), select Prefer-
ences .
2. Inthe left pane, click the Program Settings icon.

About general preferences

Set this option... To do this...

Variable Markers Specify the characters that delimit (enclose) the variables in your text objects. See
Measurement in Select the unit of measurement for PrintShop Mail.

Items without database Specify the total number of records when no database is open.

Interface language (Windows

Only) Specify which language you want to use.
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To do this...

Interface theme (Windows
Only)

Specify the appearance of the application user interface. It is possible to choose from:
Classic, Blue, Aqua.

Panels fade out (Mac OS
Only)

When inactive, panels from the Window menu fade out, moving the mouse over a
panel fades it back in.

About layout appearance preferences

Set this option... To do this...
Bleed Specify color.
Folding lines Specify color.
Crop marks (Mac OS Only) [ Specify color.

Printable area

Specify the order in which the printable areas are drawn, relative to the objects. Top spe-
cifies that the areas are always visible, Bottom that they are obscured by objects.

Guide lines

Specify the order in which the guide lines are drawn, relative to the objects. Top specifies
that the lines are always visible, Bottom that they are obscured by objects.

Magnetic strength

Define guide line sensitivity when moving or resizing objects. When the cursor comes
within the specified pixel range on either side of a guide line the object snaps to it.

Generate EPS for vertical
text objects(Mac OS Only)

During printing, PostScript for vertical text object is generated in an alternative way.

Color Settings

Color Management compares the color space in which a color was created to the color space in which the same color will
be outputted, and makes the necessary adjustments to represent the color as consistently as possible.

The Color Settings section applies only to this document. When changing these options, they are saved with your doc-
ument and may change when opening or creating a new document.

PrintShop Mail Color Management is designed to accurately display the same on-screen color as the color on the printed
output. When you install PrintShop Mail, the color space profiles (Adobe ICC Profiles) will be installed in "Win-
dows\System32\spool\drivers\color\" . When staring PrintShop Mail, the application will load the profiles allowing you to
define colors for the different objects placed in your document.

PrintShop Mail handles the Color Management at two levels:

1. PrintShop Mail originated colors. The colors defined in PrintShop Mail for objects, like border color, fill color and text

color.

2. PrintShop Mail Embedded Color Management. The colors defined for certain image file types, like TIFF, EPS, JPG

PrintShop Mail does not change the Color Management of your image, if your image files have embedded color pro-
files, these colors will not be overruled by PrintShop Mail’s Color Management.

To enable Color Management:

From the Edit menu, select Preferences or press Ctrl+K and click on the Colors icon.

1. Check the option “"Enable color management”.
2. Inthe working space section select your desired color profile.

3. Click Apply.
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When Color Management is enabled it is possible to change the working spaces profiles, which allows for colors to be adjus-
ted.

The default working space color profiles settings are:

« RGB: sRGB

o CMYK: U.SWeb Coated (SWOP) v2
o Gray: Gamma 1.8

« Rendering: Absolute colorimetric

For example
Suppose you have a colored text box with the following CMYK values:

« Cyan: 100 %
« Magenta: 0%
o Yellow: 0%
« Black: 0%

These values are an indication of the color intended to be printed, but because of the different monitors, printers, inks, types of
paper these values may yield a different color on the printed output.

To avoid this, Color Management translates colors with the help of color profiles.

The colored object will change slightly depending on the chosen color profile, but in the Properties panel the CMYK values for
that color will stay the same.

Rendering

Rendering is the process of converting one color space to another color space. The result of choosing a rendering intent
depends on the content of documents and on the profiles used to specify color spaces. Some profiles produce identical results
for different rendering intents. Differences between rendering intents are apparent only when you print a document or convert
it to a different color space.

The following rendering intent options are available:

« Absolute colorimetric
o Perceptual
« Relative colorimetric
« Saturation

In a Color Management workflow, you can use the precision of color profiles to soft proof your document directly on the mon-
itor. You can display an on-screen preview of how your document’s colors will look when reproduced on a particular output
device. The reliability of the soft proof depends upon the quality of your monitor, the profiles of your monitor and output
devices. To preview how the color will look when printed, select Print Preview and click ColorSoft proof.

Soft proof colors show the color profile defined in the Color Management.

l '+~ This feature is enabled when Color Management is activated.

Color Management for on-screen preview is different from Color Management reproduced in a particular output device. You
have more control over the appearance of the document on a particular output device than with on-screen preview, because
your document may appear on a wide range of possible uncalibrated monitors and video display systems which limits control
over the color consistency.
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To control the color consistency itis possible to assign a color profile to the monitor. In a workflow such a profile would be
provided by the monitor manufacturer or the profile would be created using specialized equipment that measures the mon-
itor's color space.

To provide a practical means for color consistency, you can change the monitor color profile to match your output device. To
do this:

Windows 2000 and Windows XP

In the Control Panel, select Display.

Click on the Setting tab.

Click on Advanced

Select the “"Color Management” tab.

Click on Add, to add the desired monitor color profile for your documents

mihwn =

| '+~ You need to restart PrintShop Mail for the changes to take effect.

Windows Vista

In the Control Panel, select Personalization.

Select Display Settings from the list.

Click on the Advanced Setting tab.

Select the "Color Management” tab.

Here you can add color profiles for each device on your system (monitor and printers).

5. Click on the Advanced tab and from the drop down menus select the desired color profiles.

PN

Print Job Settings

,+ The Print Job Settings section applies only to this document. When changing these options, they are saved with your
document and may change when opening or creating a new document.

To specify print job preference settings

(Mac 0S): From the PrintShop Mail menu (Command,), select Prefer-
ences .
2. Inthe left pane, click the Print Job Settings icon.

é 1. (Windows): From the Edit menu (CTRL+K), select Preferences.
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Print margins —
Center

* Offset  Top: |0

Left: | O
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Bottom: | 0 mm

Right: | 0 | mm

Technology: | Cptimized PostScript -: -

I\

Adobe PostScript

Optimized PostScript stores all recurring data in reusable forms,
which will only be sent to the printer once.

Troubleshooting —

v | Print report page

|2}

Send custom error handler

| o4 || Cancel || Apply |

About print job preferences

Set this option...

To do this...

Print Margins

Print Margins are empty spaces all around the page. The margin (top, bottom, left, right) is usu-
ally the empty space between where the page is cut and the layout area of the page.

PrintShop Mail allows you to make changes to the print margin for all layouts in the document. It
is possible to:

« Center (Windows only): Where the layout(s) will be centered on the paper.

« Offset: Where you can specify different values for each print margin: Top-Bottom (Y off-
set) and Left-Right (X offset).

« Note: PrintShop Mail supports different paper sizes within one document. Print Margins
settings will be applied to the whole document.

Technology

Select which print technology is used to optimize your PostScript output. See "Print Technologies"
(page 51) for more information on these options.

Print report page

Specify that a report page is printed at the end of the job.

Send custom error
handler (Windows

only)

Specifies whether a Postscript error will generate a custom error page containing tips on how to
solve the problem. Leave this box unchecked if you want your printer to handle any errors.
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Print Technologies

Because every print technology uses PostScript Level 2, PrintShop Mail requires the use of a PostScript printer driver and a
PostScript Level 2 compatible RIP.

Some technologies are based on the PostScript standard, which means that they are supported by every type of RIP available.
Other technologies are based on extensions of PostScript, which are only supported by specific RIP types.

Printing Technologies:

« Standard PostScript
« Optimized PostScript
« Adobe PDF and Adobe PDF/VT-1

RIP type and vendor dependent technologies:

. AHT

o CreoVPS

« Fiery FreeForm

o Fiery FreeForm 2

. PPML

« PPML/VDX 7(Windows only)
« PrintStreamer(Mac OS only)
. VIPP

If you want to print to a non PostScript printer, you just have to select the printer driver for that printer. PrintShop Mail will print
through that printer driver non optimized output. Printing and spooling time will be significantly slower compared to other print
technologies like Optimized PostScript.

To select a print technology

1. (Windows): From the Edit menu (Ctrl+K), select Preferences.
(Mac 0S): From the PrintShop Mail menu (Command,), select Preferences.

2. Inthe left pane, click the Print job icon.
The Print job settings dialog box appears.

3. Check if your RIP supports one of the RIP type and vendor dependent technologies. If so, you can select that specific
technology. If not, it is advisable to select Optimized PostScript.

I 14 You can also select the print technology directly from the Print dialog. Simply click on the currently selected print tech-
nology and select the one you want from the drop-down.

To specify technology specific options

1. From the File menu, select Print.
2. Onthe Print dialog box, specify technology specific options .

Standard PostScript

Standard PostScript does not use any special optimization mechanism, except that you can use OPI to speed up spooling.
Use this technology if your system does not support any of the other technologies.

Optimized PostScript

Optimized PostScript caches image data in reusable PostScript forms. This speeds up the printing process, since each unique
image is only sent once.
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- Some printer drivers offer the possibility to change the PostScript Output Options: "Optimize for Speed" or "
v Optimize for Portability". For a maximum print speed, change the PostScript Output Option to "Optimize for
Speed". You can find this property in the Printer driver/Advanced Options.

GDI Printer Output

The GDI Printer Output (or Windows Driver Output) Print Technology allows you to print to a non PostScript Printer, using a
Windows printer driver installed on your system.

This option is not available in the Preferences panel with the others Print Technologies. GDI Printing will be automatically
applied when selecting a non Postscript printer in the Page Setup or in the Print Dialog.

When selecting a non PostScript printer the print output will not be optimized, printing and spooling time will be significantly
slower compared to other technologies. This is because the job needs to be converted into the Windows printing language
(EMF) before being sent to the printer.

The Print Dialog will show the following message:

"The selected printer driver is not a Postscript Level 2 compatible device. Printing speed will be reduced and some features
might not be supported”.

The following features might not be supported by non Postscript printers:

« Subset finishing

« Color Management
« Spot color

« Caching

Adobe PDF

Adobe PDF Print Technology allows you to save optimized PDF output files to disk directly from PrintShop Mail. The PDF output
files can be used for printing to PostScript level 3 printers and soft proofing when uploading PrintShop Mail documents to
PrintShop Web.

When using “"Adobe PDF” Print Technology, itis advised to activate Split job option for the best performance.
Adobe PDF/VT-1

The Adobe PDF/VT-1 (or VT1) print technology is a VDP type of file, similar to PPML/VDX and VPS files. The PDF/VT-1 format
was created by Adobe as an alternative to vendor-specific VDP technologies that were only available on certain printers,
instead creating a more "open" format that could be compatible with more printer brands and models.

The main features of Adobe PDF/VT-1 Technology are:

. Image Caching: Each image is saved at the beginning of the file and each instance of the image points to this saved
copy, which means images are never repeated.

« Printing Speed: On printers that can natively print PDF/VT-1 files, the print speed is much higher compared to reg-
ular PDFs.

For more information about the PDF/VT technology, see this post on adobe.com's forums.

Print dialog box settings

« PDF Settings: Select one of the .joboptions files on the system. .joboptions are generally created by Adobe Distiller
and saved in specific folders (look for joboptions in the Adobe Distiller manual for your versions to learn the location of
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the joboptions files).
JobOptions Location

The .joboptions files that are listed in the PDF Settings box can be located in two different folders, depending if they are doc-
ument-specific or shared between documents.

« Document-specific .joboptions files should be placed in the same folder as your PrintShop Mail Design Document
(-psmd) file. It will not be visible from any other document.

« Global .joboptions files should be placed in a specific shared location, which (on any system) can be accessed through
the following folder: %oAllUsersProfile% \Shared Documents\Adobe PDF\Settings\

AHT

Select this technology if you have an AHT RIP. AHT uses an optimization mechanism similar to Optimized PostScript.
Print dialog box settings

1. Store forms on printer's hard disk
2. Custom cache size
3. Use OPI, don't spool images

Creo VPS
VPS (Variable Print Specifications) is a PostScript language extension, created and maintained by Creo.

It allows PrintShop Mail to classify each element on a page as either reusable (occurring more than once) or inline (occurring
only once). This distinction allows the VPS RIP to decide when image data can be reused. This avoids unnecessary repeated
processing and speeds up the print process.

One of the main differences between Optimized PostScript and VPS is that VPS re-uses rasterized data instead of PostScript.
Print Technology specific setting

Use Automatic Picture Replacement: Automatic Picture Replacement (APR) allows you to speed up the printing process
by using the image substitution capabilities of your VPS RIP. The image format support of APR is limited to EPS, but some RIP
versions support other formats like TIFF and JPEG.

.+ While previous versions of PrintShop Mail gave the option not to generate booklets, this has been removed since ver-
sion 7.0 because it caused the output not to be valid according to Creo.

Fiery FreeForm and FreeForm 2

FreeForm jobs make use of the fact that the data in your document is divided in two layers, which contain the text and image
objects in the document.

The master layer in a FreeForm job consists only of "static" objects, but the variable layer can contain a mix of both variable
and static objects, depending on the order of the objects on your layout. This is a consequence of the fact that FreeForm does
not allow data in the master layer to be printed on top of data in the variable layer.

These layers are sent to the FreeForm RIP in two separate jobs, not necessarily at the same time. The master data job is ras-
terized first, and stored under a user defined numeric ID. The RIP overlays the rasterized master data with the rasterized data
of any variable data job that references the same ID. In this way, you can reuse the same master data for different variable
data jobs.
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How the objects are separated

Static objects have content that remains constant throughout the entire record set. An image object is static when it has an
expression with a constant result. A text object is static when it does not contain any variable markers. A PDF object is always
static. All other objects are considered to be variable. A variable object is reusable when its content is the same for at least two
different records in the record set.

At printing, PrintShop Mail tries to assign as many static objects to the master layer as possible, starting with the object at the
back of your layout, and working towards the front. All static objects up to (but not including) the first variable object are putin
the master layer. All other objects make up the variable layer. Any reusable data in the variable layer will be cached in
PostScript forms.

.+ When using FreeForm and FreeForm 2, try to make sure that static objects are not placed on top of variable objects
in the object order on your layout.

FreeForm does not fully support layout conditioning. In particular, it does not allow you to conditionally skip layouts. When
SKIP is used, a BLANK page will be printed instead.

FreeForm 2 is an extension of FreeForm. The differences are:

1. FreeForm 2 fully supports layout conditioning.
2. The FreeForm 2 master ID consists of a name instead of a number.

Preference settings

« Form number (FreeForm): A numeric ID used to identify the master data job.
« Master ID (FreeForm 2): An alphanumerical name used to identify the master data.

Print Technology specific settings

Along with the regular print dialog box settings (see Print a Document), Fiery Freeform has these options:

« Send Master data: Send only the Master (template) to the Fiery server.
« Send Variable data: Send only the variable data, assuming the Master is already presentin the Fiery server.
. Send Master and Variable data: Send both the Master and Variable data together.

PPML

PPML is short for Personalized Printing Markup Language . A PPML file describes the entire personalized printing job and con-
tains all necessary elements to print the contents (layout and variable data).

The technology PPML in PrintShop Mail is very similar to PPML/VDX. The difference is that the content (PDF) and page layout
description (PPML) are sent separately.

Windows
Print Technology specific settings

1. Create ZIP archive: When checked, the PDF and PPML files will be zipped before being sent to the printer. This

option is used for specific printers, which expect a PPML-ZIP file. The ZIP file contains the PPML and the PDF file.

Embed images in PDF: When checked, all images will be embedded in the PDF.

3. Environment: The path specified in the Environment setting will place the images with a "Global Scope" in the Envir-
onment. The Consumer (RIP) stores and/or caches the images for later use.

4. Send.

N

4.1- Send "All Images": A PDF file will be created containing images that have a "Global Scope" or a "Local Scope".
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This option also creates a PPML job, using this PDF, with instructions to use the Local and the Global images. Images

with a "Global Scope" are stored in the specified Environment. After this job the "Global images" can be reused for recur-

ring print projects, for example with the option "Send Local Images".

4.2- Send "Global Images": A PDF file will be created containing images that have a "Global Scope". This option also
creates a PPML job, using this PDF, with instructions for storing these images into the specified Environment.

4.3- Send "Local Images": A PDF file will be created containing images that have a "Local Scope". This option also
creates a PPML job, using this PDF, with instructions to use these Local images and the Global Images that are stored in
the specified Environment. For that reason, images that have a "Global Scope" should be present in the specified Envir-
onment. Images with a "Global Scope" will only be referenced in the PPML job.

Note: The settings "Environment" and "Send" should not be changed when you are not familiar with PPML terms!

For more information about PPML, visit the Website of PODi (Print On Demand Initiative), http: //www.podi.org.

PrintShop Mail offers an option to define if an image should have a "Global Scope". If the Global Scope of animage is set to
"Yes" in the Properties Panel, the image will have a "Global Scope". For recurring print projects, a central benefit of PPML
is its ability to reference Reusable Objects using Global Scope. This feature allows for transmitting smaller datasets and elim-
inates repetitive processing of the reusable content.

Note: Please make sure that your RIP supports at least PPML 1.5, including the "application/pdf" source format.

Printing speed can be improved by using a "Global Scope" for one or more images, or possibly (depending on your RIP) by
unchecking the "Embed images in PDF™ checkbox in the Print dialog.

Mac 0OS

When using PPML as Print Technology, printing directly to the printer/RIP will result in the output being placed o the Desktop
(either a ZIP file or a folder), which conatins the PPML file and (if used)images recurring in the document. In order to print the
PrintShop Mail document you need to download the output to your printer/RIP.

PPML/VDX 7

PPML/VDX is an abbreviation for Personalized Print Markup Language/Variable Data Exchange. The output consists of an
optimized PDF in which reusable content elements occur only once. The PDF also contains a block of PPML data that describes
the page layout.

Note: PPML/VDX 7 requires both Adobe Acrobat(r) and Distiller(r) to be installed on your system.

To help ensure correct output there are "PSMail joboptions" files for the Acrobat Distiller versions 5, 6, or 7 in the Printshop
Mail installation folder.

These settings will tell Acrobat Distiller how to handle fonts, color, images, etc., when it creates the optimized PDF.

If so desired, you can change these output options for PPML and VDX by changing the Distiller joboptions. Double click on the
"joboptions" file you want to modify, change and save it.

Note: PSMailx.joboptions files should be saved in the PrintShop Mail installation folder, next to the executable. The "x" spe-
cifies the Acrobat Distiller version that the file corresponds to.

More information about the Acrobat Distiller joboptions can be found in the online Help of the Acrobat Distiller.
Print Technology specific settings

1. Environment: The path specified in the Environment setting will place the images with a "Global Scope" in the Envir-
onment. The Consumer (RIP) stores and/or caches the images for later use.
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2. Send

2.1- Send "All Images": A PDF file will be created containing images that have a "Global Scope" or a "Local Scope".
This option also creates a PPML job, using this PDF, with instructions to use the Local and the Global images. Images
with a "Global Scope" are stored in the specified "Environment". After this job the "Global images" can be re-used for
recurring print projects, for example with the option "Send Local Images".

2.2- Send "Global Images: A PDF file will be created containing images that have a "Global Scope". This option also
creates a PPML job, using this PDF, with instructions for storing these images into the specified Environment.

2.3- Send "Local Images": A PDF file will be created containing images that have a "Local Scope". This option also
creates a PPML job, using this PDF, with instructions to use these Local images and the Global Images that are stored in
the specified Environment. For that reason, images that have a "Global Scope" should be present in the specified Envir-
onment. Images with a "Global Scope" will only be referenced in the PPML job.

PrintStreamer

This printing technology sends two separate files to the RIP, one master file and one with variable data.

/| PrintStreamer is only available on the Mac OS edition of PrintShop Mail Design. It is not available in the Windows edi-
= tion.

Print dialog box settings

1. Use OPI, don't spool images
Print Technology specific settings

1. Send Master and variable data
2. Send Master data
3. Send Variable data

VIPP

VIPP is an acronym for Variable data Intelligent PostScript Printware. The output of this technology consists of a PostScript
stream in which reusable images occur only once.

The main difference between VIPP and Optimized PostScript is that images are cached using a proprietary VIPP specific mech-
anism instead of PostScript forms. The cached images are stored in print ready format.

Print Technology specific settings

1. Don't spool images (EPS, TIFF, JPEG): This option allows you not to send the recurring images twice to the RIP.
The output will only contain references (by filename) to images stored in the project folder.

2. Project Folder:This option allows you to store recurring images on the fly, and before printing the job, to a "project
folder" on the (VIPP enabled) RIP. The folder name can be specified in the Print Dialog.

Encapsulated VIPP supports the following image formats: JPEG, TIFF, EPS and PDF.

Note: This technology requires a RIP that has been enabled for Encapsulated VIPP, and a hardware key that has been
upgraded to enable VIPP. For more information on how to upgrade the hardware key, see Upgrading PrintShop Mail.
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Repetition Settings

The Repetition Settings lets you specify how a layout is repeated on your page. This is known as Multi-Up printing, or N-Up
printing where N represents the number of repetitions within a page (for example 2up, 4up or 8up). See "Use Layout Repe-

tition" (page 93) for more information.

The Repetition Settings section applies only to this document. When changing these options, they are saved with your
document and may change when opening or creating a new document.

To specify repetition preference settings

1. (Windows): From the Edit menu (CTRL+K), select Prefer-
ences .
(Mac 0S): From the PrintShop Mail menu, select Prefer-
ences .

2. Inthe left pane, click the Repetition Settings icon.

About repetition preferences

Set this option... To do this...

Specify how the actual multi-up is done. The number
between parentheses indicates the maximum number of
repetitions possible with the current layout and print set-
tings.

Layout Repetition « Horizontal repetition: Specify the amount of lay-
outs positioned in the horizontal direction (number of
columns).

« Vertical repetition: Specify the amount of layouts
positioned in the vertical direction (number of rows).

Specify the horizontal and vertical distance between each

S e e layouts when using layout repetition.

Shows the repetition order on the page. When the defined
Horizontal and Vertical repetition does not fit on the page,
the layouts on the left and bottom are represented with a
dash line.

Specify the priorities (1,2,3) and direction (Left to Right,
Right to Left, Top to Bottom, Bottom to Top, Front to Back,
Back to Front) in which the records in your document are
going to be printed. You can specify:

Repetition Preview

Priorities . Left to Right, Right to Left: Influences the hori-
zontal repetition.

« Top to Bottom, Bottom to Top: Influences the
vertical repetition.

« Front to Back, Back to Front: Allows printing
Through-the-stack

Specify that the positions of the layouts on the back of each
page should match de positions of the layouts on the front of

Mirroring
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Set this option... To do this...

each page. In effect, the layout positions on the back will
mirror the layouts in front of the page.

« Based on driver settings: The document will be
printed duplex according to the settings in the printer
driver, provided the driver supports this.

« Flip on long edge: Layouts in the back side of the
page will be mirrored through the long edge of the
page.

« Flip on short edge(Windows only): Layouts in
the back side of the page will be mirrored through
the short edge of the page.

« Simplex: The document does not require mirroring
of the layouts.

When selecting Based on Driver Setting, the Pre-
IA. view dialog will not show the correct mirroring
since it cannot read the printer's settings.

PrintShop Mail for Windows supports mixed layout sizes, except when layout repetition is used. When using layout
repetition, the first layout size will be the layout size for the complete document.

L
R
1h
—

Imposition Settings

4 The Imposition Settings section applies only to this document. When changing these options, they are saved with
your document and may change when opening or creating a new document.

To open the Impositions preference dialog:

1. (Windows): From the Edit menu (CTRL+K), select Preferences.
:_j (Mac 0S): From the PrintShop Mail menu (Command,), select Prefer-
== ences .

2. Inthe left pane, click the Imposition Settings icon.

Available options:

. Bleed Margins: This specifies bleed margins (see "Bleed Margin" (page 64))
. Page Level (Windows Only): To add bleed to the page, the bleed is positioned around a set of layouts, thus
keeping the layout size the same as before.
« None: No bleed margin will be used.
« Include in Job: To subtract the bleed margin from your layout, the bleed is positioned around each layout,
thus keeping your layout size the same as before.
« Width: To set the width of the bleed margin.
« Crop Marks: Specify crop marks settings (see "Crop Marks" (page 64)). This option is only available if the Bleed Mar-
gins is not set to None.
« None: No crop marks will be drawn.
« Standard: One line will be indicated for each trim position.
. Japanese: Two lines will be indicated for each trim position.

©2016 Objectif Lune Inc -58 - PRINTSHOP MAIL Bl



The PrintShop Mail program interface

« Double Sided: When using duplex and you select this option the crop marks will be printed in both sides of the
paper.
« Gap size: Specify gap size as the distance between the actual crop mark and the edge of the layout.
« Color (Windows Only): Itis possible to select a color for the Crop marks.
« Folding Lines: Specify the length of folding lines. (See "Folding Lines" (page 63))
. Center Layouts on page (Mac OS Only): Select this option to center layouts on the physical paper.

PrintShop Mail Web Settings

Use the settings bellow to fill in the URL and the login account for your company Web Server. See Publishing Documents, for
more information about creating and publishing PrintShop Mail documents to PrintShop Web.

,+ . The PrintShop Mail Web Settings section applies to your whole PrintShop Mail Design software, not just to this doc-
ument. When changing these options, they will remain the same between all your documents and templates.

To specify PrintShop Web Preference settings

1. From the Edit menu (CTRL+K), select Prefer-
ences.

2. Intheleft pane, click the PrintShop Mail
Web icon.

About PrintShop Web preferences

Set this option... To do this...

Server address
(URL)

Specify the company Web Server.

Login (Username | Specify the username and password assigned by the administrator to log in the company Web Server.
and Password) If you do not have an account, please contact your Web server's administrator.

Test Con-
nection...

Also publish data-
base

To establish a connection with the publication server.

To add the opened database to the published document.

PlanetPress Suite Settings

PlanetPress Workflow Tools is a powerful printing software for transforming and distributing print jobs from virtually any host.
Transforming and distributing print jobs allows for automated local and remote printing, integrated PDF generation for archiv-
ing, emailing and faxing.

4 The PlanetPress Suite Settings section applies only to this document. When changing these options, they are saved
with your document and may change when opening or creating a new document.

Options for the PlanetPress Suite can be added to a PrintShop Mail output job through the Preferences panel, which enables
you to send PrintShop Mail output to a location or queue that is being watched by PlanetPress Workflow Tools. This makes that
PrintShop Mail output can be further processed to be archived or emailed or sent by fax.

For example, PDF files can be automatically generated and mailed to addresses defined by the customer.
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Defining fields in PrintShop Mail

1. Create a PrintShop Mail document.

2. From the File menu, select Preferences, click on the Publish to Web icon.
Make sure the Server address and login settings are empty.

3. Click on the PlanetPress Suite icon.

4. Define the output type for your document.

To do this...

Number: Specify the fax number from the data fields of the currently opened database or the vari-
able you created.

Description: Specify the description from the data fields of the currently opened database or the
variable you created.

Fax

Number: Specify the email address from the data fields of the currently opened database or the
variable you created.

Subject: Specify the email subject from the data fields of the currently opened database or the
variable you created.

Body text: Specify the email content from the data fields of the currently opened database or the
variable you created.

Email

PDF Book-

Create a standard PDF bookmark.
mark

Name: Defines a descriptive name for the archive or for the item to be archived.

SICHRE Variable: Specify a data field of the currently opened database or the variable you created.

5. Click on the Publish to Web icon in the Standard toolbar or from the File menu select the submenu Publish to
Web.

6. When you click Finish in the Publish to Web dialog, a window will be opened to save the document as a zip file.

7. PlanetPress Workflow Tools captures the PostScript file (zip fle) and routes it to the appropriate device to output the doc-
ument.

For more information about PlanetPress Workflow Tools, please visit http: //www.objectiflune.com/

Default Settings

When you start PrintShop Mail, it always opens with a blank document that uses default settings for the layout sizes and other
preferences. You can change those preferences so that new blank documents will have your own, custom settings. This can
be a time saver if you often create new documents and have to set your preferences each time.

To modify the default preferences:

1. Close your currently opened document by clicking on the File menu then selecting Close.
2. Open the Preferences menu:
« InWindows: From the Edit menu, select Preferences (or use the CTRL+K keyboard shortcut)
« InMac OS: From the PrintShop Mail menu, select Preferences (or use the £+, keyboard shortcut)
3. Make the changes you want to any of the sections of the preferences.
4. Click OK in the preferences window to save the changes.

Starting from now, any new document that you create will use these preferences. To change the default settings in the future,
simply repeat these steps.
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To reset PrintShop Mail to its default settings

You can reset the preferences to the default settings that were in effect when you first installed PrintShop Mail.

1. Close PrintShop Mail

2. Double-Click on the PrintShop Mail icon on your desktop, or click on it from the Start Menu, Programs, PrintShop
Mail Suite 7

3. Immediately when the Splash Screen appears, press and hold the CTRL and SHIFT keys on your keyboard.
The following dialog is displayed:

wehich part of PrintShop Mail do wou want bo reset?

Windaw pasitions

Toolbar configuration

[ |Preferences

4. Check the settings that you want to reset to the defaults:
« Window positions: Resets all of the windows and panels to their original, default locations and states.
. Toolbar configuration: Resets the position, order and appearance of all the toolbars and their buttons to
their original defaults.
« Preferences: Resets all of the Preferences to their original defaults, except for the language of the interface.
5. Click OK to apply the reset and open PrintShop Mail.

Layout Basics
A PrintShop Mail document can consist of multiple layouts.
To insert a layout

1. From the Layout menuy, select Insert.
2. Choose where you want to insert the layout.
3. Click OK.

To see your current layouts:

« In Windows: Open the "Layouts Panel" (page 22) from the Window menu.
« Mac 0S: Select Show Document Layouts from the Window menu.

To duplicate a layout

1. Go to the layout which needs to be duplicated.

2. From the Layout menu, select Duplicate.
Alternatively (Windows): in the Layouts Panel, right click on the layout you want to duplicate and from the submenu
select Duplicate.
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Alternatively (Mac OS): in the Layout Panel, click on the layout you want to duplicate, then click on the plus sign at
the lower right corner of the panel.

To remove a layout

1. Go to the layout which needs to be removed.

2. From the Layout menu, select Remove.
Alternatively (Windows): in the Layouts Panel, right click on the layout you want to remove and from the submenu
select Remove.
Alternatively (Mac OS): in the Layout Panel, click on the layout you want to remove, then click on the minus sign at
the lower right corner of the panel.

To change the layout size and orientation

1. From the Layout menu, select Size.
2. Make the appropriate changes.

Under Windows, you can apply the changes to:

« Selected Layout

o Current Layout

« This point forward
« Whole document

I '+~ Under Mac OS, PrintShop Mail does not support multiple layout sizes within one document.

Guide Lines

Guide lines are non printing grid lines to help you to arrange and position objects. Moving or resizing objects to within a certain
distance of a guide line causes the selection to snap to the line.

To add a guide line

Windows
1-Insert from the Insert menu
From the Insert menu, select Guide line
Select Horizontal or Vertical line.
Drag the mouse to the exact position where you want to place the guide line and left click on it.
E 2-Insert from the Ruler
I Right click on the ruler. The contextual menu will show “Guide line” and “Folding line”.
Select Guide Line.
Use the horizontal ruler to add a vertical guide, and the vertical ruler to add a horizontal guide. Left clicking on a ruler
adds either a guide line or a folding line, depending on the icon displayed in the top left corner of your work area.
Mac
From the View menu, select Layout Ruler. Select either a horizontal or vertical guide line.
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Note: When you drag a guide line, its default behavior is to snap to any existing objects. You can change this behavior by
selecting or clearing the Guides Snap to Objects option in the View menu..

To set the "snap to" distance

Set the distance required for objects to snap to guide lines in Program settings, under Magnetic strength. The indicated number
of points is the distance from the guide, within which an object will be drawn to the guide position.

To modify a Guide line position

1. Select the Guide line.
2. Rightclick onit.
3. From the menu select “Position”.
The window will show the current coordinates of the Guide line.
4. Enter the new coordinates for the line position.

To remove a guide line

Itis possible to remove a guide line by dragging it to an invalid location outside the layout. The drag cursor is updated to reflect
whether releasing the mouse button will move or remove the folding line. Alternatively right click on the guide line and from
the menu select " Remove".

Folding Lines

You can use folding lines to determine where to fold documents. Folding lines are printed on the visible part of the document
(the part that will remain when the document is cut to the right size, for example they are also printed when there is no bleed
margin). Unlike guide lines, folding lines are part of the print output, they are printed on either side of the document.

To add a folding line

Windows
1-Insert from the Insert menu
From the Insert menu, select Folding line
Select Horizontal or Vertical line.
Drag the mouse to the exact position where you want to place the folding line and left click on it.
@ 2-Insert from the Ruler
Right click on the ruler. The contextual menu will show “Guide line” and “Folding line”.
Select Folding Line.
Use the horizontal ruler to add a vertical line, and the vertical ruler to add a horizontal line. Left clicking on a ruler adds
either a guide line or a folding line, depending on the icon displayed in the top left corner of your work area.
Mac
From the View menu, select Layout Ruler. Select either a horizontal or vertical guide line.
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To change a folding line:

« Length - Use the Imposition settings dialog box to change the length of the folding line. The overlay length of a folding
line specifies the length on the visible part of your document (for example, excluding any bleed margin).
« Color - Use the Program settings dialog box to change the color of the folding line.

To modify a folding line position

1. Select the Folding line.
2. Rightclick onit.
3. From the menu select "Position"
The window will show the current coordinates of the folding line.
4. Enter the new coordinates for the line position.

To remove a folding line

Itis possible to remove a folding line by dragging it to an invalid location outside the layout. The drag cursor is updated to
reflect whether releasing the mouse button will move or remove the folding line. Alternatively right click on the folding line and
from the menu select " Remove" .

Bleed Margin
A bleed margin is a part of your layout that is printed to the edge of a finished page.

Once a page is reproduced on press, the bleed margin is removed.

In PrintShop Mail, your total layout size (as seen in Size in the Layout menu) includes the bleed margin. To learn how to set
bleed margins, see "Imposition Settings" (page 58).

.+ When applying a Custom size to a layout and the bleed margin selected is at Page Level, the bleed is not displayed at
the edge of the paper, but around the set of layouts.

Once you specified the Bleed Margin, check the "Crop marks" option and specify the Gap size, which is the distance between
the crop marks and the edge of the document.

Crop Marks

Crop marks are printed lines that make it easier to trim the document to its finished size after the bleed margin is removed.
Crop marks are only printed if the layout includes a bleed margin.

To learn how to add crop marks, please see "Imposition Settings" (page 58).
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Supported Image Formats

These are the supported graphical formats and associated filename extensions:

Graphics Format Filename Extension

Encapsulated PostScript EPS or EPSF
Windows Bitmap BMP

Portable Document Format (*) | PDF

JPEG File Interchange Format |JPG, JPE or JPEG
Tagged Image File Format (**) | TIF or TIFF

Windows MetaFile WMF
PNG PNG
GIF GIF

o (*) Microsoft Word documents (DOC, DOCX) are converted to PDF.
o (**) PrintShop Mail fully supports LZW-compression.

The Mac version of PrintShop Mail uses QuickTime to handle image files. The supported image file formats therefore
depend on your version of QuickTime. For a list of image file formats you can visit www.apple.com.

Windows Shortcuts

The following keyboard shortcuts can be used to save some time by using the keyboard instead of reaching for the mouse.

File Menu
Menu  Action |

New Blank Document Ctrl+N

New PDF Based Document | Ctrl+Shift+N
Open Ctrl+0
Close Ctrl+W
Save Ctrl+S

Save As... Ctrl+Shift+S
Page Setup Ctrl+Shift+P
Print Preview Ctrl+F2
Print Ctrl+P

Exit Ctrl+Q

Edit Menu

Undo Ctrl+2
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Redo Ctrl+Y
Cut Ctrl+X
Copy Ctrl+C
Paste Ctrl+V

Select All Ctrl+A
Preferences | Ctrl+K

View Menu
Preview F2
Zoom In Ctrl++
Zoom Out Ctrl+-

Actual Size Ctrl+Alt+0
Whole Layout | Ctrl+0
Rulers Ctrl+R
Object Borders | Ctrl+H

Insert Menu

PDF Ctrl+Shift+W
Image File | Ctrl+Shift+E
Variable Text | Ctrl+Shift+T
Image Box | Ctrl+Shift+G

Text Menu

Italic Ctrl+1
Bold Ctrl+B
Underline | Ctrl+U

Editing Text (advanced)

Action Keys
Change bullet style Ctrl+Shift+L
Line spacing = 1 lines Ctrl+1

Line spacing = 2 lines Ctrl+2

Line spacing = 1.5 lines Ctrl+5
Select font name Ctrl+Shift+F
Increase font size Ctrl+Shift+>
Decrease font size Ctrl+Shift+<

The PrintShop Mail program interface
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Action Keys

Increase character spacing | Ctrl+Shift+]

Decrease character spacing | Ctrl+Shift+[

Reset character spacing Ctrl+Space

Help Topics | F1

Database Menu
Open Ctrl+D
Close Ctrl+Shift+D
First Record Alt+Up
Previous Record | Alt+Left
Next Record Alt+Right
Last Record Alt+Down
Find Record Ctrl+F
Window Menu
Layouts Ctrl+1
Variables Ctrl+2
Database Ctrl+3
Warnings Ctrl+4
Verification Result | Ctrl+5
Properties Ctrl+6
Fonts Ctrl+7
Help Menu

Macintosh Shortcuts
PrintShop Mail Menu

Preferences

Command,

Hide PrintShop Mail [ Command + H

Hide Others

Alt + Command + H

Quit PrintShop Mail | Command + Q

The PrintShop Mail program interface
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The PrintShop Mail program interface

File Menu
Menu  Acion |
New Command + N
New PDF based Document.. | Shift + Command + N
Open Command + O
Close Command + W
Save Command + S
Save As... Shift + Command + S
Page Setup Shift + Command + P
Print... Command + P
Print Record Alt + Shift + Command + P
Print Report Page Alt + Command + P
Edit Menu
Menu __ Action
Undo Command + Z
Redo Shift + Command + Z
Cut Command + X
Copy Command + C
Paste Command + V
Delete Backspace
Select All Command + A
Spelling Command:
Check Spelling | Command;

View Menu
Toolbar Alt+ Command + T
Preview Command + Y

LayoutRulers | Alt+ Command + R

Zoom in Command + +

Zoom out Command + -

Actual size Command + =

Insert Menu

Image File Shift + Command + E
Variable Text [ Shift + Command + T
Variable Image | Shift + Command + G
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Item Menu

Lock Position

Command + L

Unlock Position

Shift + Command + L

Show Object Properties | Command + Return
Text Menu

Show Fonts Command + T

Copy Font Alt + Command + C

Paste Font Alt + Command + V

Style Bold Command + B

Style Italic Command + I

Style Underline | Command + U

Copy Tabruler | Command + 8

Paste Tabruler | Command + 9

Show Colors Shift + Command + C

Layout Menu

First Alt + Shift + Command + Left

Next Shift + Command + Right

Previous | Shift + Command + Left

Last Alt + Shift + Command + Right

GoTo... |Command + ]

Database Menu

Open Alt + Command + O

Close Alt + Command + W

First Record Alt + Left

Next Record

Command + Right

Previous Record | Command + Left

Last Record Alt + Right

Window Menu
Minimize Command + M
Show Database Command + 1
Show Variables Command + 2

Show Layout Conditions

Command + 3

The PrintShop Mail program interface
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Show Fonts

Command + 4

Show Document Layouts

Command + 5

Show Warnings

Command + 6

Help Menu

PrintShop Mail Help | Command + ?

The PrintShop Mail program interface
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Working with PrintShop Mail Documents

£4 Working with PrintShop Mail Documents
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Create a New Document

You can create a new PrintShop Mail document either from a blank document, a template, or a PDF file. By default, PrintShop
Mail always starts with a blank document with a default size.

To start with a blank document

1. Open the File menu
2. Select New
3. Select Blank Document

You can also create a new blank document by use the CTRL+N (Windows) and #+N (Mac OS) keyboard shortcuts.

The size of this blank layout is set to Fit to Page. For more information on layout sizes, see "Specify the Layout Size" (page

73).

To create a new document from a PDF:

Open the File menu.

Select New.

Select PDF-based document.

Browse to the PDF file you want to use for your document.
Click Open.

AR S

You can also use the keyboard shortcut CTRL+SHIFT+N in Windows to create a new PDF-Based document.

PrintShop Mail will automatically create one layout per page in your PDF, so if your document has 5 pages you will now have a
PrintShop Mail document with 5 layouts. Each layout size is the same as the size of the page in the PDF. PDF pages are treated
as separate objects. Itis possible to scale the PDF pages around on the layout.

You can also use a Microsoft Word (.doc) document in PrintShop Mail. If you select a Word document, it is automatically con-
verted into PDF format and treated as a PDF throughout your design. If the original Word document is modified, PrintShop Mail
will notify you that the document has changed and will ask if you want to update the PDF in your PrintShop Mail document.

To create a new document from a template:

Open the File menu.

Select New.

Select Template-based document.
Browse to the template file you want to use
Click Open.

AR S

| '+ Inorder to use a template you have to first create one. Please see "PrintShop Mail Templates" (page 72).
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PrintShop Mail Templates

PrintShop Mail allows you to create PrintShop Mail templates. Templates are PrintShop Mail documents that you can design for
later use, for example for Publishing to PrintShop Web. These templates contain the (background) layout and the document
settings.

To create a template

1. Create a PrintShop Mail document either by opening an existing blank one, opening an existing document, or creating a
new template-based document.

2. Make any modifications to the document that you desire in your template

3. From the File menu, select Save as Template.

PrintShop Mail templates are saved with the extension ".PSMT". By default PrintShop Mail templates will be saved in the Tem-
plate folder which is located in the PrintShop Mail application folder.

Modifying the template
Itis possible to modify PrintShop Mail templates to change the document settings or content.

1. From the File menu, select Open Template.
2. Make the desired changes.
3. From the File menu select Save As Template.

LR A template does not save the link to the database you may have used in the designed stage of the PrintShop Mail doc-
b s
ument.

Page Setup

The Page Setup of your document allows you to specify which printer to print to, the paper size, source, and other char-
acteristics of your print media.

The settings in the Print dialog are applied to the current print job only, but the settings in the Page Setup dialog will be
stored in your document file.

You can specify a different Page Setup for each layout, but you can only send layouts to one printer. This allows you to mix
paper sizes (Windows only), orientations, media types, and finishing options throughout your document, provided that this
is supported by your printer.

Windows
There are different ways of changing the Page Setup:

1. From the File menu, select Page Setup, and choose either:
. Selected Layouts: layouts selected in the Layouts window.
« Current layout: layout selected in the Layouts window.
« This point forward: current layout and all layouts below it.
« Whole document: all layouts in the document.
2. Selectthe Layouts tab in the Properties panel, select one or more layouts, select Page Size, and click onthe [...]
button.
3. Rightclick on the layout and select Page Setup to open the dialog.

Use the Page Setup dialog box to specify printer options, as well as the media your job will be printed on.
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Mac OS
To change the Page Setup:

1. From the File menu, select Page Setup.
2. Inthe dialog box, you can change:

o Settings

« Format

« Orientation
« Scale

Use this dialog box to specify printer options, as well as the media your job will be printed on.

Specify the Layout Size
Windows

A PrintShop Mail document may consist of one or more layouts, which can be of different sizes. PrintShop Mail for Windows sup-
ports multiple layout sizes within one document.

To access the layout size properties:

Select the layout of which you want to change the layout size from the "Layouts Panel" (page 22).

Open the Properties Panel by clicking on Window, the selecting Properties.

Click on the Layout Size option in the Properties Panel. This triggers the [...] button next to the layout size.
Click on the [...] button to open the Layout Size options

Modify the options you want

Click OK to save the changes.

ounhcwwnN =

PrintShop Mail for Windows Layout Size Options

Setting Description

Select the layout size from the following options:

« Fit to Page: Fits the layout so it corresponds exactly to the Page Size.

_ « Fit to Objects:The layout will start at the top-left of the page and will resize itself dynamically to fit all the

Size objects on the page until the lower-rightmost corner of the lower-rightmost object.

« Custom Size: Lets you specify any custom size.

. A3/A4/Legal/Letter/etc: Lists all of the paper sizes available in the printer that is currently selected in
the Page Setup dialog.

Width Enter custom width. This setting is editable if you select "Custom Size".
Height | Enter custom height. This setting is editable if you select "Custom Size".
Shape [ Select either Tall or Wide.

Current Layout: Will apply only to the currently selected layout.
Apply to | This point forward: Will apply to this layout and any located after it.
Whole document: Will apply to all of the layouts including this one.

PrintShop Mail for Windows supports mixed layout sizes, except when layout repetition is used. When using layout
repetition, the first layout size will be the layout size for the complete document. See "Repetition Settings" (page 57).
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Mac OS

A PrintShop Mail document may consist of one or more layouts, all having the same size. There are two ways to specify the lay-
out size and orientation.

Automatic Layout Size

You can choose to base your layout size on the currently selected paper size in the Print Setup dialog, by selecting Layout
Size Automatic in the Layout menu. This will cause PrintShop Mail to dynamically resize your layouts to fit on the paper,
even when you are using layout repetition.

Fixed Layout Size

You can specify a fixed layout size in the Layout Size dialog. This will force your layout size to stay the same, independent of
the currently selected printer and paper size.

80Cc Layout Setup
Size: '_-Cus.tl:-m Size =
Width:  40.00 “mm 4
Heigth:  40.00| “mm =

r: 3 Tall
Orientation: =

) wide

(. Cancel '_.I { 0K }

PrintShop Mail for Mac OS Layout Size Options
Setting Description
Select a standard size for the PrintShop Mail document, A4, A5, B5, US Letter, US Legal. Select Custom Size to
enter customized settings.

Width Enter custom width. This setting is editable if you select "Custom Size".
Height Enter custom height. This setting is editable if you select "Custom Size".
Orientation | Select either Tall or Wide.

Size

Specify Spot Colors

Spot Colors are special premixed inks used instead of, or in addition to CMYK inks. Spot Colors are used in offset printing to
reduce printing cost or to provide solid colors that can not be exactly reproduced using process colors (such as CMYK). For
example to be able to print colors like gold and silver, some printers can accommodate an extra toner or cartridge filled with
that dedicated ink.

' '+ Spot Colors are only available in PrintShop Mail for Windows, and are not currently available in the Mac OS version.

PrintShop Mail allows you to enable Spot colors in order to print the document with the desired colors.
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To open the Spot Color dialog

1. From the Edit menu, select Spot Colors.
The Spot Color window is shown

> - x|
A |
Spok colar | Example spok{gold)
Spot color B ocfinition
Magentaspotialternate) B
Magenta [ = : ;
. patation | Separation
Example spok{gald) [
Alternate calor [ |+
YK Gray
EEEEREEERER
m [ | B
Remove ] [ Mew [ | [ | [ Ok, l [ Cancel ]

Cuskormn Calar

N

Spot Color " Name": A descriptive name is defined here.

3. Separation"Name": The name of the ink/cartridge as known on the device (printer/RIP). This must be identical to the
name configured on the device.

4. Alternate color: The Alternate color will be used at printing if the Spot Color is not available on the device and it

will be used as the displayed color on the screen preview at design time. This color may be complete different from the

actual Spot Color

To add a new Spot Color

Click the New button.
Type the Separation name.

Select the desired Alternatecolor from the drop down list or create a Custom color.
Click Save.

HON=

l !+ Spot Colors are saved with the current document. The Spot Color will not be saved as an application setting.

To remove a Spot Color

1. Select the Spot Color you want to remove
2. Click the Remove button.

l !+ IfaSpot Color is currently used in your document, it cannot be deleted, only modified.
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To modify an existing Spot Color

1. Select the Spot Color you want to modify
2. Change the name, separation and alternate color as desired.
3. Click Save.

Spot Colors in EPS files

Spot Colors defined in EPS files are recognized and loaded in the Spot Color dialog as though it is defined in the document
itself. If a Spot Color defined in an EPS file has the same name as an already existing Spot Color definition but is in fact a dif-
ferent Separation, a warning will be shown. As a result the used Spot Color will be sent to the printer (unmodified) and depend-
ing on the availability of the Spot Color on the printer, the Spot Color or the Alternate color will be printed.

Limitations
There are some limitations based on the printer and PrintShop Mail capabilities.

« The number of Spot colors used in a document is limited to the printer capabilities.

« PrintShop Mail cannot determine if a Spot Color is available on the device.

« Support for EPS with DCS (Desktop Color Separation) is limited to one separation in the DCS. If the EPS exceeds this lim-
itation, PrintShop Mail will return a warning: "«filename».eps is a color separated file and might not print correctly."

« When verifying a document, the verification results show all used Spot Colors in the document.

Open a Database

A database is a file or service that contains data that you can use in your document. PrintShop Mail can read a database one
record at a time and use the fields on that line in your text as variables. A field is a single piece of information, a record is one
complete set of fields and a file is a collection of records. Traditional databases are organized by fields, records and files.

To open a database file:

1. From the Database menu, select Open.
2. Browse for a database file (see "Supported Database Formats" (page 78)).
3. Select the database and click on Open.

.+ Ifyou open a delimited text file (such as CSV or Tab-Delimited files), you will be presented with the Open Delimited
Text File dialog (Windows Only). See Delimited Text Files.

To open a database through ODBC (Windows Only):

1. From the Database menu, select Open.
2. Click on ODBC Data Sources on the left.
3. Selectan ODBC Data Source on the right and click on Open.

y ODBC Data Sources can be created via the Windows Control Panel / Administrative Tools / ODBC Data Sources. For
more information on creating ODBC Data Sources, please refer to the Microsoft Windows documentation.

PrintShop Mail only supports one active table at a time. If a database contains multiple tables, you will be presented with the
Select Table dialog.

To select a specific table or view in your database, simply click on itin the list of available tables in the Select Table dialog.
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You can also use an SQL query in order to display custom data. This is only available with database formats that support
SQL queries (Access, SQL, Excel)

To create a custom query (Windows only):

1. Click onthe "Custom" item in the list, then double-click on the description row.
The Edit Query box appears.
2. Modify the existing query. This can be any SQL query that your database format supports. For more information, con-
sult your database software's documentation.
Click Apply to see a preview of the results in the Select Table behind.
4. Click OK when you are satisfied with the results to save the query.

W

LR Custom tables can also be used to call stored procedures in SQL databases. Check your SQL manual for details on

2= how to create and use them.

To sort the database
In Windows:

1. Select from the menu Database : Sort > Edit.
2. Specify your sort conditions by selecting a database field from the drop down menu and specifying the sort order.
3. Click OK.

In Mac:

1. Open the Database floater and click the Edit button next to Soert checkbox.

2. Select a database field in the list to the left and press Add button to copy it to the Sort Order list to the right. Double
clicking the field name has the same effect. Repeat the steps with all the fields that you want to use as further sort keys.

3. Itis possible to specify the Sort Order per selected field, which is either Ascending or Descending by selecting a
sort key in the list to the right and dragging it up or down, or remove a sort key by selecting it and clicking Clear, or
double click the sort key.

4. Press Sort to sort the database and Ready to close the dialog.

To filter the database
In Windows:

1. Select from the menu Database: Sort > Edit.
2. Select up to 4 filter criteria, by selecting the database field to compare, the type of comparison to do (see list
below) and what value to compare it too.
Available types of comparison:
« Contains: Database field contains the string indicated.
« Equals: Database field is exactly equal to the string indicated.
. Does not equal: Database field is not exactly equal to the string indicated.
. Is less than: Database field is numerically smaller than the number indicated.
. Is less than or equal to: Database field is numerically smaller or equal to the number indicated.
. Is greater than: Database field is numerically larger than then number indicated.
. Is greater than or equal to: Database field is numerically larger or equal to the number indicated.
« Is empty: Database field is empty
« Is not empty: Database field is not empty (contains any character, even a space)
« Starts with: Database field starts with he string indicated.
3. Atthe end of each criteria, select if you want to combine all the conditions together (And) or if any condition can be true
for the record to appear (or).
4. Click OK.
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In Mac OS:

« Open the Database window and click Edit button next to the Filter checkbox.

« Enter an expression of which the result can only be true or false.

« Select Filter from the Database menu or click the Filter checkbox in the database window to apply your filter set-
tings. Selecting or deselecting the filter option, toggles between using the entire database or using only the filtered
records. The filter option is enabled only when the database is currently open.

Data Fields: For the purpose of publishing PrintShop Mail documents to PrintShop Web, you can design a
PrintShopMail document with or without linking it to a database. The entries you will find in the Data Fields panel in
'__ PrintShop Mail, represent data fields that occur in the document. These fields are either referred to in expressions (for
— variables or layout conditions, without the need to be directly linked to a database), or they refer to actual database
fields (when the document is already linked to a specific database). Data Field Properties are relevant for Publishing
to PrintShop Web. For more information about Data Fields, see Publishing Documents.

Supported Database Formats

These are the supported database formats and associated file name extensions:

Database Format File Name Extension Note
dBase DBF

i See "XML Data-
Eﬁzer;smle Markup Lan- XML base Format"
guag (page 78)
Microsoft FoxPro DBF, DBC Windows Only

Microsoft Access

MDB, MDA, MDE, ACCDB, ACCDA,
ACCDE

Windows Only

Microsoft Excel XLS, XLSX, XLSB, XLSM

Paradox DB Windows Only
See "Delimited

Text TXT or CSV Text Files" (page
81)

Oracle Through ODBC connection Windows Only
Windows Only

SQL Server Through ODBC connection Support for SQL
Schema

DB2 Through ODBC connection Windows Only

XML Database Format

- A PrintShop Mail designer normally does not have to design XML databases on their own, itis provided by a third-
“v  party or is generated by a software. This page is meant as information to be forwarded to whomever is controlling
how the XML is generated so that it is compatible with PrintShop Mail.

PrintShop Mail can map the elements in an XML file to records and fields and use it as a data source, as long as the XML con-
forms to certain rules.
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Encoding
Any XML encoding is supported. If the encoding is not specified, it is assumed to be UTF8.
Hierarchy

There must be one root element. The root element can have one or more record elements, which form a recordset. Each
record element can have one or more field elements.

Example 1: Basic flat hierarchy

<root>
<record>
<field2>Record 2, Field 2</field2>
<fieldl>Record 2, Field 1</fieldl>
</record>
<record>
<field2>Record 1, Field 2</field2>
<fieldl>Record 1, Field 1</fieldl>
</record>
</root>

If a field element has child elements, the field element is considered to be an embedded recordset. The value of an embedded
recordset is a combination of the values of its records, separated by newlines. You will see this value when you use the field in
your layout. For performance reasons, the Select Table dialog and Data Fields pane do not display an actual preview of an
embedded recordset - they only display the text "(Multiple records)".

Example 2: Dynamic product list

<orders>
<order>
<name>Mr. A.</name>
<product type="Cranberry Sauce" price="$40.00"/>
</order>
<order>
<name>Mrs. B.</name>
<product type="Dried Pears" price="$30.00"/>
<product type="Cajun Seasoning" price="$22.00"/>
<product type="Aniseed Syrup" price="$10.00"/>
</order>
</orders>

Attributes

Attributes are interpreted as child elements. For example: <elem attrib="1"/> is identical to <elem><at-
trib>1</attrib></elem>.

Exceptions:
- PrintShop Mail will not include an attribute as a data field if its name starts with "xmins"
- PrintShop Mail will not include an attribute as a data field if its name is

"xsi:noNamespaceSchemalocation", "xsi:schemalocation", "xsi:type", "xsi:nil", "xml:base", or "dt:dt"

A special case is <elem attrib="1">InnerText</elem>. PrintShop Mail will expose "attrib" as a data field since it's a named
child element, but the InnerText value will be hidden. If you want to use the InnerText value you have two options:
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« Turnitinto a named child element: <elem attrib="1"><value>InnerText</value></elem>
« Inanexpression, add a reference to the hidden data field [$Text]

Multiple tables

PrintShop Mail 7.1 introduced support for multiple tables. Also, PrintShop Mail 7.1 no longer requires the record elements to be
at the second level in the hierarchy. A 'table’ in an XML data file is a collection of record elements, with the same name, at the
same hierarchy level. If more than one table is found, the user will be asked to select one in the Select Table dialog.

Exceptions:

« PrintShop Mail will not list a table if its name is "s:Schema" (XML persistence schema)
« PrintShop Mail will not list a table if it only consists of embedded recordsets (no regular fields)

Example 3: Data at deeper level

</inventory>
<level2>
<level3>
<leveld>
<car color="red" year="1999"/>
<car color="lime" year="2000"/>
<car color="black" year="2010"/>
</leveld>
</level3>
</level2>
<inventory>

Example 4: Two tables, '/car' and '/bike'

<inventory>

<car color="red" year="1999"/>
<car color="lime" year="2000"/>
<car color="black" year="2010"/>
<bike type="unicycle"/>

<bike type="two-seater"/>
</inventory>

Validation
PrintShop Mail will display an error message with context information if the XML has an incorrect syntax.

It should be possible to have PrintShop Mail validate the XML against a DTD or XSD schema, but we noticed that the MSXML
4.0 parser can have some trouble processing certain DTD schemas. If you run into any strange behavior, try removing the
schema reference.

Data types

Anything between CDATA brackets is considered to be literal character data instead of markup. Angle brackets ('<', '>") and
ampersands ('&") within a CDATA section do not need to be escaped.

CDATA Example:
<elem><! [CDATA[Hello world]]></elem>

PrintShop Mail has limited support for typed XML. Types need to be specified in an external XDR schema (the inline dt:dt attrib-
ute is not supported). Note that the "fixed.14.4" type is assumed to represent currency.
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Example 5: XDR schema

[File: weather.xml]

<?xml version="1.0"?>

<weather xmlns="x-schema:weather.xdr">
<date>1970-09-30</date>
<degrees>67.5</degrees>

</weather>

[File: weather.xdr]

<Schema xmlns="urn:schemas-microsoft-com:xml-data" xmlns:dt="urn:schemas-microsoft-
com:datatypes">
<ElementType name="date" content="textOnly" dt:type="date"/>
<ElementType name="degrees" content="textOnly" dt:type="float"/>
<ElementType name="weather" content="eltOnly">
<element type="date"/>
<element type="degrees"/>
</ElementType>
</Schema>

Delimited Text Files

PrintShop Mail supports opening any text file that is delimited with a special character. Generally these files are CSV files
(Comma Separated Value), but can also be tab-delimited, pipe-delimited, etc.

When you open a delimited text file using the Database, Open menu, you are presented with the Open Delimited Text File dia-
log.

O Open Delimited Text File (Ksiazeczkicsy) B X
1 —eEncoding: 11252 (ANSI - Latin I} x
2 —®separatar: Typ Saldo Nr_najemcy Mazwiskn B |
b Z Bk 5p.2 0.0, (.
Festawienie ksitre
& Camma
M CE 11275060 FIUTEE
Space M CE 50502421 JUSZCZAK
_ M CE 36139431 KOLCZ
Sernicolon M CE 44667310 GFOMBICA
'''' M CE 40663965 DKI
Other:
eri || M CE 55002079 ZDZIEB?OMYSKI
M CE 50503320 MaCH x:
3™  Create field names 4| M | b
(8] 4 Cance

1. Encoding: Select the encoding that is used in the text file. PrintShop Mail detects the encoding automatically. In most
cases, you can leave this setting as its default. If you know that the text file was created using a different encoding that
the encoding that you are using on your computer, you should change this setting to match it. For example, if your
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computer is set to use encoding 1251(Cyrillic, Windows), but you know that the file was created by using encoding
1252(Western European, Windows), you should change it to 1252.

Separator: Select the character that separates values in your text file. If the character is not listed, select the Other
check box, and then type the character in the box that contains the cursor.

Create field names: If no field names are part of the database, PrintShop Mail can add the field names for you. The
field names have the following structure Field <<number>>, where the number is formatted as three digits with
leading zeros starting at 1 (such as Field1, Field2, etc).

Delimited Text File Limitations:

The maximum number of fields supported is 255 for all types of delimited text files. Any column beyond 255 is ignored
by PrintShop Mail.

The first line in your text file should contain the field names.

Field names should only contain alphanumeric characters and underscores.

The records should be listed on the following lines.

The field separator is either a tab, a comma, a space, a semicolon or a user-defined character (not alphanumeric or
underscore) and these separators cannot be used in field contents.

If a field contains a field separator character, it should be enclosed in double quotes in order to be treated as one string.
Two adjacent field separators imply that an empty field is placed between them.

The record separator is a newline character.

Any missing fields at the end of a line are left empty.
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Objects are pieces or components that you place in your PrintShop Mail document to display some sort of data on your page.
Objects include text, images, barcodes and others.

To learn how to manipulate objects, see "Manipulating Objects" (page 34).

Text Object

You can display text on your page using a mix of static and variable text. Variable text is generally constructed using pieces
from your database, sometimes using conditions to control what text appears and when.

To add a text object to your document:

1. Click on the Text Object button in the Tools toolbar ()

2. Using your mouse, create a box on the document by clicking and holding the mouse button where you want one corner

to be, then moving the mouse to where you want the opposite corner and letting go of the button.

Start typing your text using static text and variables (see "Working With Variables" (page 91)).

4. You can apply styles and formatting to your paragraphs and text. See "Text Style" (page 40) and "Paragraph Style"
(page 42)).

5. Click outside of the text object to see the result as it will appear.

w

You can also create a text box of the default size by dragging a Database Field onto your page. This creates a text
I '/ box that contains one variable with the same name as your data field, and that variable will have the data field as an
expression.

Manipulating the text object
The text object can be manipulated in the following ways. You can:

« Editits properties (See "Text Properties" (page 27))

« Selectit (see "Selecting Objects" (page 34))

« Move and resize it (see "Moving and Resizing Objects" (page 35))

« Copy it (see "Copying Objects" (page 36))

« Align it with other objects (see "Aligning Objects" (page 37)) and arrange it (see "Arranging Objects" (page 37)).
« Lock it (see "Locking Objects" (page 38))

« Link it with other text objects (see "Linking Text Objects" (page 38))

« Anchor it with other objects (see "Anchored Objects" (page 38))

Add Static and Variable Images

In PrintShop Mail, image objects can contain either static or variable images. Using variable images with PrintShop Mail allows
you to personalize your documents with pictures.

l '/~ Note: For a list of supported image formats, see Supported Image Formats.

About static images

Static images are not linked to a variable, which means that they are always associated with the same image file throughout
your whole document.
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To insert a static image

1. Click on the Image Object button in the Tools toolbar.

Using your mouse, create a box on the document by clicking and holding the mouse button where you want one
corner to be, then moving the mouse to where you want the opposite corner and letting go of the button.

In the dialog box, browse to the image to insert.

4. Click Open.

N

w

4 Youcan also insert the Image Object via the Insert -> Image File menu. This create the Image Object at the top-left
corner of the document.

Images added to the document will be within an area called the Bounding Box. You do not manipulate the image directly but
rather its bounding box. Images will always fit within the bounding box and their image ratio will not change. For example, if
you resize the bounding box horizontally to make it wider, the image will center itself but not be bigger. If you resize the box
vertically afterwards, then the image will grow to fit. The initial size of an image depends on its resolution. PrintShop Mail
assumes an image resolution of 96 DPI (Dots Per Inch), except for EPS (72 DPI) and TIFF files. The resolution of a TIFF image
is stored in the file itself.

About variable images

Variable images are linked to variables in the same way as variable text. The result of the expression associated with a vari-
able image should be an image file name.

To insert a variable image

1. Click on the Insert Image Box button in the Tools toolbar.
2. Using your mouse, create a box on the document by clicking and holding the mouse button where you want one
corner to be, then moving the mouse to where you want the opposite corner and letting go of the button.

To set the variable image folder and file name

Double-click on the variable image box.

Browse to the folder where you want to look for images.

Double-click on one of the images.

Open the Variables tab and double-click on the variable that corresponds to the name of the image object you just cre-
ated (such as Imagel, Image2, Image3).

5. Use the Expression Editor to determine what image will appear. The result of the expression must be the actual file
name of the image in the same folder, including the extension (.jpg, .png, etc). See "Building Expressions" (page 120).

AN

Technically, both image objects are the same - we offer both for the convenience of adding the one that will offer the
l '+ correct dialog box. Both image types are cached using your print technology, where each individual image is cached
once and referred to multiple times.

Examples of Variable Image documents
Example: Image filename is "As is".

If your database contains a field that already has the name of the image you want do display including the extension, you can
refer to it directly in the image's expression. For example, if your database has a field called "Car Pic", you could simply use
the expression [Car Pic] in your expression.

ZIP (CAR CAR PIC
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91335 [ Mustang | Mustang.jpg
75038 | Explorer | Explorer.jpg
60173 [ Windstar | Windstar.jpg
33351 | Explorer | Explorer.jpg

Result:

Example: Condition triggered by the contents of a data field.

If your database contains a small trigger that can be used to dynamically determine what image will be displayed, you can use
a condition in the expression to determine what image will be shown depending on that trigger. For example, if you have a
field called "Car Type" that contains either A, B or C which refer to a specific car type, you can use that.

ZIP CAR |CAR TYPE
91335 | Mustang A

75038 | Explorer B
60173 | Windstar C
33351 | Explorer B

Expression
IF ([CAR TYPE] = "A", "Mustang.jpg",
IF([CAR TYPE] = "B", "Explorer.jpg",
IF( [CAR TYPE] = "C", "Wj_ndstar_jpg", llll) ) )
Place PDF

You can insert a PDF file as a static PDF object or as a variable image object. As a variable image object allows for using vari-
able pages within a (single) PDF document.

To insert a PDF image as a static PDF object, you can:

1. Drag and drop a PDF file to your layout, or
2. From the File menu, select New PDF based document, or
3. Inthe Tools toolbar, click the Insert PDF button, or from the Insert menu, select PDF...

To insert a PDF file as a variable image object, you can:

1. Inthe Tools toolbar, click the Insert Image File button, or from the Insert menu, select Image File.
2. Inthe Tools toolbar, click the Insert Image Box button, or from the Insert menu, select Image Box.

Note: Animage object can be linked to a single PDF file. As PDF files can contain multiple pages you can specify the page(s)
to be used in your document through an expression, in this way you can use variable pages within that PDF file.
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Mac OS

1. Inthe Tools toolbar, click the Place Variable Image button and drag a rectangle to the desired size on your layout,
or from the Insert menu, select Variable Image.

2. Double click the name of your variable image in the Variables window, to display the Expression Editor.

3. Inthe Expression Editor, define an expression or select a database field that contains the image filename.

Note: PrintShop Mail for Macintosh converts the color space that is embedded in the image to the color space of the printer
driver. You can check the color space of the printer driver, selecting from the File menu, Print/ColorSync.

Barcode Object

The most commonly known barcodes are composed of a sequence of vertical bars and spaces varying in width. Some bar-
codes use start and stop characters, which are defined as patterns of bars and spaces that tell the barcode reader where the
code begins and ends. Others have a checksum, which is an integer value that the reader can use to verify the integrity of the
barcode data. Some include human readable characters below the bars.

With PrintShop Mail you can add a variety of barcodes to your documents. For detailed descriptions of each one of the options
offered by specific barcodes, or for background information on barcodes, refer the documentation provided by individual bar-
code suppliers.

To add a barcode:

1. Create a new document or open an existing document.
2. Click the Barcode tool in the toolbar to insert a new barcode. The barcode object shows a default barcode.

To change the barcode properties, see "Barcode Properties" (page 32).

For a list of supported barcodes in PrintShop Mail, see "Barcodes Supported by PrintShop Mail" (page 86).

Barcodes Supported by PrintShop Mail

This page lists all the barcodes supported by PrintShop Mail Web, along with any specific requirements or notes regarding
them. Note that these barcodes are generally supported by both the PrintShop Mail Barcode Fonts (for versions previous to
7.0) and the PrintShop Mail Barcode Object (for versions 7.0 and higher).

Linear Bar Codes (1D)
Name Description Expected
Data
CodaBar 2 Widths | CodaBar (2 Width), CodaBar2
Codel1 Code 11, Code-11
Code 20F5 Data

) Code 2 of 5 Data Logic Version
Logic

Code 20F5 IATA Code 2 of 5 IATA Version (International Air Transport Association)

Code 20F5 Industry | Code 2 of 5 Industry Version

Get SAUIAUIE S Code 2 of 5 Interleaved (alias ITF or Code 2/51IL),
leaved

Code 20F5 Matrix | Code 2 of 5 Matrix (alias 20f5 Standard)

g:’je 20F5Sand= | ~ 10 5 of 5 (identical with Code 2 of 5 Matrix)
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Expected

Name Description Data
Code 39 Code 3 of 9 alias Code-39

Code 39 Full ASCII | Code 3 of 9 Extended Version (ASCII)

Code 93 Code 93

Code 93 Full ASCII | Code 93 Extended Version (ASCII)

Code128 Code-128 all sub sets and Compressed Mode
Codel128A Code 128 Subset A

Code128B Code 128 Subset B

Code128C Code 128 Subset C

EAN13 EAN-13 (also JAN or IAN),

EAN13 P2 EAN-13 (also JAN or IAN) with 2 digit add-on

EAN13 P5 EAN-13 (also JAN or IAN) with 5 digit add-on

EAN14 EAN-14 (GTIN coded with EAN-128 symbology)
EANS EAN-8 (also JAN or IAN)

EAN8P2 EAN-8 (also JAN or IAN) with 2 digit add-on

EANSP5 EAN-8 (also JAN or IAN) with 5 digit add-on

EAN128 EAN-128 alias UCC-128 alias GS1-128

Flattermarken Flattermarken

GS1-128 GS1-128, identical to EAN-128 / UCC-128
GS1-DataBar S::(;g)iltaaoiaé SSg/)mbologies: all variants of GS1 DataBar are supported (GS1 DataBar is
ISBN ISBN

ITF-14 ITF14, Code 20f 5 Interleaved (14 digits)

LOGMARS DOD Logmars, Department of Defense Logmars

MSI MSI Barcode variants with different check digits
NVE-18 NVE 18 (Nummer der Versandeinheit)

:_I:aagkmacode One- Pharmacode One Track (1 Track)

_FI’_I:aaEE'lacode Two- Pharmacode Two Track (2 Track)

PLANET 12 Digit Planet Code 12 digits (Postal Alpha Numeric Encoding Technique)
PLANET 14 Digit Planet Code 14 digits

Plessey Plessey Code Unidirectional

I;Le::le 1 SMeliEe Plessey Code Bidirectional

PZN Pharma Zentralnummer (Deutschland)

RSS Expanded EAN/UCC RSS Expanded (Reduced Space Symbology)
RSS Limited EAN/UCC RSS Limited (Reduced Space Symbology)
RSS-14 EAN/UCC RSS14 (Reduced Space Symbology)
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Expected

Name Description .

RSS-14 Truncated | EAN/UCC RSS14 Truncated (Reduced Space Symbology)

RSS-14 Limited EAN UCC RSS14 Limited (Reduced Space Symbology)

S:dl DataBar Expan- GS1 DataBar Expanded (Reduced Space Symbology)

GS1 DataBar GS1 DataBar / RSS14 (Reduced Space Symbology)

SaSt;IjDataBar Trun- GS1 DataBar Truncated (Reduced Space Symbology)

lfesdl DataBar Lim- GS1 DataBar Limited (Reduced Space Symbology)

SSCC-18 SSCC 18 Shipping Container Code

Telepen Telepen

Telepen Alpha Telepen Alphanumerisch

UCC/EAN-128 UCC/EAN 128

UCC-128 uccC 128

UPC12 / UPCA UPC 12 (alias UPC-A),

UPC-A UPC A (alias UPC-12),

UPC-A P2 UPC Version A with 2 digit add-on

UPC-AP5 UPC Version A with 5 digit add-on

UPC-E UPC Version E

UPC-EP2 UPC Version E with 2 digit add-on

UPC-EP5 UPC Version E with 5 digit add-on

UPCSCC UPC Shipping Container Code (refer to ITF14, SCC-14) -
Postal Codes (1D)

Name Description Expected Data

ﬁgss:réﬁ:_n Australian Post Standard Customer,

tom Customer2, Customer 3

Australian

Post Redir-| Australian Post Redirection

ect

Australian

Post Reply | Australian Post Reply Paid

Paid

Australian

Post Rout- | Australian Post Reply Routing

ing

DPD Code | German Parcel Service Label Code

CDOF;Iedent- Deutsche Post Identcode
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Name Description Expected Data

CD:dléelt_ Deutsche Post Leitcode

;Zz?ar:ese Japanese Postal Barcode

Italian Italian Postal Code (based on 20f5

Postal IL)

KIX Dutch Postal Barcode

Korean

Postal Korean Postal Barcode

Authority

zgéiLMall (Ré)l\):lilsﬂ?:l)l 4 State Barcode

(RM4SCC)

Onecue | 1SPSCreCote (1) s 575

(4-CB)
"Content" properties support:
ZIP: 5 digit or 5 Digit + 4.

USPS United States Postal Service PostNet Adc_lress D_ata: StreeF number and street name, used for automatic

PostNet barcode. Supports ZIP, ZIP+4, Delivery Point calculation.

Zip+4+Delivery Point. Note that you cannot use "raw" data (112345123478!) to generate a bar-
code, you need the actual ZIP and Address data. Delivery point and
checksum are automatically added.

Two-Dimensional (2D) Codes
Name Description Expected Data \
Codablock-F CodablockF (Stacked Code128), used by HIBC
Data Matrix Data Matrix (ECC200 standard with error correction), Auto Compaction
MaxiCode Maxi Code (used by UPS®)
MicroPDF417 Micro PDF-417, MicroPDF
PDF417 PDF-417 (all encodation modes with auto compaction)
PDF417 Truncated PDF-417 Truncated Version
QR-Code QRCode (Quick Response Code) (mostly used in Asia)
Aztec Code Aztec Code

RSS-14 Stacked

EAN/UCC RSS14 Stacked

RSS-14 Stacked Omnidir

EAN/UCC RSS14 Stacked Omnidirectional

RSS Expanded Stacked

EAN/UCC RSS Expanded Stacked

GS1 DataBar Stacked

GS1 DataBar Stacked

GS1 DataBar Stacked Omnidir

GS1 DataBar Stacked Omnidirectional

GS1 DataBar Expanded Stacked

GS1 DataBar Expanded Stacked
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EAN-UCC Composite Variants (2D)

Name Description Expected Data
RSS-14 Composite Component CC-A / CC-B
RSS-14 Stacked Composite Component CC-A / CC-B
RSS-14 Stacked Omnidirectional | Composite Component CC-A / CC-B
RSS Limited Composite Component CC-A / CC-B
RSS Expanded Composite Component CC-A / CC-B
RSS Expanded Stacked Composite Component CC-A / CC-B
EAN 13 Composite Component CC-A / CC-B
EAN 8 Composite Component CC-A / CC-B
UPCA Composite Component CC-A / CC-B
UPCE Composite Component CC-A / CC-B
UCC/EAN128 Composite Component CC-A / CC-B/ CC-C| -
GS1 DataBar Composite Variants (2D)
Name Description Expected Data
GS1 DataBar Composite Component CC-A / CC-B
GS1 DataBar Stacked Composite Component CC-A / CC-B

GS1 DataBar Stacked Omnidirectional | Composite Component CC-A / CC-B

GS1 DataBar Limited

Composite Component CC-A / CC-B

GS1 DataBar Expanded

Composite Component CC-A / CC-B

GS1 DataBar Expanded Stacked

Composite Component CC-A / CC-B

Related Symbologies

With the listed symbologies you can generate also the following variants:

« USS Code 39
« AIAG

« HIBC

« USSCode 128
« UCC-128

. ISBT-128

« SCC-14

« JAN

« Bookland

« ISSN

o USSITF 2-5
o I-2/5

o ITF-14

o SSC-14

. DUN14

« USPS

« DOD Logmars (Department of Defense Logmars)
o UPC SCS (UPC Serial Shipping Symbol)
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DirectSmile Object

Despite the fact that the integration of DirectSmile with PrintShop Mail benefits from state-of-the-art optimization and speed
improvements techniques, the generation of personalized images can still consume considerable amount of computer
resources. Therefore, DirectSmile must run on a separate computer than the one where PrintShop Mail is installed in order to
spread computer resources. System responsiveness may be affected dependent upon system specifications and number and
complexity of images used.

' The DirectSmile plug-in should be installed and available by default. If not, please re-install PrintShop Mail and check
= the DirectSmile plugin option.

If the connection between PrintShop Mail and DirectSmile is lost, images can no longer be requested nor received. It is there-
fore very important to verify the connection settings and make sure the PrintShop Mail document has access to the DirectSmile
server. The same holds true when using DirectSmile in a multiple users environment as well as when printing PrintShop Mail
documents with PrintShop Mail Web.

To insert a DirectSmile object on the page:

o Click the DirectSmile icon in the Tools toolbar.

« Double-Click the object that is added to the page.
« Typeinthe Server name and select an image set.
« Click Open.

The properties of a DirectSmile object are available in DirectSmile Properties.

Working With Variables

Variables are basically words that contain data, which can be used throughout your document in any text object. You can have
as many variables as you want in your text, and they can be re-used as many times as you want. Changing the expression
(content) of one variable will change its result in each place it is used.

Variables can be created manually by typing its name in a text object, automatically by dragging a data field on your doc-
ument, or automatically by objects that you add.

To create a variable manually:

1. Create a new text object in your layout or use an existing text object.

2. Typeina variable name, surrounded by the variable delimiter (by default, this is the @ symbol). For
example: @FIRSTNAME@ , or @Last Name@ .

3. Click outside of the text object. The variable appears in the "Variables Panel" (page 22).

To create a variable from a data field:

Open the "Data Fields Panel" (page 23).

Click on a data field and hold your mouse button.

Move your mouse to where you want the contents of the data field to appear.

Let go of the mouse button. A variable with the same name as the data field appears in the "Variables Panel" (page 22).

PO

To assign database fields to the variables

The next step is to connect the variables to fields in the database. To do this,
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1. (Windows): Double click on a variable in the Variables Panel to display the Expression Editor, or right click on
the text object and select the variable in the Edit Expression submenu.
(Mac 0S): Double click on a variable in the Variables floater.

2. Double click on the database field to which to associate the variable.

3. Click OK to close the window.

Persistent Variables

A persistent variable is a variable that will remain present in your document even when it is not present in any text object. Per-
sistent variables are normally useful when used in combination with the "TEXT_FILE" (page 153) function. In order for any
variable in the contents of your external file to be replaced by an expression, create a persistent variable and change that vari-
able's expression to reflect what you want to appear. For more information see "TEXT_FILE" (page 153).

To create a Persistent Variable

1. Right-click anywhere in the "Variables Panel" (page 22), then click on Add Persistent Variable.
2. Type the name you want for the variable.
3. Click OKto create it.

To modify the properties of a Persistent Variable

1. Click onthe variable in the "Variables Panel" (page 22).
2. Goto the "Properties Panel" (page 26).
3. Editthe "Variables Properties" (page 31).

Use Layout Conditioning

Use layout conditioning to conditionally skip certain pages of your document or to leave them blank during the printing pro-
cess. The PRINT and BLANK commands will not influence the amount of pages printed.

There are three options for applying a condition to a layout:

« PRINT: The layout will be printed (default).
« BLANK: A BLANK page will be printed instead of the layout.
« SKIP : The layout will be skipped and the next layout will take its place.

To specify layout conditioning
Select the layout for which you want to set the condition:

« (Windows): Itis possible to specify layout condition in three ways:
1. From the Layout menu, select Edit Condition.
2. Rightclick on the layout and select Edit Layout Condition.
3. Inthe Layouts panel, select the layout and click on Action to Edit Condition.
« (Mac 0S):
1. From the Windows menu, select Show Layout Conditions.
2. From the Windows menu, select Show Variables and click on Layout Conditions.

Use Case Example

You want to print a one page newsletter or promotional letter, but you want to use a different page (different colors or images,
for example) for your clients depending if they are male or female. Luckily, your database contains a field that says "M" for
male clients and "F" for female clients.
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The following expression can be used on the layout that is meant for your male clients:
IF( [GENDER] = "M", Print, Skip)
In plain words, "If the GENDER field is equal to "M", print the page, otherwise skip it".

The expression for your female audience will be very similar:

IF( [GENDER] = "F", Print, Skip)

4 FreeForm and FreeForm 2 print technologies do not fully support layout conditioning and do not allow you to con-
ditionally Skip layouts. When SKIP is used, a BLANK page will be printed instead.

Note: When you use layout condition SKIP for your PrintShop Mail documents with multiple layouts, or when you have applied
variable Number of Copies, this may cause that the size of the record sets (the number of actual printed layouts per record)
will be different per record set. This in turn may cause that some record sets will be split across different stacks.

When should Layout Conditions be applied?

« Output of multiple versioned documents within one PrintShop Mail file.

« Sending a different promotional coupon to clients that have purchased more or less than a specific amount (perhaps
when sending a "thank you for your previous purchase" letter)

« Inserting blank pages

Note: For more information on expressions, see Expression Overview.

Use Layout Repetition

PrintShop Mail can print multiple layouts on a single page that is larger than the layout itself, which is useful for printing
address stickers, postcards and business cards. This concept is sometimes referred to as Multi-Up or N-Up, where N is the
number of layouts in a page (e.g. 2-up, 4-up, 8-up, etc). The technique can also be used to save "clicks" on printers that
charge you each time a physical page is ejected, by placing multiple copies or records on a single, larger sheet.

This is done by using the Layout Repetition settings in the PrintShop Mail Preferences dialog (see "Repetition Settings" (page
57)).

Use Cases and examples:

« You can print 10 business cards on a single Letter-sized thick paper by creating a layout that is 3.5" wide by 2" high,
with 2 horizontal repetitions and 5 vertical repetitions.

« You can use half as many physical pages ("clicks") on your printer by using an 8.5"x11" layout, repeated twice hori-
zontally on a Tabloid-sized page.

« You can print postcards 4-up (2 horizontal, 2 vertical) on a Tabloid page.

Cut & Stack (aka Through-the-Stack) in Simplex mode

You can use the repetition settings to re-order the output so it creates stacks. This is useful when you are cutting the stack at
printout, in order to retain the precise order of the records. For example, if you are printing 500 "tickets" 4-up using a
"COUNTER" (page 143) function to display a serial number, you would probably want to keep the order as 1-500.

To do this, you can set the first priority settings to be (1) on Front to back, the second to be (2) on Top to bottom and
finally (3) on Left to right. This way the first record is printed on the top-left of the first page, the second record on the top-
left of the first page, etc. Record 126 will be on the top-right of the first page, and 500 will be at the bottom-right of the last

page.
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When you cut the output stack in 4, you can then simply order them in the order of: top-left, top-right, bottom-left then bot-
tom-right stacks, and this will retain your 1-500 order.

Cut & Stack and Duplex mode

If you are creating a PrintShop Mail document with two layouts per record and Cut & Stack, you will need to use the Front to
back option in priority 1 as described above, or else your "back" layout would end up besides your front one instead of on the
back of the page. In order for this system to work correctly, you need to make sure that every record always generates two
layouts.

When duplexing, you also need to remember to correctly select the proper Mirroring setting to the same option as your Duplex-
ing option on the printer, so the layouts on the back are correctly ordered. For example, if you printin Short-Edge Duplex in
your printer, select Flip on Short-Edge in the Mirroring option.

When you use layout condition SKIP for your PrintShop Mail documents with multiple layouts, or when you have
applied variable Number of Copies, this may cause the size of the record sets (the number of actual printed layouts

.+ per record) to be different per record set. This in turn may cause some record sets to be split across different stacks.
To avoid this, always make sure that the number of layouts per record is correct (you can use conditional
"blank" layouts to do this).

Select Paper Trays

If your printer supports different paper trays and your document consists of multiple layouts, you can send different layouts to
different trays.

To associate a layout with a paper tray
Windows

1. From the File menu select Page Setup, or right click on the layout and choose Page Setup. Alternatively in the
Properties panel, select Page Size.
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— Apply ko
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—|"Whole document
| [ | | Cancel | | Advanced..

2. From the Tray box, select the desired paper tray.
3. Inthe Apply to box select:

Current layout: layout or layouts selected in the Properties Panel.
This point forward: current layout and all layouts below it.

Whole document: all layouts in the document.
4. Click OK.

If your printer supports more trays but they are not available in the Page Setup window, use the following steps to select a tray
in the Advanced properties of the printer driver:

From the File menu select Page Setup, or right click on the layout and choose Page Setup.
Click on the Advanced tab.

In the Printer Document Properties select Advanced.
In the Printer Advanced Options select Printer Features.

AN

I '/ The options outline above, must be repeated for each layout, if each layout need a different tray.

Another way to associate a layout with a paper tray is by selecting the layout in the Layouts panel, then select the Paper Tray
property and choose the desired tray from the drop down menu.
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Tarne
Layout Size Fit to Page
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Paper Tray Trayl W
Ackion Automatically Select
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Paper Tray Trays
Paper Traw Travh
Mac 0S

From the Layout menu, select Paper Tray. Depending on the selected PPD, a list with the available trays will be displayed.

MDatabase View Window Help )

Insert... k
Remove...
| Move... L
Duplicate
First
Previous B Hsas T I B
I |
Go To... |
Select Paper Tray N Printer's default
Upper
: Middle
s " Lower

LargeCapacity

Number of copies

PrintShop Mail allows you to print a number of copies per page. The Expression Editor can be used to generated multiple
copies of each page in your document.

To setup the number of copies

« Select the Layouts panel.
« Select the desired layout and click on Number of Copies, to open the Expression Editor.
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Once the Expression Editor is open:

1. Double click on the VAL function from the function list. The expression will be pasted into the Expression Edit field.
2. Select the string value of the database field containing the number of copies.

D cdi Expression for "Number of Copies'

L REARL

VAL{ [Number of
Wil o O

exr of copies]}|

£ =
Expression result: 2
[E Components | Fp Favorites
@ Al Functions: E] | Data Fields:
String TRIM * Eat‘f’g':”
i o
umber
JPCH
Barcode JECE
Logical JEFER
YUBAR -
WAL{Text} Fs
w

- Retums numbers in test as data type Mumber, for use with formulas invalving numbers

|
@

VALM23") => 123

Filename. . | |

Ok

| | Cancel
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Non-numerical Text String

! Data Fields o =
V| MHame | Walue | Type |
Comparny Bill Co Text
[rata Shart Text Text
Rt best rif Teut
v Copies a Murnber
Trigger A Text

In this case, the data field does not contain a number string, but it does have a field to be used as "Trigger".

1

D cdi Expression for "Mumber of Copies" B X

IF([Trigger]="aA", VAL("12"},IF([Triggexr]="B", VAL ("E"}, s
s

._.J_._:Erlf_r|:|:|:||-

Expression result; 1

Components | Fp Favorites

& All | Functions; E] | Data Fields:
] M = | ey

i UECH iln:l?ngl:ueer of copies

Barcode UPCE E]

Logical JEEER E] E] C]

(=

. YUBAER W |

| WAL{Text) -
- Retums numbers in text as data type Mumber, for use with formulas involving numbers

| WALI123 == 123

|®| | Filename... | | Ok || Cancel |

In the expression "IF([TRIGGER]="A",VAL("12"),IF([TRIGGER]="B",VAL("8"),VAL("1"))) ", the field name "TRIGGER" has
either an "A" or a "B" in it. The number of copies for "A" would be 12, and the number of copies for "B" would be 8. At the end
of the expression, you need to add VAL("1"), because the function must result in a numeric value.

Note: When you use layout condition SKIP for your PrintShop Mail documents with multiple layouts, or when you have applied
variable Number of Copies, this may cause that the size of the record sets (the number of actual printed layouts per record)
will be different per record set. This in turn may cause that some record sets will be split across different stacks.

You can also print multiple copies of your document by entering the desired number of copies in the Print Dialog. To do this:
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« Onthe File meny, click Print.
« Inthe Number of copies box, enter the number of copies you want to print.

To print a complete copy of the document before the first page of the next copy is printed, select the Collate check box. If you
prefer to print all copies of the first page and then print all copies of subsequent pages, clear the check box.

Limitations

« The output result will be one copy if a single zero ("0") is used in any part of the Expression.

« For multi-page documents, you need to set the number of copies per each individual page.

« Number of copies can not be used in combination with Layout Repetition.

« Number of copies can not be used when FreeForm Print Technology is selected, use FreeForm 2 instead.

Verify a Document

Before printing, you can verify your document for possible problems.
To perform document verification
PrintShop Mail performs the following checks at Layout level:

« Are any images or PDF files missing?

« Are all items placed within the printable area?

« Does a text object contain more text than the text box can hold?

« Are there fonts missing in your system that are referred to in the document?

When you select Verify Document from the Layout menu, a progress bar will be displayed, showing the amount of
records being checked. The warnings for the whole document will be listed in the Verification Results panel.

= =5

| ¢ verification result (17) o x|

. | Layout  Record = Description

I Object iz not entirely placed on the layout
Object iz placed beyond the printable area
Object iz placed beyond the printable area
Text does nat fit in it bounding box
Yariable "DATE" iz not linked to an expression
Image "Branch Den Helder'" nat found
Mo image specified
Mo image specified
Mo image specified
Mo image specified
Mo image specified
Mo image specified
Image "Branch Leiden' nat found
Mo image specified
Mo image specified
Mo image specified

1] Mo image specified

RN T T T [ O A T D U T DY TR UL T o TR S S R

bl = I = Y I R R R P T e B

i
i
i
i
i
i
i
[l &
&
&
i
i
i
i
i
i
i
B

[ 1]
[ |

Verify document checks the document at two levels:

Layouks |at-c Yariables | _j Daka Fields | B Warnings (7] | :i. ¥erification res... |—
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« Layout level: Warnings at layout level will show the warning with the layout number in the Warnings panel.
« Record level: Warnings at record level will show the warning with the layout number and record number in the

Warnings panel.

Verify document will be stopped when 1000 warnings are found or when you press the Cancel button on the pro-

gress bar.

Here is a list of a few possible messages:

Error Message Possible Solution

Object is placed beyond the printable area

Move the object on the layout so it is directly on the page

Object is not entirely placed on the layout

Move the object on the layout so it is completely on the page

Text file not found

Verify the expression that creates the filename used by the TEXT_FILE function.

Variable X is not linked to an expression

Check the Variables Panel for any variable that does not have an expression.

Text does not fit in its bounding box

Verify the text box where the error occurs. Either make the text box bigger, or
use Text Links to flow the text into another text box.

Image X not found

Verify the file name or expression that calls the images file in your Image box.

Error loading image

Verify that the image you are calling is a valid type supported by PrintShop Mail
and that it is not corrupted.

Page number X is invalid; this PDF only
contains Y pages

Verify the expression used to choose the page displayed by the PDF, and that
the PDF name is the correct one.

Variable X: argumentY is invalid

Verify the expression for the variable.

Variable X: barcode input string Y is
invalid

Verify the expression for the barcode object and make sure it corresponds to
what the barcode is expecting.

Variable X: date formatY is invalid

Verify the date format for the variable.

X contains at least one TrueType font that
is not embedded in the PDF

Recreate the PDF in order to embed all the TrueType fonts.

Variable X: database field Y not found

Verify the database field name in the variable's expression.

You can save any error message in the Verification Results panel or the Warnings panel. To do so, right-click on the
message and select Copy. You can then paste it somewher else, for example by emailing it to technical support.

Save a Document

When saving a document, it is recommended to use one folder for the document file and its supporting files that is, the image
files and the database. The reason for this is because the supporting files for a PrintShop Mail document are not included in the
document file. This file only contains references, stored as paths relative to the document folder.

For example:

If you save your document in...
"C:\My Documents"

and it contains an image...

"C:\My Documents\Images\Car.tif",
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the reference to this image is stored as...
"Images\Car.tif"
If you move the Documents folder and its subfolders to another drive, PrintShop Mail will still be able to locate the image.

Windows Note: PrintShop Mail 6.1 documents can be opened in all PrintShop Mail 6.X versions (downward/upward com-
patibility). You can import PrintShop Mail 98, 4.x, 5.x and 6.x documents into new versions of PrintShop Mail, but PrintShop
Mail 98, 4.x and 5.x will not be able to interpret documents saved by the new version of PrintShop Mail . If you try to overwrite
an existing PrintShop Mail 98/4.x/5.x/6.x document in the new PrintShop Mail format, PrintShop Mail will issue a warning.

Mac OS Note: You can open PrintShop Mail documents created in PrintShop Mail 4.3.X or older, but PrintShop Mail 4.3.x will
not be able to interpret documents saved by the new version of PrintShop Mail. If you open an existing PrintShop Mail 4.3.x doc-
ument in the new PrintShop Mail format, PrintShop Mail will issue a warning, asking you whether you really want to save this
document as soon as you close the document, even if you have not changed anything.

When opening PrintShop Mail documents from versions 4.3.6 or 4.2.9 (Japanese language) in PrintShop Mail 5, the following
settings might be lost:

-Format settings in DATE and TODAY expressions will not be converted automatically; this settings can be rest manually.
-Variable images will be opened with an empty expression.

-Leading between lines setting can not be converted, this setting can be reset manually. Variables embedded in an EPS (@vari-
able@) is not supported.

-Transparency will be converted to white, this setting can be reset manually.

-The COUNTER function will be converted using an end value of 2.000.000.

If you wish to use documents made in earlier versions of PrintShop Mail than versions 4.3.6/4.2.9 (Japanese language) before
you open them in PrintShop Mail 5.x.

To save your documents
You can save a PrintShop Mail document in three ways:

1. As a PrintShop Mail document, with the extension ".PSMD".
From the File menu, select Save as.

2. As a PrintShop Mail template, with the extension ".PSMT".
From the File menu, select Save as Template. For further guidance in saving PrintShop Mail templates, see Create a
New Document.

3. Save for Output archived in a "ZIP" file which contains all files used in the PrintShop Mail document.
From the File menu, select Save for Output.
When selecting Save for Output, PrintShop Mail collects and copies all the files needed into a compressed folder. The
collected data includes the PrintShop Mail document, static and variable images, database, fonts and a summary file
which shows a list of all the copied image file names.

To revert to the last saved version of the document, select Revert from the File menu.
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Document Output

£4 Document Output

PrintShop Mail Design can generate multiple types of printed and file outputs, even some that are device-specific and meant
for certain PostScript RIPs. It can also output to non-postscript printers as well as PDF files. Documents can also be printed
through, or published to, a PrintShop Mail Web server.

To preview a document before printing it, see "Print Preview" (page 103).

To print a document, see "Printing a Document" (page 103).

To print for a specific type of printer, see "Print Technologies" (page 51).

To create a PDF, see "Save as PDF Dialog" (page 105).

To print your document through PrintShop Mail Web, see "Print To Web" (page 106).

To publish your document for it to be used through PrintShop Mail Web, see "Publishing Documents" (page 107).

Print Preview

While you are working on your document, it is possible to view an on screen representation of the printed output. In this Print
Preview itis possible to browse through pages and view multiple layouts and records at the same time.

You can enter the Print Preview mode in two ways:

1.
2.

From the File menu, select Print Preview.
Click the Print Preview toolbar button in the Standard toolbar.

In Print Preview mode, four menu items are shown:

Page combo box: Allows you to select the view of a single page or multiple pages at the same time. By default you
will see two pages horizontally and one vertically.

Print button: When you click this button, PrintShop Mail returns to the design view and the Print Dialog will be
opened.

Book Preview: Click the Book Preview to force the preview window to display the pages as they would appear when
printing duplex and stapling on the left. Odd-numbered pages will be displayed on the right, even-numbered pages are
displayed on the left. To correctly display the book preview, make sure you are displaying 2 pages as once, hori-
zontally (see Page combo box option).

Close button: When you click this button, PrintShop Mail returns to the design view. Alternatively, you can close the
Print Preview by pressing Esc, or by pressing Alt+F4.

Color softproof: Allows you to display an on-screen preview of how your documents colors will look when repro-
duced on a particular output device. This feature is enabled when Color Management is activated.

Printing a Document

Before you do the actual printing, PrintShop Mail offers different ways to optimize your output, allowing you to select how
many pages or records you want to print. Additionally, you may wish to print the currently selected record, or proof your doc-
ument in PDF format before printing. To do this, click on the File menu and select Print to open the Print Dialog.

When printing through PrintShop Mail Design, the following options will be available to you:

« Operating System Default Print Options

« Printer: The printer you wish to print to.
« Printer Properties: Controls printer options, for example layouts options and paper quality.
« Print to File: Instruct the printer driver to print to a file on the disk, instead of the printer.
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« Number of copies: Indicates the number of copies you wish to print of each page. If the value is set to one,
only the original page will be printed.

« Collate: Determines how the layouts are ordered within a record, the layouts within the record set will keep
the order intact. By default this option is On.

« Print Options:

« All Records: By default "All Records" is selected. This option allows you to print the complete job. Behind this
selection the amount of available records is displayed.

« Record Range: This option allows you to print a certain range of records. If the range of records you wish to
print exceeds the number of records available, a message will be displayed until the amount of records is equal
or less than the total amount of records available.

. Page Range: This option allow you to print a certain range of pages. When using layout repetition and you
select this option the complete humber of pages needs to be calculated to output the correct pages.

« Current Record: This option allows you to print the selected record, using Standard PostScript print tech-
nology. No Credits will be charged from your hardware key.

« Softproof PDF: This option generates a PDF file of the current record, using Standard PostScript print
technology. No Credits will be charged from your hardware key. When a non PostScript printer is selected, it will
use the PostScript printer driver installed by the PrintShop Mail installer to generate output.

« Report Page: This option allows you to print a Report Page, using Standard PostScript print technology. No
Credits will be charged from your hardware key.

« Variable Markers: This option allows you to print the current layout(s) with the variable markers on it, using
Standard PostScript print technology. No Credits will be charged from your hardware key.

« Split job: This option allows you to split the job per record or per page in several outputs. Print speed will be improved
when using limited job sizes. Please note that the number of pages is round up to the nearest record boundary, so if a
document produces 10 pages per record and the splitis set to 5, the split will actually happen every 10 pages.

« Save Print Options: Click this button to save the settings that have been modified in this window. If you cancel the
print dialog, your options will still be saved. Note that clicking Print or Verify and Print will also save the print options.

« Print Technology: Use this option to select a specific print technology that is compatible with your printer. To select
a print technology, simply click on the name of the currently selected print technology, and click the one you want in the
drop-down. For more details on Print Technologies, see "Print Technologies" (page 51). Print technology options are
described below.

= If you use the options "Store forms on printer's hard disk" or "Custom cache size", and the RIP is password protected
8 you might get a printer error. Consult the RIP manual or consult the system administrator to change the settings on
the RIP.

Print Technology Options
These options are available in one or more print technologies, as indicated.

« Use OPI, don't spool images: Most print technologies support OPI (Open Prepress Interface), allowing you to use
an image substitution server to speed up the printing process. OPI only supports EPS and TIFF image formats. Avail-
able in the following print technologies: Standard PostScript, Optimized PostScript, AHT, Fiery FreeForm, Fiery Free-
form 2.

. Store forms on printer's hard disk: Storing PostScript forms (cached reusable content) on hard disk will prevent
out of memory conditions if your document contains large high resolution images. Only use this option if your RIP has
access to a hard disk. Available in the following print technologies: Optimized PostScript, AHT, Fiery FreeForm, Fiery
Freeform 2.

« Custom cache size: Increasing the PostScript form cache size can help to improve performance. You may want to
experiment in order to determine the optimum value. Specifying a custom cache size only works if the system settings
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of your RIP are not password protected. Available in the following print technologies: Optimized PostScript, AHT, Fiery
FreeForm, Fiery Freeform 2.

« PDF Settings: Click on the drop-down to view the available job option profiles found on the system, and click one to
apply it to the PDF output. The job option profiles are related to PDF quality settings and can only be created, managed
or deleted through Adobe Distiller. For more information on job options, please see the Adobe Distiller documentation.
Available in the following print technologies: Adobe PDF, Adobe PDF/VT-1.

« Use Automatic Picture Replacement (Creo VPS only): Automatic Picture Replacement (APR) allows you to
speed up the printing process by using the image substitution capabilities of your VPS RIP. The image format support of
APR is limited to EPS, but some RIP versions support other formats like TIFF and JPEG.

« Form Number (Fiery FreeForm only):

« Form ID (Fiery FreeForm 2 only): A numeric ID to identify the Master Data job. If a Master with the ID already
exists and you send Master data, the previous form will be overwritten.

« Send (Freeform): Select what is being sent to the Fiery server. Available in the following print technologies: Fiery
FreeForm, Fiery Freeform 2.

« Master data: Send only the Master (template) to the Fiery server.
« Variable data: Send only the variable data, assuming the Master is already present in the Fiery server.
« Master and variable data: Send both the Master and Variable data together.

. Create ZIP archive (PPML only):

« Environment:

. Embed images in PDF (PPML only):

« Send (PPML):

« Allimages:

« Global images:

« Local images:
. Don't spool images (EPS, TIFF, JPEG) (PPML/VDX 7 Only):
. Project Folder (VIPP Only):

Available in the following print technologies: Standard PostScript, Optimized PostScript, Adobe PDF, Adobe PDF/VT-1, AHT,
Creo VPS, Fiery FreeForm, Fiery Freeform 2, PPML, PPML/VDX 7, VIPP.

Save as PDF Dialog

When you click on File, Save As PDF, the Print Dialog opens and selects the Adobe PDF print technology by default. This gives
you the ability to create a PDF from PrintShop Mail without having to rely on a separate PDF print such as Adobe Acrobat.

You can also save as PDF by selecting Print or Print To Web and then changing the Print Technology to Adobe PDF or Adobe
PDF/VT-1. In both those print technologies, only the PDF Settings (aka joboptions) drop-down is displayed. If you need to fine-
tune your PDF options, you will need to use Adobe Distiller to create a joboptions file. See "Adobe PDF" (page 52).

Subset Finishing
Subset finishing is the process of applying a finishing option (such as stapling or binding) to each subset in a print job.

PrintShop Mail defines a subset as a set of pages belonging to the same record. If you are not using layout repetition or layout
conditioning, the number of pages in each subset will equal the number of layouts in your document.
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To use subset finishing

You can specify a finishing option in the printer driver, using the Properties button in the Print dialog or using the
Advanced button in the Print Setup dialog box.

PrintShop Mail can embed certain PostScript instructions in the output to signal that the finishing option should be applied.
You can specify which instructions to embed in the Embed PostScript dialog box.

Itis possible to write your own PostScript set and save them. If you go to New you can give the PostScript set a name. The
given instructions at the "Start of Page", "Start of Job" and "Between Sets" will be saved. You can also turn it to the default set-
ting by selecting the button "Set Default".

Locating this dialog box
File > Embed PostScript
There are 4 options:

1. General: This option can be used to give the PostScript set a "Name" and write a "Description".
2. Start of Page: These instructions will be injected at the start of each page.

3. Start of Job: Instructions given there will be injected in the header of the job.

4. Between Sets: Instructions given in this field will be injected between the sets.

For stapling or binding, the default setting (Generic Subset Finishing) should suffice.

Print To Web

Print to Web allows you to print PrintShop Mail documents to PrintShop Mail Web. The output will be generated on the
PrintShop Mail Web server, not on the computer where the PrintShop Mail document is created.

There are a few specific points that must be handled for this integration between Design and Web to be functional:

« Itis strongly recommended that the Operating System be the same on the server and all client machines.

« Itis recommended not to mix 32 and 64 bit versions of the operating systems and drivers (x86 and x64).

« Each PrintShop Mail Design user must have a their own username and password defined in PrintShop Mail Web.

o Printers that will receive jobs from PrintShop Mail Web must be accessible from the PrintShop Mail Web server and
activated within PrintShop Mail Web's interface.

« Printer names must be the same across all machines that share PrintShop Mail documents, as well as the server.

« Printshop Mail Design users must have the printer drivers installed on their local machines for every printer they intend
to output to through PrintShop Mail Web. It does not matter if the output printer is accessible or not from the Design
machine, only that the driver be present. This is because the page setup and driver settings are set from PrintShop Mail
Design but will actually be used from PrintShop Mail Web so they must match.

From the File menu, select Print to Web...

.+ When selecting Print to Web... option, the PrintShop Mail document can be saved before it is uploaded, otherwise
the original document will be sent to PrintShop Mail Web.

The following options are displayed in the Print to Web dialog:

« Destination Group
« Server address (read-only): Displays the server configured in the PrintShop Mail preferences. See
PrintShop Web Preferences.
« Company: This option list the available Companies. PrintShop Mail will store the last selected company with
the document.
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. Remote Printer: This option list the available printers installed on the PrintShop Mail Web server. If no print-
ers are installed, the combo box will show “No printers available” and the print button will not be enabled.

« Print to File: This option will generate a print file when creating output, instead of actually printing. The file
will be saved in the default PrintShop Mail Web Output folder.

« Print Group:

« All Records: By default "All Records" is selected. This option allows you to print the complete job. Behind this
selection the amount of available records is displayed.

« Record Range: This option allows you to print a certain range of records. If the range of records you wish to
print exceeds the number of records available, a message will be displayed until the amount of records is equal
or less than the total amount of records available.

« Split job: This option allows you to split the job per record or per page in several outputs. Print speed will be
improved when using limited job sizes.

« Print Technology: Use this option to select a specific print technology that is compatible with your printer. To select
a print technology, simply click on the name of the currently selected print technology, and click the one you want in the
drop-down. For more details on Print Technologies, see "Print Technologies" (page 51). Here are the options available
in the Print Technology group:

« Use OPI, don't spool images: Most print technologies support OPI (Open Prepress Interface), allowing you
to use an image substitution server to speed up the printing process. OPI only supports EPS and TIFF image
formats.

. Store forms on printer's hard disk: Storing PostScript forms (cached reusable content) on hard disk will
prevent out of memory conditions if your document contains large high resolution images. Only use this option if
your RIP has access to a hard disk.

« Custom cache size: Increasing the PostScript form cache size can help to improve performance. You may
want to experiment in order to determine the optimum value. Specifying a custom cache size only works if the
system settings of your RIP are not password protected.

« PDF Settings (Adobe PDF and Adobe PDF/V'T1 only): Click on the drop-down to view the available job
option profiles found on the system, and click one to apply it to the PDF output. The job option profiles are
related to PDF quality settings and can only be created, managed or deleted through Adobe Distiller. For more
information on job options, please see the Adobe Distiller documentation.

Save Print Options: This option allows you to store specific print options with the PrintShop Mail document.

Print: When printing the document and its related files will be sent to PrintShop Mail Web print queue.

Directsmile note: In order to print PrintShop Mail documents using DirectSmile objects with a PrintShop Mail Web
server, you must make sure that the PrintShop Mail Web server has the proper access to the DirectSmile server.

Publishing Documents
PrintShop Mail Web is an easy to use, powerful and open Web to print application that allows for printing over the Web.

PrintShop Mail Design allows to prepare and add documents to PrintShop Mail Web. PrintShop Mail Design documents are used
as the basis for print jobs, meaning that it is possible to reuse the documents by uploading new databases. The designer can
publish (upload) an existing or new document and customers will be able to use PrintShop Web to order print jobs based on
this document. Print jobs can be previewed and validated before they are submitted to the printer.

Preparing PrintShop Mail documents for publishing

You, "the designer" create documents and templates in PrintShop Mail.
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When the document is ready for publishing, you can start the upload process by clicking on Publish to Web selecting the
File menu or clicking the Publish to Web button in the Standard toolbar.

You can design a document with or without linking it to a database. The variable data in the document preview in PrintShop
Web will be based upon Data Fields that you assign in PrintShop Mail. For more information about data fields, see "Data Field
Properties" (page 28) and the "Data Fields Panel" (page 23).

Publishing documents to PrintShop Mail Web

Before publishing your document, you must first ensure that the link between PrintShop Mail Design and PrintShop Mail Web is
established and working.

To set the PrintShop Mail Web Connection

Click on the Edit menu

Click on Preferences

Click the PrintShop Mail Web icon.

Enter the URL, Username and Password for PrintShop Mail Web (see "PrintShop Mail Web Settings" (page 59)).
Verify the information by clicking on Test Connection.

ik

If no PrintShop Web Server address has been defined in the PrintShop Mail Preferences, the document and its attributes
(images and fonts) will be saved in a zip archive (Publish to zip) for later publishing.

To publish your document to PrintShop Mail Web

1. Click onthe File menu.
2. Click Publish to Web... . The Publish to Web dialog appears.
3. Fillin the information in this dialog:

« Name: Enter a name for this document. If the name already exists on PrintShop Mail Web in the same company
and publication type, the document will be overwritten with the one you upload.

« Printer: Select a printer on the PrintShop Mail Web server on which this document is setup to print.

« Operator Instructions: Type in any special instructions to the operator that will print the job. For example,
this can be instructions to cut & stack or post-printing finishing touches.

« Publication Type: This is the publication type as defined in the PrintShop Mail Web server. Publication types
contain one or more document and are part of a company. This dialog displays all the companies that you, as a
user, have access to on the server.

« New Company: If you have the proper permissions, click to open the New Company dialog. Type in a com-
pany name and click OK. New companies are disabled by default.

« New Pub Type: If you have the proper permissions, select an existing company and click to open the New
Publication Type dialog. Type in a publication type name and click OK. New publication types are disabled by
default.

4. Click Next when ready. If your document contains any images, the Add Variable Images window appears.

In the Add Variable Images window, PrintShop Mail displays all the resources that are used by the document including
all external files, PDFs and images. This includes files called using TEXT_FILE as well as fonts. PrintShop Mail Design
detects files called using variable expressions, so all the files here should be the only ones needed. You can, however,
click Show Browser to browse to extra files to upload, select them and click Add to add them.

6. Click Next. PrintShop Mail Design prepares the document by compressing all its files in a single compressed ZIP file.

bl

7. Click Finish to compress the document.

Once the message Successfully uploaded the new document appears, click OK.

9. Check for any warnings then click OK to send the document to PrintShop Mail Web, or Cancel to close the dialog and
return to PrintShop Mail.

0
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,+ Itis possible to upload documents made in older versions of PrintShop Mail WE to PrintShop Web through PrintShop
Mail 5.2 and higher.

What is sent with the document?

When PrintShop Mail Design prepares and sends a document to PrintShop Mail Web, a number of files are included with the
actual PrintShop Mail Design document alongside it in the zip file. This is a list of files that are sent.

« Fonts: Only freely distributable fonts will be added automatically. A warning message will be displayed about fonts
that need license before publishing. You need to verify if the necessary licenses are available to add the fonts that need
licenses. It is possible to choose to upload the licensed fonts directly to avoid a manual upload of the fonts at the
PrintShop Web server.

« Plugins: When publishing a PrintShop Mail document which contains plugin objects, the availability and the version of
the plugin will be checked with the PrintShop Web server before publishing.

« Macros: When publishing a PrintShop Mail document which contains external macros, the availability of the macro will
be checked with the PrintShop Web server before publishing. The check is based on the filename only.

. Images: Allimages that are referred to by the document, even with variable expressions, are sent along.

« PDF Settings: If your document has specific PDF Settings (jobinfos, only used when generating PDFs), they are
included in the zip file.

« Text Files and RTF files: When using the TEXT_FILE function, all text files referred to by your expression are
included.

More information about managing uploaded documents, Companies and Publication Types can be found in the PrintShop Mail
Web Administration Guide.

Automated Printing

PrintShop Mail allows you to automate certain tasks, such as opening and printing documents.

Automation features are no longer sold and are being deprecated. You may continue to use the features, however
/| new dongles are not shipped with these features enabled, and no upgrades are possible with this feature enabled.
= Automation features are now available by combining PrintShop Mail with the power of PlanetPress Workflow Tools,
part of PlanetPress Suite.

Windows

When you right click on a PrintShop Mail document file in a Windows Explorer window, you will notice that the menu contains
the submenu Print. You can print the document without starting PrintShop Mail, and you can drag a PrintShop Mail document
to a specific printer.

More advanced ways of automate the printing process is to use one of the next available features:

« Automated Printing using Command-line Arguments
« Automated Printing using Extended Scripting
« Automated Printing using DDE

Note: To be able to use this feature, you need to activate the automated printing option. See Upgrading PrintShop Mail to
learn how to add this feature to your license.

Note:When using automated printing, any errors will be logged in the Autoprint.log file, which usually is located in:
C:\Documents and Settings\User\Application Data\PrintShop Mail.

If you have installed .NET Framework 2.0, the errors will be logged in the Event Viewer.
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To open the Even Viewer:

« Start/Run/eventvwr.msc, or
« Start/Control Panel/Administrator tools/Event Viewer

Note: Automated printing allows you to print PrintShop Mail documents and PrintShop Mail templates automatically through
the Command line or script file . Make sure to use the appropriate extension (<document name>.psmd or <document
name>.psmt) in the Command line or in the script file.

Mac OS

PrintShop Mail allows you to automate the printing process to a high extend. Instead of opening a document in PrintShop Mail
and selecting the "Print" submenu, the program can be told to monitor a HotFolder and execute print jobs as soon as the neces-
sary files (a PrintShop Mail document and/or a database file) are found there.

« Automated Printing using the HotFolder

Command line Arguments

You can order PrintShop Mail to perform certain actions by specifying them on the command line.

Automation features are no longer sold and are being deprecated. You may continue to use the features, however
|é new dongles are not shipped with these features enabled, and no upgrades are possible with this feature enabled.
= Automation features are now available by combining PrintShop Mail with the power of PlanetPress Workflow Tools,
part of PlanetPress Suite.

Supported command line arguments

Argument Description

Filename of a PrintShop Mail document.
Example: "Mailing November.psmd"

Prints the specified document to the default printer selected in the PrintShop Mail document properties.

<document name>

P Example: "Mailing November.psmd" -p

ot Prints the specified document to a specific printer, enclosed in quotes.
P Example: "Mailing Novembert.psmd" -pt "Laserwriter 16/600"

-db <database> Links the specified document to a certain database.

Example: "Mailing November.psmd" -db "Database.mdb"
How to use command line arguments

A simple example using command line arguments can be created by following the next steps:

1. Create a PrintShop Mail document, for example "Sample.psmd"

2. Create a database you wish to use with this document, or copy an existing database to the folder where you saved the
PrintShop Mail document.

3. Create a shortcut to the PrintShop Mail executable usually located at "C:\Program Files\PrintShop Mail6 \PSMail6x.exe".
Copy this shortcut to the same folder as you saved the document you created in step 1.

4. Rightclick on the shortcut and choose Properties. In the field Target, specify the document name by adding it to the
target. It should look something like "C:\Program Files\PrintShop Mail6\PSMail6x.exe" Sample.psmd.

If you double click on the shortcut you've just created, PrintShop Mail will be started and the specified document will be
opened. You are now ready to use any of the other supported command line arguments by adding them to the target.
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A few examples

"C:\Program Files\PrintShop Mail6\PSMail6x.exe" Sample.psmd -db "Database.mdb"
"C:\Program Files\PrintShop Mail6\PSMail6x.exe" Sample.psmd -p

Dropping a database on a shortcut

You can create a shortcut that will make PrintShop Mail open any supported database you drop on it, by specifying the next
textin the target field of the Shortcut's properties:

"C:\Program Files\PrintShop Mail6\PSMail6x.exe" Sample.psmd -db

If you drop a database on the shortcut, PrintShop Mail will be started, opening the document "Sample.psmd" with the database
you just dropped.

Note: Automated printing allows you to print PrintShop Mail documents and PrintShop Mail templates automatically through
the Command line or script file . Make sure to use the appropriate extension (<document name>.psmd or <document
name>.psmt) in the Command line or in the script file.

Extended Scripting

Extended Scripting is a fast and flexible way of automating your print jobs. This feature allows you to print any PrintShop Mail
document, combined with any database to any printer. You can even schedule an Extended Scripting job on a certain date
and/or time where your printer is usually idle.

Automation features are no longer sold and are being deprecated. You may continue to use the features, however
|é new dongles are not shipped with these features enabled, and no upgrades are possible with this feature enabled.
= Automation features are now available by combining PrintShop Mail with the power of PlanetPress Workflow Tools,
part of PlanetPress Suite.

You specify a certain action, or a range of actions, in a plain text file and tell PrintShop Mail to use that file by adding itto a
shortcut:

1. Create a shortcut to the PrintShop Mail executable usually located at "C:\Program Files\PrintShop Mail6\PSMail6x.exe".
2. Add"-script scriptfile.txt" to the Target in the properties of the shortcut.

Note: When the script file has a name with spaces ("My <space>Script.txt") be sure to enclose this file name with quote
marks ("") in the Target line of the PrintShop Mail shortcut: "C:\Program Files\PrintShop Mail 6\PSMail6x.exe"” -script "My
Script.txt”. Include the quote marks if you copy this line.

In the script you can specify a set of predefined commands to perform certain actions.

Supported Commands

Command Description

Opens the specified document. If another document is opened, it will be closed by PrintShop Mail.

FileOpen [name] Example: FileOpen C:\Documents\MassMailing.psmd

FileClose Closes the currently opened document.
FilePrint Prints the currently opened document to the default printer selected in the PrintShop Mail document
properties.

Prints the currently opened document to the specified printer.
The name of the printer should equal the name specified in the Printer's properties.
Example: FilePrint MyPrinter

FilePrintToFile [file- Prints the currently opened document to the specified file. If its print technology would create multiple

FilePrintTo [prin-
tername]
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Command Description

name] files, FilePrintToFile will generate a zip file.
SetPrintTech [tech- Will change the current print technology.
nology] Example: SetPrintTech Standard

Prints the specified record range to the default printer selected in the PrintShop Mail document prop-
FilePrintRange [start] erties.

[stop] Note: Itis not possible to print a record range to a non-default printer.
Example: FilePrintRange 5 10 Prints record 5 to 10 from the currently opened document.
FileExit Quits PrintShop Mail. No other scripting commands followed by this command are executed.

Opens the specified database. If any other database is opened, it will be closed by PrintShop Mail. If the

database contains multiple tables, DatabaseOpen will automatically select the first table. You can then
DatabaseOpen [file] use DatabaseSelectTable to select a different table.

Example: DatabaseOpen C:\Documents\Example.mdb

Opens the Microsoft Access database "Example" from the folder C:\Documents.

Opens the specified data source. If any other database is opened, it will be closed by PrintShop Mail.
Example: DatabaseOpenODBC MyDSN
Opens the data source called "MyDSN"

DatabaseOpenODBC
[source]

DatabaseSelectTable

Selects a different database table in the currently opened document.
[table name]

Filters the database according to the specified filter.
DatabaseFilter [filter] Example: DatabaseFilter [CITY] = 'New York'
Filters the database, only records where the value of field "CITY" equals "New York" will be used.

Closes the currently opened database.

DatabaseClose Example: DatabaseClose

The argument <technology > must have one of the following predefined values.

Print Technology  Script Value
Standard PostScript SetPrintTech Standard
Optimized PostScript SetPrintTech Optimized

Adobe PDF SetPrintTech PDF
Adobe PDF/VT1 SetPrintTech PDF/VT1
AHT SetPrintTech AHT

Creo VPS SetPrintTech VPS
FreeForm SetPrintTech FreeForm
FreeForm2 SetPrintTech FreeForm2
PPML SetPrintTech PPML
PPML/VDX SetPrintTech PPMLVDX
VIPP SetPrintTech VIPP

How do I create an Extended Scripting job?
You create an extended scripting job by following the next steps:

1. Create a PrintShop Mail document and save it, for example "ScriptTest.psmd".
2. Create a texffile containing all commands you want to perform.
3. Create a shortcut to PrintShop Mail.
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4. Add the argument "-script scriptfile.txt" to the command line (where "scriptfile.txt" is the textfile containing the com-
mands)

Note: Itis advised to save your script file as "UNICODE" encoding.

Note: Automated printing allows you to print PrintShop Mail documents and PrintShop Mail templates automatically through
the Command line or script file . Make sure to use the appropriate extension (<document name>.psmd or <document
name>.psmt) in the Command line or in the script file.

In the script file, you specify all commands you want to perform:

FileOpen ScriptTest.psmd
FilePrint
FileExit

This simple scriptfile opens the document "ScriptTest.psmd", prints it to the default printer and quits PrintShop Mail.

You can create a batch process by telling PrintShop Mail to use another document:

FileOpen ScriptTest.psmd
FilePrint

FileOpen AnotherDocument.psmd
FilePrint

FileExit

PrintShop Mail first opens the document, "ScriptTest.psmd" and prints it to the default printer. When this is done, PrintShop
Mail opens the second document, "AnotherDocument.psmd" and prints it to the same default printer. Of course, you can
choose to specify a different printer by using the command "FilePrintTo". Finally, PrintShop Mail exits.

It's possible to use the same document with different databases:

FileOpen ScriptTest.psmd
FilePrint

DatabaseOpen AnotherDatabase.MDB
FilePrintTo Printer2

FileExit

This opens the document "ScriptTest.psmd" and prints it to the default printer. When this is done, PrintShop Mail opens the
database "AnotherDatabase.MDB" and prints it to another printer, called "Printer2". Finally, PrintShop Mail exits.

A combination of the commands is also possible:

FileOpen ScriptTest.psmd
FilePrintRange 5 10

DatabaseOpen AnotherDatabase.MDB
FilePrintRange 10 15
DatabaseOpen ThirdDatabase.XLS
FilePrintTo Printer?2

FileOpen Document2.psmd
FilePrint

FileExit

This opens the PrintShop Mail document "ScriptTest.psmd" and prints records 5 to 10 to the default printer. When this is fin-
ished, it opens the database "AnotherDatabase.MDB" and records 10 to 15 are printed to the default printer. Then, the data-
base "ThirdDatabase.XLS" is opened and all records are printed to printer "Printer2". Eventually, the PrintShop Mail document
"Document2.psmd" is opened, printed to the default printer and PrintShop Mail exits.
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It's possible to change the Print Technology used when the document was created, or print the same document using different
Print Technologies:

FileOpen ScriptTest.psmd
SetPrintTech Optimized
FilePrint

FileOpen ScriptTest.psmd
SetPrintTech Standard
FilePrint

Database Filters

A database filter consists of a field name, an operator and a condition. Suppose you have the following database:

NAME CITY GENDER
Eddy New York M

Pamela Los Angeles F
Tim Washington M

Robert New Jersey M

The available field names in this database are "Name", "City" and "Gender". The database has 4 records.

An operator should be one of the ANSI SQL operators listed in the table below.

Operators Definition
Equal
> Not equal
Less than
Greater than
Less than or equal
Greater than or equal

vV ANV A A

A filter is used to construct the WHERE clause of an SQL statement. It does not include the reserved word WHERE to filter the
record set.

Except for "Distinct", "Like" and "Between", all SQL commands are supported. For more information about the SQL com-
mands, please visit www.sgl.org.

If you want to select and print the records where the field name "City" equals "New York", the following line should be added
to the script file:

DatabaseFilter [CITY] = 'New York'
Result: One record will be printed.

Note: Please notice that we have used single quotes around the conditional values 'New York'. SQL uses single quotes around
text values. Numeric values should not be enclosed in quotes.

Suppose you want to send a mailing to all persons in the database where [GENDER] does not equal 'F'. The filter should look
like:

DatabaseFilter [GENDER] <> 'F'

Result: Three records will be printed.
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Or, you want to print all records where the [GENDER] equals 'F' OR where [CITY] does not equal 'Washington':
DatabaseFilter [GENDER] = 'F' OR [CITY] <> 'Washington'
Result: Three records will be printed

These are just three examples of a database filter. You can create very advanced and powerful database filters. Please refer
to your SQL manual or an online resource for advanced examples.

If you need to have data from more than one table in the database, you can make a query in SQL or MS Access and export the
result of this query into Excel, Access or a text file. This file can be used as a database in PrintShop Mail.

Scheduling a job

Itis possible to schedule a certain job on a certain date and time. This can be achieved by using the Windows Scheduler. For
more information about the Windows Scheduler and how to create a scheduled task, please refer to your Microsoft Windows®
manual.

DDE

DDE Dynamic Data Exchange is a more flexible way to automate printing than using command line arguments, but it requires
knowledge of a programming language that supports DDE, such as Visual Basic or C++. Please refer to the Win32 API doc-
umentation to learn how to establish a DDE connection.

Automation features are no longer sold and are being deprecated. You may continue to use the features, however
|é new dongles are not shipped with these features enabled, and no upgrades are possible with this feature enabled.
= Automation features are now available by combining PrintShop Mail with the power of PlanetPress Workflow Tools,
part of PlanetPress Suite.

To connect to the PrintShop Mail DDE Server, make sure PrintShop Mail is running and open a DDE-connection to server
"PrintShopMail6".

Visual C++ 6.0

// include "ddeml.h"

UINT iReturn = Ddelnitialize(&idInst, (PFNCALLBACK)DdeCallback,
APPCLASS_STANDARD | APPCMD_CLIENTONLY, 0);

HSZ hszApp = ::DdeCreateStringHandle(idInst, "PrintShopMail6", 0);
HSZ hszTopic = ::DdeCreateStringHandle(idInst, "C:\\untitled.psmd", 0);
HCONV hConv = ::DdeConnect(idInst, hszApp, hszTopic, NULL);

:: DDEExecute(idInst, hConv, "[FileExit]");

Visual Basic 6.0

TextBox.LinkTopic = "PrintShopMail6|Connect" ' Set link topic.
TextBox.LinkMode = vbLinkManual ' Set link mode.

On Error Resume Next "TextBox thinks DDE is not executed,

'when actually itis.

TextBox.LinkExecute "[FileExit]"

©2016 Objectif Lune Inc -115- PRINTSHOP MAIL .


http://www.objectiflune.com/OL/Products/PlanetPressSuite/Index.aspx

Document Output

On Error GoTo 0

PrintShop Mail accepts the following DDE commands:

Command Description

[FileNew] Closes the current document (if any) and creates a new document.
[FileOpen "filename"] Opens the specified document.

[FileClose] Closes the current document.

[FilePrint] Prints the current document to the default printer.

[FilePrintRange "start", "end"] Prints a range or records to the default printer.

[FileExit] Closes PrintShop Mail.

[DatabaseOpen "filename"] Opens the specified database.

[DatabaseClose] Closes the current database.

[DatabaseOpenODBC "source"] Opens the specified ODBC data source.

Note: This only applies to PrintShop Mail 6.x or later. PrintShop Mail 4.x and 5.x are slightly different. If desired, the text can
be adapted for 4.x and 5.x by changing the word “PrintShopMail6” to “PrintShopMail4.x" or PrintShopMail5.x (all 3 occur-
rences).

HotFolder

4 This page refers to PrintShop Mail Mac Edition only. For Windows users, you can automate PrintShop Mail using Plan-
etPress Workflow.

This feature allows more than one user to "drop" their database files and/or documents into the "HotFolder", causing a print
job to start without further interaction (and without even needing access to the PrintShop Mail program from their computers).

= You can transfer your database into the HotFolder using an AppleScript or other third-party automation tools. For
5 example, if you receive your database via Email you can use an AppleScript to retrieve the attachment from the inbox
and place it in the HotFolder.

Initializing the HotFolder

From the PrintShop Mail menu, select Preferences and click on the HotFolder icon.
Click on Browse to select the folder containing the desire documents to monitor.

Click Apply.

From the File menu, select Monitor HotFolder.

To stop monitoring and automatic printing of the document, click on the Cancel button.

kN =

Using the HotFolder

1. Create a PrintShop Mail document and store it in the HotFolder.
Since there will not be any user interaction with the program when the document is automatically printed, users should
verify the document before saving it.

2. Drop the document or/and the database file into the HotFolder.
Within 30 seconds, PrintShop Mail combines the database with the available PrintShop Mail document and starts the
print job.

3. After PrintShop Mail has printed the document, the database file is moved to a folder "PSMPrinted", in the HotFolder.
The PrintShop Mail document remains in the same location and can be used again.

4. PrintShop Mail writes a log of its actions into a log file. Since the timestamp of the log file is automatically adjusted every
time when PrintShop Mail becomes active, this timestamp can be used to check whether PrintShop Mail is still running
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or not. If no PrintShop Mail document and/or database file was found, the log file is still updated. The log file is located
in the folder /Users/user name/Library/Logs/PSM.log.
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L4 Using Expressions

The Expression Editor . . 119
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EXPression OPerators . L 123
Favorite EXPresSIONS | 124
Functions Overview 127

The Expression Editor

Expressions allow you to display information in your document by using special functions, operators and conditions. By com-
bining these features, you can manipulate data and text coming from the database and display it on the page depending on cer-
tain criteria.

The Expression Editor interface appears whenever you edit a variable by double-clicking on it in the Variables tab (see "Work-
ing With Variables" (page 91))

-'.) Edit Expression for "expression” = X
PROPER {|/[Nam=]) Y 4
w
Expression result; 'Cynthia Proctor’ I
4, le=5] Components | Fp Favortes 3

= Al Functions: i ( | Data Fields: te— 7
e String PAGE NR o bl Address
BOS CDID.r
Mumber BOSTHET Email
6, o= Barcode E] Phe

Logical RECORD COUN... [E] E] C} . 3

RECORD NR

REFLACE TR
FPROPER(Text) - 9
- Converts the first letter of each word to an uppercase character, and the rest to lowercase.
PROPER{"PERSOMALIZED printing”)} == "Personalized Printing” . 10
| @ | | Filename... | | oK | |  Cancel |
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1. Expression Edit field: Allows adding, deleting and modifying the expressions. See "Building Expressions" (page
120).

2. Expression result: Checks the expression and shows the result if the expression is valid.

3. Favorites: Allows saving the favorites expressions. See "Favorite Expressions" (page 124).

4, Components: Shows the components you can use to build your expressions, such as Functions, Operators and Data
Fields.

5. Functions: Shows the functions list. See "Functions Overview" (page 127).

Open Assistant button: Opens a new Expression Assistant window for that function. See "Building Expressions"

(page 120).

Data Fields: Shows the content of the opened database.

Operators: Allows combining, comparing or modifying the value of an expression.

Help text: Shows the description of the selected function.

Example: Shows an example of the selected function and the result of the function when applied.

o

© v ooN

1
Expression texts are displayed as follows:

« Blue text: Functions

. Green text: String

« Purple text: Database fields
« Red text: Logical

. Dark red text: Variables

Building Expressions
Expressions are built from the following components:

. Database Fields: You can add fields from your database into the Expression Editor, by double-clicking on the field in
the "Data Fields:" list. Database fields are always surrounded by square brackets (e.g. : [FirstName])

« Variables: You can refer to any variable except the one that you are currently editing. Variables are always sur-
rounded by the variable markers (e.g.: @MyVariable@)

« Constants: PrintShop Mail has a few constant values you can use such as "true" and "false".

« Functions: You can use functions to manipulate the data into many different ways. Functions are built from the func-
tion name followed by its parameters surrounded by parenthesis, such as FUNCTION(Param1,"Param2").

« Strings: You can add static text to the expressions. Static text is always surrounded by double quotes (e.g.: "Hello
World!").

« Operators: You can manipulate data using operators such as mathematical operators (+, -, etc) and concatenations
(&, AND, OR, etc).

You build your expression by adding these components so they work together. You can do this manually by starting to type
any of the component's name in the Expression Edit field.

The Expression Editor tries to automatically complete variable names, database fields, functions and constants for

4 you. For example, if you type "P" in the Expression Edit field, a list of functions will automatically appear, starting
with the ones with the letter P. You can use the up/down arrow keys to navigate this list and press Enter to select it
from the list.

You can also add components to the expression automatically by using the function list, data field list and operators box below
the Expression Edit field. For example, double-clicking on the PROPER() function will automatically add PROPER(Text) to
your Expression Edit field.
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Q Edit Expression for "expression”

PROPER (Text)

] »

Expression result:

[&] Components | Fp Favorites

& Al | Functions: | Data Fields:
i PAGE HR I ™ E] Address
Sl - E} Color

BOS

humber | posTHET e

Firstname

Barcode E] Lastname
et RECORD COUN... [E] E]C] ;J:;ﬂnee

REECORD MR

REPLACE v e o

FROPER{Text)
- Conwverts the first letter of each word to an uppercase character, and the rest to lowercase.

| FROPER{"PERSOMNALIZED printing") = "Personalized Printing”

|@| | Filename... | | 0K || Cancel

The Expression Assistant

When using functions in your expression, you can use the Expression Assistant to help you fill in the function's parameters
and values. To do this, click on the [...] icon next to the function name. You can also double-click on the function name in the
Expression Edit field to open the Expression Assistant.
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Q Function arguments for: PROPER

~ PROFER

Texd * *  String

PROPER{Text)

Text Arty tesd expression or data field containing a text.

Function result:

Converts the first letter of each word to an uppercase character, and the rest to lowercase.

| PROPER("PERSONALIZED printing"} => " Personalized Printing”

| oK || Cancel |

To help you to add the correct names of database fields, variables or functions, you can select those items from the pop up
menu on the right hand side of the edit box.

0 Function arguments for: PROPER B X
~ PROPER
Text * o et
Database  » Firstname
Variables * Lastn
PROPER(Texd) asinams

Functions 3 Prefix

Text Any text expression or data field containing a text. Brnse

Function result:

Converts the first letter of each word to an uppercase character, and the rest to lowercase.

FROPER({"PERSOMNALIZED printing") =3 "Personalized Prirting”

| 0K | | Cancel |

The result of the function you created here, will be pasted into the Expression Edit field. For example: PROPER ([First
name]).
Result and debugging

You can always see the result of the expression itself just under the Expression Edit field. If there are any errors in the expres-
sion or if your expression returns no result, this box will be empty. If the result is a constant such as PRINT or SKIP, or if itis a
number, the result is always shown as a string of text in the Expression Results box.

If there is any error in your expression, a few things can happen:
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« Database fields that do not exist will be shown in darker purple, and will be italicized.

« Functions that do not exist will remain in normal, black text.

« Parameters of the wrong type will be underlined and put in bold (example: putting a number in the PROPER() function,
which expects a string)

« The Expression Result box will not display anything.

« Anerror will be displays in a small tooltip with a red X icon. This tooltip should explain the error in a basic way.

When you click OK to save the expression and close the Expression Editor, further validation is done, and any error will be
shown in the Expression Edit field as a tooltip. The expression will not be saved until you correct the error and click OK again.

Variable Dependencies

You can use regular and global variables within your expression the same way you would use them in your document by enter-
ing the variable name surrounded by the variable marker (by default the @ symbol, e.g. @MyVariable@). If you attempt to
use the name of a variable within its expression (such as entering @MyVariable@ while editing the MyVariable expression),
this causes a "Deadlock" error, also known as a circular reference. This permits you to re-use expressions by calling their vari-
able within another expression, as well as break up complex expressions into smaller parts.

Variables names are case-sensitive. This means that @myvariable@ is not the same as @MyVariable@, or
'+ @MyVaRiAbLe@. If you type in a variable name that does not exist, it will be created in the Variables panel and given
an empty string ("") expression.

Expression Operators

The operators used in the expressions are displayed in PrintShop Mail in the "Components" section of "The Expression Editor"
(page 119). To add an operator in your Expression Edit field at the location where your cursor is located, simply click on the
desired operator (you can also type any of these operators except the Line Feed character, which is not on your keyboard).

o
* )
L E
} }: =
g+ 1

There are more than one kind of operator. Here is an exhaustive list.

Mathematical Operators:

Operator Definition Example Result‘
+ Add 23+11 |34
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Operator Definition Example Result

= Subtract 30-2 28
* Multiply 2*5 10
/ Divide 42/2 21
Comparison Operators:
Operators Definition Example Result
< Less than (32<21) FALSE
<= Less than or equal (21 <=21) TRUE
<> Not equal ("Foo" <> "Bar") TRUE
> Greater than (55> 3) TRUE
>= Greater than or equal | (43 >= 44) FALSE
= Equal ("String" = "Strings") | FALSE
Other Operators:
Leftand . . o C . .
(and) |Right par- Gives prlorlty to V\{ha.t is inside of the parentheses just like in mathematical operations. Can also
entheses be used to give priority to conditions.
. Double !_itergl strings (text) en’iered into an e'>l<pression needs to be surrounded by double-quotes to be
identified as such (e.g. "Hello, World!"). However, no other component should use double-quotes
quotes (number, functions, database fields or variables).
Comma Commas in strings (e.g. "hello, henry") are simply printed as commas. Commas in functions (e.g.
! COUNTER(1, 50, 2) ) are used to separate the parameters used by that function.
Decimal Decimal points in strings (e.g. "This is a sentence.") are simply printed as a decimal point.
point Decimal points in numbers (e.g. 529.54) are used to indicate decimal values such as currency.
& Ampersand ngensv n;zc(ajrjavcld” irse:fltlatc: :0" ;(oaﬂ(c)a\f\tlagj;?"(.put together) two strings. For example, "Hello
The new line character will create a Carriage Return/Line Feed in a string. This is useful to create
q New Line an expression that will print out in multiple separate lines in your document. Note that the new
line character is added with surrounding ampersands, as itis always concatenated.

Favorite Expressions

You can use the Favorites tab in the Expression Editor to save expressions that you use often in your documents. These favor-
ite expressions will be saved in the software preferences, not your document, so they can be used in any documents you cre-
ate or edit in the future.

To see your existing favorite expressions:

1. Openthe Expression Editor.
2. Gotothe Favorites tab.
3. The favorites are listed in the box on the left.
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To add a new favorite expression:

1. Openthe Expression Editor.

2. Build or write the expression that you want to save as your favorite.

3. Gotothe Favorites tab.

4. Copy the expression (select your expression then to CTRL+C on Windows or # + C on Mac OS)
5. Click New.

6. Typeina name for the favorite expression in the Name field on the right.

7. Paste the expression in the box under the name.

8. Click on Save.

To de

lete an existing expression:

Open the Expression Editor.

Go to the Favorites tab.

Click on the name of the favorite expression you want to delete.
Click on Remove.

PO

Inserting a Salutation

You can generate salutations with a conditional IF statement. If you have a field in your database that specifies the gender of
the person, you can use it to add 'Mr." or 'Mrs.' to the name.

Example

First Name Last Name Gender

John Abrahams M
Theresa Johnson F
William Fremont M

This example uses the IF function in combination with the "&" operator, which allows you to combine text strings.

"Dear" & IF([Gender]="M", " Mr. ", " Mrs. ") & [First name] & " " & [Last name]

This will result in a string that always starts with Dear , continues with either Mr. or Mrs. depending on the gender, and always
finish with the first name, then a space, then the last name:

First Name Last Name Gender Result

John Abrahams M Dear Mr. John Abrahams
Theresa Johnson F Dear Mrs. Theresa Johnson
William Fremont M Dear Mr. William Fremont

Custom Serial Numbers

PrintShop Mail allows you to create customized serial numbers. You can use these numbers to serialize such items as raffle
tickets, coupons or self-mailers. In combination with the barcode functions, you can create serially numbered barcodes.

You do not need to have a database to create serial numbers. You can change the number of Items without a database in the
Preferences dialog box, from the Edit menu, select Preferences, or in the Database toolbar, enter the desired number of
records and press Enter. From the PrintShop Mail menu, select Preferences (Mac 0S).
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This example creates a Code 39 barcode. The custom serial number starts with "SWA", and ends with a counter, counting

from 1 to 1000. The functions used are:

. CODE39
« COUNTER

After a text box with a variable for the barcode is created, the barcode function is attached to the variable.

CODE39 ("SWA" & COUNTER (1, 1000, 1, 4,
The result in PrintShop Mail:
*SWAO0001*, *SWA0002*, *SWAO0003*, etc.

After the correct barcode font is selected, the result is:

+ SHADDD2+

* 5 WA

0003 =+

* S WA1T0O00 =+

Padding a string

True))

You can use an expression to automatically pad a string or number to a certain number of positions, by using a combination of
the RIGHT() function and by concatenating the string with the characters you want to pad with.

Example: Padding a string with dots (periods) to 20 positions:

RIGHT (Mt e et e eeeeeeennnnn " & [DataFi
Result (if [ DataField] contains "Example™):

............. Example

eld], 20)

Example: Padding a 5-digit zip code with zeroes, to 5 positions (this is useful if PrintShop Mail sees the zip code as a number

and removes the zeroes automatically):

RIGHT ("00000" & [ZipCode], 5)
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Result (if [ZipCode] is 1234):

01234

Functions Overview

You can use the following functions in PrintShop Mail:

Operator
ABS
AND
ASC

BLANK

CHANGED
CHR
CODABAR
CODE128
CODE39
CONTAINS
COUNTER
DATE

DIV
EAN13
EANS
FALSE
FILE_EXIST
IF

INT

ITF

JAN13
JANS

KIX

LAYOUT _
COUNT

LAYOUT_NR

LEFT
LEN
LOWER
LTRIM

MID

MOD
MSI

NOT
NW7
OBJECT_

Function

Returns the absolute value of <Number>.

Returns True if both <Logical value 1> and <Logical value 2> are True.
Converts the leading character in <Text> to its numeric UNICODE value.

Layout action constant. If your layout condition evaluates to BLANK, then the layout will be left blank when the document is
printed.

Returns True if the current expression result differs from the result of the previous record.

Returns the character represented by UNICODE index <Number>.

Computes a CODABAR barcode.

Computes a CODE128 barcode.

Computes a CODE39 barcode.

Returns True if <Text> contains <Text to find>, returns False otherwise.

A counter which by default counts from the first to the last record. Arguments are optional.

Returns the current date, formatted according to <Date string format> (optional) or the system regional settings.
Returns the integral quotient from dividing <Number> by <Divider>.

Computes an EAN13 barcode.

Computes an EAN8 barcode.

Logical constant False.

Returns True if the file <Filename> exist on disk.

Gives one of two results depending on a condition you specify.

Returns the integral part of a floating point number.

Computes an ITF barcode.

Computes a JAN13 barcode.

Computes a JAN8 barcode.

Computes a KIX barcode.

Returns the number of layouts associated with the current record, taking into account any skipped layouts.
Layout counter that is reset after every record. It does not count skipped layouts. Note: LAYOUT_NR cannot be used in layout
conditions.

Returns the specified number of characters in the supplied text, counting from the left.

Returns the number of characters in <Text>.

Returns all letters in the given text as lowercase.

Returns the supplied text, stripped of all leading spaces, tabs and newline characters.

Extracts characters from the supplied text, starting at the character position specified by start position and containing the num-
ber of characters specified by size.

Returns the remainder after the specified number is divided by a divisor.
Computes a MSI Plessey barcode.

Returns True if <Logical value> is False, and False otherwise.

Any expression which results in a logical value, example True or False.

Determines whether a object with the specified name is empty. Returns True or False.
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EMPTY
ONECODE
OR

PAGE_
COUNT

PAGE_NR
POS
POSTNET
PRINT
PROPER

RECORD_
COUNT

RECORD_NR
REPLACE
RIGHT
ROUND
RTRIM

SGN

SKIP

STR
TEXT_FILE
TODAY
TOTALPAGES
TRIM

TRUE

UPCA

UPCE

UPPER

VAL

YuBar
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Function

Computes a ONECODE barcode.

Returns True if either <Logical value 1> or <Logical value 2> is True.
Returns the total number of pages at printing for this document.

Returns the page number at printing time, or 1 at design time. Note: PAGE_NR cannot be used in layout conditions.
Returns the character position of a searched string in text. Returns 0 if not found.

Converts a 5 digit (zip code), 9 digit (zip+4 code), or an 11 digit (delivery point barcode) to a valid POSTNET barcode.
Layout action constant, can only be used in layout conditions.

Convert the first letter of each word to an uppercase character, and the rest to lowercase.
Returns the total number of records of the database.

Returns the current record number of the database.

Looks for <Text to find> in <Text> and replaces every occurrence with <Replace with text>.

Returns the specified number of characters in the supplied text, counting from the right.

Returns the supplied number rounded off to the specified number of decimal places.

Returns the supplied text, stripped of all trailing spaces, tabs and newline characters.

Returns one of three possible values (-1, 0 or 1), depending whether the number is negative, zero, or positive.
Layout action constant, can only be used in layout conditions.

Converts a number to data type Text, for use with functions that expect text arguments.

Returns the contents of the TXT or RTF file <Filename>.

Returns the current date, according to the computers internal calender, formatted according to the system regional settings.
Returns the number of pages in a PDF file, or the number of frames in a multi-frame TIFF or GIF file.

Returns the supplied text, stripped of all leading and training spaces, tabs and newline characters.

Logical constant True.

Computes a UPCA barcode.

Computes a UPCE barcode.

Returns all letters in the given text as uppercase. Use the UPPER function to ensure consistent data entry of such things as
state abbreviations or postal codes.

Converts a string representing a number to data type Number, for use in functions that expect numeric arguments.

Computes a YuBar barcode.

Barcode Functions

Barcode functions and fonts are deprecated in PrintShop Mail 7.0 for Windows. We strongly advise using the "Barcode
Object" (page 86) instead.

Available Barcode Types in PrintShop Mail:

« Codabar: Codabar (also known as NW?7) is generally used in health care, chemical processing, express delivery and
government.

« Code 128: The most common use of Code 128 is for shipping labels.

« Code 39: Code 39 is a widely used industrial barcode and is mandated for some automotive industry and Department of
Defense labels, because of its ability to represent alphanumeric data. Code 39 is a bidirectional, self-checking, discrete
and variable length code.

« EAN/UPC: The EAN (European Article Numbering) and UPC (Universal Product Code) is used through the world to mark
physical goods in retail shops.
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« ITF (Interleaved 2 of 5): ITF is one of the most popular barcode used by shipping and warehouse industries for iden-
tification. Itis also used in the medical and automotive fields.

« JAN: The JAN (Japanese Article Numbering) is similar to EAN, used in Japan.

« KIX: KIX barcode is used by the Dutch post office for mail addressing.

« MSI/Plessey: MSI/Plessey (Modify Plessey Code) barcode, are mostly used for marking retail shelves for inventory con-
trol. MSI is a variable length symbology, however various applications use fixed length codes.

« NW?7: Is used atlibrary, parcel delivery service and various other purposes.

« ONECODE: ONECODE barcode used to sort and track packages from their origins to their destination.

o POSTNET: The POSTNET (Postal Numeric Encoding Technique) symbology was developed in the United States for the
automatic sorting of mail. POSTNET is only used for mailing address marking.

Barcode Fonts

The table below reflects an example of which font name can be used with each barcode.

Barcode PrintShop Mail Font Name Example
CODABAR PSMCbar PSMCbarHrP24DhTt
CODE 128 PSMC128 PSMC128Bwr3P36DhTt
CODE 39 PSMC39 PSMC39HrP24DhTt
EAN 13/ EAN 8 PSMEan PSMEanBwrP36Tt
ITF PSMInt PSMIntHrP72DmTt
JAN 13/JAN 8 PSMJan PSMJanBwrP36Tt
MSI PSMMsi PSMMsiHr72DhTt
NW7 PSMNW?7 PSMNW?7HrP48DmTt
ONECODE OneCode Barcode PSMOneCode
POSTNET PSMPostNet PSMPostNetHrTt
UPCA/UPCE  PSMUpc PSMUpcP72Tt

PrintShop Mail font name description

P = Point size. The Point size refers only to the height of the font. For example if you see C39HrP24DmTt, the P used here

refers to the point size of 24.

Dh, Dm and DI = Density (high, medium and low).The density of a barcode is the number of characters per inch (cpi) of the
printed barcode. It is of great practical importance since it determines the minimum barcode length required to print the
desired information. The higher the density, the shorter the barcode.

Hr= Human Readable characters. These characters are printed below the barcode.

Bwr = Bar Width Reduction. The font includes technology to reduce the width of the individual bars uniformly across the bar-
code without changing the center line of the barcodes.

Note: You can install the barcode fonts library from the PrintShop Mail Installers folder on the CD.

The PSMFimCodesTt font, used to generate POSTNET barcode, is a special font used by the US Post Office to separate busi-
ness reply mail from other mail. The FIM font consist of four unique barcodes, each barcode represents a unique reply mail
classification.

Font Information

« Each font name starts with the letters “PSM”.
« Some fonts come in human readable versions.
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« Each font has different densities (thicknesses) depending on printer capability. It is recommended that samples of each
density be printed to verify quality and readability.
« Font Style: must always be Regular.

Barcode Setup
Below are the steps for setting up a barcode. A Postnet barcode is used for this example.

Click on the text tool on the Tools toolbar to draw a text box, or from the Insert menu, select Variable Text.

Type a variable name, example @Barcode@.

Double click on the Barcode field in the Variables panel, to open the Expression Editor.

Click the radio button titled "Barcode" to display all barcode generators and select the required function from the list. A

barcode function translate a numerical code to a text string, which yields the desired barcode when printed with a spe-

cial barcode font. Select POSTNET by double clicking on it.

5. As the argument to the barcode function, enter the database field that contains the code that should be translated into a
barcode. Some barcode functions require another argument.

6. Click OK.

Note: PrintShop Mail Postnet function and font, only works with 5, 9 and 11 digit number strings. No hyphens can be in

the string.

Select the variable @Barcode@, and pick the barcode font, that is specified for use with the chosen barcode generator.

8. From the Text Formatting toolbar or from the Text menu, select the desired PrintShop Mail font. Adjust the font size to

show the barcode at the specified or desired size.

PN

N

CODABAR

4 Barcode functions and fonts are deprecated in PrintShop Mail 7.0 for Windows. We strongly advise using the "Barcode
Object" (page 86) instead.

Syntax CODABAR(Text, Start character, Stop character, Check digit)
Description Computes a CODABAR barcode.
Example  CODABAR("123456", "A", "B", True)

Result Hl m‘"HH'H'HHH"H" |H

1234567 8

Parameter description

The value represented by the barcode.Codabar barcodes can include numeric characters, special characters

Text (-$:/.+) and spaces.
Start char- One of four special start/stop characters A,B,C and D.
acter
Stop char- .

One of four special start/stop characters A,B,C and D.
arcter

Check digit True or False. Default value is False.

Codabar is useful for encoding dollar figures and mathematical figures. These barcodes are slightly larger than Interleaved 2
of 5 barcodes.

Codabar requires start and stop characters. The check digit is optional.
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CODE 128

Barcode functions and fonts are deprecated in PrintShop Mail 7.0 for Windows. We strongly advise using the "Barcode

—~ Object" (page 86) instead.

Syntax CODE128(Text)
Description Computes a Code128 barcode
Example  CODE128("123456"

)

Parameter description
Text The string to be represented as barcode. The full (128-character)ASCII character set can be encoded.

Result

This symbology is a very compact barcode for all alphanumeric applications.

The full (128-character) ASCII character set can be encoded in this symbology without the double characters found in exten-
ded Code 39.

If the barcode has four or more consecutive humbers (0-9), the numbers are encoded in double density mode (where two
characters are encoded into one character position).

Code 128 actually has three different character code subsets. It has two forms of error checking, making it a very stable bar-
code.

Checksums are not required.

If you have a choice, Code128 is generally the best all round one.

CODE 39

.+ Barcode functions and fonts are deprecated in PrintShop Mail 7.0 for Windows. We strongly advise using the "Barcode
Object" (page 86) instead.

Syntax CODE39 (Text[,Check digit])
Description Computes a Code39 barcode.
Example  CODE39("Example", True)

cesae LT TR

*EXAMPLEA®

Parameter description

Text The string to be represented as barcode. The full (128-character)ASCII character set can be encoded.
[,Check digit] Optional, True or False. Default value is False.

Code 39 (or Code 3 of 9) is the most common barcode in use for custom applications. It is popular because it:

« Supports both text and numbers (A-Z, 0-9, +, -, ., and <space>).
« Can be read by almost any barcode reader in its default configuration.
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« Is one of the oldest of the modern barcodes.
Code 39 s a variable width barcode, and it can support any number of characters that the reader can scan.
Itis used in many military and government specifications.
Code 39 barcodes are self checking and are not prone to substitution errors.

EAN 13

Barcode functions and fonts are deprecated in PrintShop Mail 7.0 for Windows. We strongly advise using the "Barcode
Object" (page 86) instead.

Syntax EAN13(Text)
Description Computes an EAN13 barcode
Example  EAN13("978123456789")

2345678

Result

Parameter description

Text Any text expression or data field containing a text to be represented by the barcode.
EAN (European Article Number)

This function prints the variable barcode for the string using the EAN13 standard, which consists of an 12 digit numeric code.
To print the barcodes, a special barcode font is needed.

The EAN13 code is used for overseas applications where a country code is required. The UPCA symbology is actually a subset
of the EAN13 symbology.

This barcode is composed of 2 numbers for the country code, 10 numbers for the data characters, and a checksum. The check-
sum is generated automatically.

EAN 8

Barcode functions and fonts are deprecated in PrintShop Mail 7.0 for Windows. We strongly advise using the "Barcode
Object" (page 86) instead.

Syntax EANS8(Text)
Description Computes an EAN8 barcode.
Example  EAN8("9712345")

Result Hll]”” H”H 1|
'9712"3453"

Parameter description

Text Any text expression or data field containing a text to be represented by the barcode.

EAN (European Article Number)
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This function prints the variable barcode for the string using the EANS standard, which consists of an 7 digit numeric code. To
print the barcodes, a special barcode font is needed.

The EANS code is similar to the EAN13 barcode. Is used for overseas applications where a country code is required, only five
numbers are used.

This barcode is composed of 2 numbers for the country code, 5 numbers for the data characters, and a checksum. The check-
sum is generated automatically.

ITF

Barcode functions and fonts are deprecated in PrintShop Mail 7.0 for Windows. We strongly advise using the "Barcode
Object" (page 86) instead.

(Interleaved 2 of 5)

Syntax ITF(Text [,Check digit)

. .. Computes an ITF barcode .ITF has the flexibility to encode any even number of digits. If you have an odd num-
Description . . .
ber of digits, a leading zero will be added.

Example ITF("1234567890")

T

Parameter description

Text Any text expression or data field containing a text to be represented by the barcode.
Check digit Interleaved 2 of 5 is prone to substitution errors, it is advised to use a check digit.

Also known as 120f5, this is a numeric only barcode that prints out a little larger than the UPCA barcode when 10 digits are
encoded.

This symbology has the flexibility to encode any even number of digits.

This barcode is an excellent candidate for numeric only applications, and it is the best symbology to use for fixed mount read-
ers.

Because Interleaved 2 of 5 is prone to substitution errors, you should always use a checksum.

JAN 13

Barcode functions and fonts are deprecated in PrintShop Mail 7.0 for Windows. We strongly advise using the "Barcode
Object" (page 86) instead.

Syntax JAN13(Text)
Description Computes JAN13 barcode
Example  JAN13("123456789012")

a0

Result
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Parameter description

Text Any text expression or data field containing a text to be represented by the barcode.

JAN (Japanese Article Number)

JAN code is most popular barcode for products in the shop. JAN13 is called as standard code.

JAN13 represents fixed length 13 digits number. It requires fixed length 12 digits of numeric characters for input.
MOD10 check digit is automatically calculated and added.

This barcode is composed of 2 numbers for the country code, 10 numbers for the data characters, and a checksum. The check-
sum is generated automatically.

For JAN barcodes the first two numbers must be 45 or 49 which identifies Japan.
JAN code is equal to EAN code.
JAN 8

Barcode functions and fonts are deprecated in PrintShop Mail 7.0 for Windows. We strongly advise using the "Barcode
Object" (page 86) instead.

Syntax JANS(Text)
Description Computes JANS8 barcode.
Example  JANS8("1234567")

Result

Parameter description
Text Any text expression or data field containing a text to be represented by the barcode.

JAN (Japanese Article Number)

JAN code is most popular barcode. JANS is called simplified code.

JANS represents fixed length 8 digits number. It requires fixed length 7 digits of numeric characters for input.
MOD10 check digit is automatically calculated and added.

This barcode is composed of 2 numbers for the country code, 5 numbers for the data characters, and a checksum. The check-
sum is generated automatically.

For JAN barcodes the first two numbers must be 45 or 49 which identifies Japan.
JAN code is equal to EAN code.
KIX

Barcode functions and fonts are deprecated in PrintShop Mail 7.0 for Windows. We strongly advise using the "Barcode
Object" (page 86) instead.

Syntax KIX(Postcode, Street address number,Country code)
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Description Computes a KIX barcode. KIX barcode are used by the Dutch post office for bulk mail addressing.
Example  KIX("3842BX", "Daltonstraat 42-44", "NL")
Result NL3842BX

Parameter description

Postcode Any text expression or data field containing a text.
Street address number Any text expression or data field containing a text.
Country code Any text expression or data field containing a text.

KIX barcode are used by the Dutch post office for bulk mail addressing.
Itis imperative that the point size of the KIX code fontis 10 point.
MSI Plessey

Barcode functions and fonts are deprecated in PrintShop Mail 7.0 for Windows. We strongly advise using the "Barcode
Object" (page 86) instead.

Syntax MSI(Text)
Description Computes a MSI Plessey barcode.
Example  MSI("1234567890")

il

Parameter description

Result [‘

Text Any text expression or data field containing a text. Numbers must be provided as text.

The MSI Plessey barcode was designed in the 1970s by the Plessey Company in England and is used primarily in libraries and
retail applications.

This is a numeric only code that stands up well to frequent use.
This code is not self checking, a checksum is highly recommended.

The symbology of the MSI Plessey character set consists of barcode symbols representing the numbers 0-9, the start char-
acter and the stop character.

NwW?7

Barcode functions and fonts are deprecated in PrintShop Mail 7.0 for Windows. We strongly advise using the "Barcode
Object" (page 86) instead.

Syntax NW?7 (Text, Start character, Stop character, Check digit)
Description Any expression which results in a logical value, example: True or False.
Example NW?7("123456", "A", "B", True)

Result |I | |||I ||| |II ""I I
A 1 2 3 o -

¥
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Parameter description

Text Any text expression or data field containing a text to be represented by the barcode.

Start character Start character.

Stop Character Stop character.

Check digit Optional, True or False. Default value is False.

NW?7 is used at library, parcel delivery service and various other purposes.

NW?7 supports variable length number up to 100 digits.
When use DR7 / DSR7 / DR9 / DSR9 and if original text includes more than 16 digits of numeric strings, error will be returned.
ONECODE

4 Barcode functions and fonts are deprecated in PrintShop Mail 7.0 for Windows. We strongly advise using the "Barcode
Object" (page 86) instead.

Syntax ONECODE(BarcodelD, ServiceTypelD, MailerID, SerialNo [,Zipcode])
Description Computes a ONECODE solution barcode. OnceCode is now named Intelligent Mail Barcode or IMB.
Example  ONECODE("10","042","123456","123456789",[""])

Resutt ([l ot ooyl oo I ooty 1

Parameter description

BarcodelID String of 2 digits. The first digit should be in the range of 0-9, the second digit should be in the range of 0-4.
ServiceTypelD String of 3 digits

MailerID String of 6 or 9 digits, depending on the SerialNo length. Both together should total 15 characters.
SerialNo String of 9 or 6 digits depending on the length of MailerID.
Zipcode Optional string of 0, 5, 9 or 11 digits corresponding to a zip code. Should not contain dashes (-).

For more information about the ONECODE barcode, which is now named the Intelligent Mail Barcode or IMB, please visit
www.ribbs.usps.gov/onecodesolution.

POSTNET

,+ Barcode functions and fonts are deprecated in PrintShop Mail 7.0 for Windows. We strongly advise using the "Barcode
Object" (page 86) instead.

Syntax POSTNET (Text[,Street address number])

Converts a 5 digit (zip code), 9 digit (zip+4 code), or an 11 digit (delivery point barcode) to a valid POSTNET
barcode.

Example POSTNET("12345-6534","152 Oxford Street")
Ts sl bl Mhao Baal o Bl Blaaa Bl s Bl s Buall i Ballaa slall Bl

Description

Result
'125‘3*’v§f‘_uﬂj';ifj2;j.
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Parameter description

Text Any text expression or data field containing a text to be represented by the barcode.

Street address  Any text expression or data field containing a text to be represented by the barcode. The delivery point
number number is calculated from this text.

POSTNET (Postal Numeric Encoding Technique)

This barcode is the special code that is placed on the lower right portion of an envelope.

Itis used to speed mail through the postal service (by automated sorting) and get reduced rates.
Start and stop characters are automatically added by PrintShop Mail.

Itis recommended that you have an U.S Postal Service Mailpiece Design Analyst review and approve all POSTNET barcodes
generated from PrintShop Mail. The Mailpiece Design Analyst is trained to analyze POSTNET barcodes and determine whether
or not they meet the U.S Postal Service's technical requirements. Output can be send to them via email (digital file) fax or mail.
Point your Web browser to: http://pe.usps.gov/mpdesign/mpdfr_mda_lookup.asp to find the name and contact information
for the Mailpiece Design Analyst that is assigned to your geographical area.

UPCA

4 Barcode functions and fonts are deprecated in PrintShop Mail 7.0 for Windows. We strongly advise using the "Barcode
Object" (page 86) instead.

Syntax UPCA(Text, System number)
Description Computes a UPCA barcode

Example  UPCA("123456789", 0)

i 123#5“5#311 3

Result

Parameter description

Text Any text expression or data field containing a text to be represented by the barcode.
System number Numeric expression or data field containing a number which results in a one digit system number (0-9).

UPC is the standard barcode for items for sale to the public. It is the code seen on items at the local supermarket. UPCA is a
fixed length, numeric only barcode.

It contains:

« 1digit for a system number

« 5digits for the manufacturer number
« 5digits for the product number

« One checksum digit

The position and value of the digits is standardized by a grocery industry committee. UPCA and UPCE also allow two or five
digit supplemental numbers.

UPCA and UPCE codes have an automatic checksum.

Only tags with the system character of 0 can be encoded with this symbology.
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UPCE

4 Barcode functions and fonts are deprecated in PrintShop Mail 7.0 for Windows. We strongly advise using the "Barcode
Object" (page 86) instead.

Syntax UPCE(Text)
Description Calculates an UPCE barcode
Example  UPCE("123456")

0 "125436" 5

Parameter description
Text Any text expression or data field containing a text to be represented by the barcode.

UPCE is ideal for small packages, because it is the smallest barcode available. This symbology contains the same information
as UPCA, except that at least four zeros are suppressed.

The position and value of the digits is standardized by a grocery industry committee. UPCA and UPCE also allow two or five
digit supplemental numbers.

UPCA and UPCE codes have an automatic checksum.
Only tags with the system character of 0 can be encoded with this symbology.
YUBAR

4 Barcode functions and fonts are deprecated in PrintShop Mail 7.0 for Windows. We strongly advise using the "Barcode
Object" (page 86) instead.

Rolan barcode consists of YUBAR.

YUBAR is for Japanese postage barcode defined by Postal Services Agency.

Syntax YUBAR(Address code, Postal code)
Description Computes a YUBAR barcode
Example  YUBAR("1-1-11","1030013")

Result (1] CEYY LY BT Y| YL | B O CE 8 | D ERTEETLETLETLELETLETA Y LA
Parameter description

Address code Any expression or text field to represent the address code.
Postal code Any expression or text field to represent the address code.

YUBAR is Japanese postal barcode named Yusei Customer Barcode.

Layout Functions

You can use the following layout functions in PrintShop Mail:
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« Blank

o Print

. Skip
Use these functions to specify which layout should be printed, left blank, or skipped.
PRINT and BLANK commands won't influence the amount of printed pages.

To edit layout conditions

1. Go to the layout for which you want to change the expression.

2. From the Layout menu, select Edit Condition or select the layout in the Layout panel, in the properties click on
Action.

3. Select one of the layout functions.

Example

A specific page must go to clients of a specific sales representative ("John"). This field is called 'SALES REP' in the database.
The expression used is:

IF([SALES_REP] = "John", Print, Skip)

When PrintShop Mail encounters the name "John" in the "SALES REP" field, it prints the page. In all other cases, the page will
be skipped.

Note: Fiery FreeForm does not support the SKIP function. BLANK is used instead.
Fiery FreeForm 2 uses BLANK instead of SKIP when Layout Conditioning is used in combination with Layout Repetition.

Related Topics

"OBJECT_EMPTY" (page 141)

"Use Layout Conditioning" (page 92)

BLANK

Syntax BLANK

Layout action constant. If your layout condition evaluates to Blank, then the layout will be left blank when the
document is printed.

Example IF(VAL([AGE])<55,Print,Blank)

Description

PRINT

Syntax PRINT
Description Layout action constant. If your layout condition evaluates to Print, then the layout will be printed.
Example IF([SALES_REP] = "John", Print, Blank)

In this example, the layout is printed when PrintShop Mail finds the name "John" in the "SALES_REP" field of the database.
SKIP
Syntax SKIP

Description Layout action constant. If your layout condition evaluates to Skip, then the layout will be skipped.
Example IF([SALES_REP] = "John", Print, Skip)
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In this example, the layout is skipped when PrintShop Mail finds anything else but the name "John" in the "SALES_REP" field of
the database.

Logical Functions
You can use the following logical operators to define conditions in PrintShop Mail:

. AND

« FALSE

o FILE EXIST

. IF

. NOT

« OBJECT_EMPTY
. OR

. TRUE

AND

Syntax (Logical value 1) AND (Logical value 2)
Description Returns True if both <Logical value 1> and <Logical value 2> are True.
Example False AND True => False

Parameter description

Logical value 1 Logical expression.
Logical value 2 Logical expression.

CHANGED
CHANGED returns True if the current expression result differs from the result of the previous record.

Syntax CHANGED(Expression)

Descrintion Determines if the result of <Expression> has changed compared to the previous record. The previous record
P is the current record minus one. CHANGED will return False for record 1.

CHANGED([Customer])
IF (CHANGED([zipcode]), Print, Skip)

Examples
Parameter Description

Expression Expression to evaluate for the current record and the previous record.
FALSE

Syntax False

Description Logical constant False

Example (1<10) = False => False

The result of the example is "False", "1<10", which is True, does not equal "False".
FILE_EXIST

Syntax FILE_EXIST (Filename)
Description Returns True if the <filename> exist on disk.
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Example  FILE_EXIST([Image])

Checks whether a resource, for example an image file exists on your computer. This function returns "True", if the image exist
on disk.

Parameter description

Filename Filename of file to check the existence of. Any text expression or data field containing a text.
IF

This function manipulates the database output without changing the content. Its purpose is to make a conditional selection
from the database.

Syntax IF(Logical test, Value if True, Value if False)

. .. Gives one of two results depending on a condition you specify. Returns <Value if True> when <Logical test>
Description .

is True, and <Value if False> otherwise.
Example IF([GENDER]="M", "Mr.", "Mrs.")

In this example, the IF function checks the database field [GENDER], if it contains "M", it returns the string "Mr.". If the data-
base field contains anything else, it returns "Mrs".

Parameter description
Logical test Logical expression that determines which of the 2 parameters values will be returned.

Value if True Any expression of fieldname. Will be returned if test condition evaluates to True.
Value if False Any expression of fieldname. Will be returned if test condition evaluates to False.

You can use the IF function, for example, to create a salutation. See "Inserting a Salutation".

NOT

Syntax NOT(Logical value)
Description Returns True if <Logical value> is False, and False otherwise.
Example NOT(True)=>False

Parameter description

Logical value Any expression which results in a logical value, example: True or False.
OBJECT_EMPTY

(Windows only)

Syntax OBJECT_EMPTY(Object name)
Description Determines whether an object with the specified name is empty. Returns True or False.
Example  OBJECT_EMPTY("Textl")

Parameter description

Object name Name of the object to check.

Checks whether the name of an object exist, even when moving objects backward or forward on the same layout or to
another layout.

This function can also be called upon via the menu Layout>Skip if Object is Empty.
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Syntax Logical value 1 OR Logical value 2

Using Expressions

Description Returns True if either <Logical value 1> or <Logical value 2> is True.

True OR False => True
False OR True => True
True OR True => True
False OR False => False

Example

Parameter description

Logical value 1 Logical expression.
Logical value 2 Logical expression.

TRUE

Syntax True
Description Logical constant True
Example (1<10) = True =>True

This example returns "True", because the logical test (1<10) is true.

Number Functions

You can use the following functions to manipulate numbers and values in PrintShop Mail:

. ABS

. CHR

« COUNTER

+ DIV

. INT

« LAYOUT COUNT
« LAYOUT NR

. MOD

« PAGE _COUNT

« PAGE_NR

« RECORD_COUNT
« RECORD_NR

« ROUND

. SGN

. VAL

ABS

Syntax ABS(Number)
Description Returns the absolute value of <Number>.
Example  ABS(-2.3) => 2.3

Parameter description

Number Numeric expression or data field containing a Number.
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CHR

Syntax CHR(Number)

Description Returns the character represented by UNICODE index <Number>.
Example CHR(97)=>"a"

Parameter description

Number UNICODE index of character to represent.
Notes

« CHR produces a UTF-16 encoded UNICODE character consisting of 2 bytes.

« You can find the code point for any character using Microsoft's Character Map application, which you can access by
going in Start, Run, typing charmap and click OK.

« The output of CHR should not be used in the data input for a Data Matrix barcode. Instead, the Encoding properties of
the barcode object should be set to Hexadecimal and a hex-encoded string should be used.

COUNTER

Syntax COUNTER([Start value][,End value] [,Step size] [,Number of positions] [,Leading zeroes])
Description A counter which by default counts from the first to the last record. Arguments are optional.
COUNTER (1,100)
Example COUNTER (1,100, 5, 3, True)
COUNTER (1, 100, 0.5, 3, False)

Parameter description

Start value The start value of the counter. Default 1 .

The end value of the counter. If no value is specified, the counter is never reset and will go until the
End value

end
Step size The step size to the next number. Default 1.
Number of pos- The number of characters the counter will create. By default no extra characters will be added.
itions Default 0.
Leading zeroes True for leading zeroes, False for no leading zeroes (default).

You can use a counter when printing tickets or numbering your mailing. You do not need to open a database within PrintShop
Mail when using a COUNTER, if this is the only variable.

Example 1
The first example creates numbers, starting with 1 and ending with 100.
Code:
COUNTER (1,100)
Result:

1,2 3,4,[..]1,99 100, 1, 2, 3, [...]

l '+| The counter restarts once it has reached the end, in this case 100.

Example 2
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The Second example has a step of 5, meaning it will only display every 5th number. The parameters step size, humber of pos-
itions and leading zeroes have been added.

Code:

COUNTER (5,100, 5, 3, True)
Result:

005, 010, 015, [...], 090, 100, 005, 010, [...]
Example 3
The third example has a fraction for the step size. This means that the counter increases by 0.5.
Code:

COUNTER (1, 100, 0.5, 3, False)
Result:

1, 1.5, 2, 2.5, 3, [...], 99.5, 100, 100.5, [...]
Example 4

The last example, COUNTER() starts with 1 and ends at whatever number is set in Items without database (Program set-
tings in the Preferences).

DIV

Syntax DIV(Number,Divider)
Description Returns the integer quotient from dividing <Number> by <Divider>.
Example DIV (25,3)=>8

Both may be a floating point number, and an integer result is returned.

Parameter description

Number Numeric expression or data field containing a number.
Divider Numeric expression or data field containing a number.

INT

Syntax INT(Number)
Description Returns the integral part of floating point number <Number>.
Example INT(2.78)=>2

Parameter description
Number Numeric expression or data field containing a number.
LAYOUT_COUNT

Syntax LAYOUT_COUNT()
Description Returns the total numbers of layouts for the current record of the database.
Example LAYOUT_COUNT()=>10
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LAYOUT_NR

Syntax LAYOUT_NR()
Description Returns the current layout number.
Example LAYOUT_NR()=>3

Note: When using layout conditions, the function LAYOUT_NR will respect the SKIP argument. When using PRINT and
BLANK, the LAYOUT_NR function will return the number for those layouts.

MOD

Syntax:

MOD (number, divider)
Attributes:

« number: Numeric expression or data field containing a number.
« divider: Numeric expression or data field containing a number.

Returns:
The remainder of the first number divided by the divider.

Example Uses

MOD (20, 9) => 2 // Returns true
MOD (5, 3) // Returns 2
MOD (5.5, 3) // Returns 2.5
PAGE_COUNT

Syntax PAGE_COUNT()
Description Returns the total numbers of pages at printing for this document.
Example PAGE_COUNT()=>10

PAGE_NR

Syntax PAGE_NR ([Reset after each record])

Returns the page number at printing. If <Reset after each record> equals TRUE, the page number will be reset
to "1" after each record.

Example PAGE_NR()=>10

Description

Parameter description

Input number Truetoresetto 1 after each record. Leave empty to increment the page number continuously through-
value out all printed records.

This function can also be called upon via the menu:
Insert>Page Numbers
Entire Job: Prints the page number for the entire job.

Reset After Each Record: Prints the layout number within a record set.
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RECORD_COUNT

Syntax RECORD_COUNT()

Description Returns the total number of records of the database.
Example RECORD_COUNT()=>10

RECORD_NR

Syntax RECORD_NR()

Description Returns the current record number of the database.
Example RECORD_NR()=>10
The function RECORD_NR() yields the current record number. It has no arguments and it does not perform any calculations.

When no records are filtered out and no BLANK is used as a layout expression, it simply increases 1 ata time.
ROUND

Syntax ROUND(Number, Precision)

Description Returns the supplied number rounded off to the specified number of decimal places.
Example ROUND (1.678,2) => 1.68

Parameter description
Number Numeric expression or data field containing a number.

Precision Number of decimal places. Numeric expression or field containing a numeric expression.
SGN

Syntax SGN(Number)

Description Returns one of three possible values (-1,0 or 1), depending whether the number is negative, zero, or positive.
Example  SGN (-345) => -1

Parameter description

Number Numeric expression or data field containing a number.

TOTALPAGES

Syntax TOTALPAGES(Filename)

Description Returns the number of pages in a PDF file, or the number of frames in a multi-frame TIFF or GIF file.
Example  TOTALPAGES("Example.pdf') => 10

Parameter Description

Filename Path to a PDF, TIFF or GIF file.
VAL

Syntax VAL(Text)

Description Returns number in text as data type Number, for use with formulas involving numbers or numeric functions.
Example VAL("123")=> 123
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Parameter description
Text Any text expression or data field containing a text to be converted to a numeric value.

You can use this function to convert text fields to fields that hold a value.

If you have a text field that holds number characters, you can convert that field so you can do calculations with it.
Example:

The field [COUPON] holds a text, (for example, "7")

VAL([COUPON])/365 => 0.02

String Functions
You can use the following functions to manipulate strings in PrintShop Mail:

. ASC

« CONTAINS
. DATE

. LEFT

. LEN

« LOWER

e« LTRIM

« MID

. POS

« PROPER

« REPLACE
e RIGHT

« RTRIM

. SR

o« TEXT FILE
« TODAY

. TRIM

« UPPER

ASC

Syntax ASC(Text)
Description; Converts the leading character in <Text> to its numeric UNICODE value.
Example ASC ("abc") => 97

Parameter description
Text String from which to get UNICODE code from first character.
CONTAINS

Syntax CONTAINS(text, Text to find)
Description Returns True if<Text> contains<Text to find>, returns False otherwise.
Example  CONTAINS("PrintShop", "Mail")=>False

Parameter description

text Any text expression or data field containing a text.
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Text to find Any text expression or data field containing a set of characters you want to verify the existence of.

Searches for a given text in another given text. This example returns "False", because the text ("PrintShop"), does not contain
the text to find ("Mail").

DATE

Windows

Syntax DATE(Input date string[,Date string format])

Returns the current date, formatted according to <Date string format> (optional) or the system regional set-
tings.

Example DATE(database field, "DD MMMM YYYY") or DATE("19740227",").

Description

Parameter description

Input date string Datein"YYYYMMDD" format (Example: 20070206).
Date string format Enter the output date format. Use the D, Mand Y symbols to represent the date.

You can use the following parameters for "date string format":

d Number of the day, no leading zero 1

dd Number of the day, with leadingzero 01
ddd Short weekday name Mon
dddd Longweekday name Monday
m Number of the month, no leading zero 6
mm Number of the month, with leading zero 06
mmm  Short month name Jun
mmmm Long month name June
Yy Short year notation 01
YYyY Long year notation 2001
Mac 0S

Itis possible to specify the format of the expression with format specifiers as shown below. These can be used with the DATE
and the TODAY function.

Format Spe-

cifier P Result

%% A"%" character

%a Abbreviated weekday name

%A Full weekday name

%b Abbreviated month name

%B Full month name

%cC Shorthand for "%X %x", the locale format for date and time

%d Day of the month as a decimal number (01-31)

%e Same )als %d but does not print the leading 0 for days 1 through 9 (unlike strftime(), does not print a leading
space
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Form =

ci?‘ler atSpe Result

%F Milliseconds as a decimal number (000-999)

%H Hour based on a 24-hour clock as a decimal number (00-23)

%]l Hour based on a 12-hour clock as a decimal number (01-12)

%ij Day of the year as a decimal number (001-366)

%m Month as a decimal number (01-12)

%M Minute as a decimal number (00-59)

%p AM/PM designation for the locale

%S Second as a decimal nhumber (00-59)

%w Weekday as a decimal number (0-6), where Sunday is 0

%x Date using the date representation for the locale, including the time zone (produces different results from strf-
time())

%X Time using the time representation for the locale (produces different results from strftime())

%y Year without century (00-99)

%Y Year with century (such as 1990)

%Z Time zone name (such as Pacific Daylight Time; produces different results from strftime())

%z Time zone offset in hours and minutes from GMT (HHMM)

Examples:

You can use the format specifier to generate different results.

DATE() - Yields a date according to the specified format or according to the date preferences (specify format:"™)
DATE("20020701", ") => 2002-07-01 00:00:00 +0000

DATE("20020701","%m-%d-%y") => 07-01-02

DATE("20020701","%m-%d-%y") will give 07-01-02

DATE("20020701","%b-%A-%Y") will give Jul-Monday-2002

DATE("20020701","%B-%w-%Y") will give july-1-2002

TODAY() - Yields today's date according to the specified format or according to the date preferences (if format="")
TODAY("") => "2002-11-07 12:40:10 +0100"

TODAY("%A %d-%m-%Y %H:%M:%S") => Thursday 07-11-2002 12:40:10

LEFT

Syntax LEFT(Text, Number of characters)
Description Returns the specified number of characters in the supplied text, counting from the left.
Example  LEFT ("Personalized Printing", 6) => Person

Parameter description

Text Any text expression or data field containing a text.
Number of characters Numeric expression or data field containing the number of characters to get.

This function allows you to print a number of characters, counting from the left side of the value in the defined database field.
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You can use this function to separate field content or to create a unique code with parts of someone's name.

LEN

Syntax LEN(Text)
Description Returns the number of characters in <Text>.
Example LEN ("Personalized Printing") => 21

Parameter description
Text Any text expression or data field containing a text.

You can use this function to calculate the length (the number of characters) of the database field. For example, certain ZIP
codes or barcodes might need to have a specific number of characters to print correctly.

LEN is often used in combination with other functions, such as LEFT, RIGHT, MID and IF, where it can be used to determine
exactly how many characters are printed of a selected database field.

In the following example, IF and LEN are combined to calculate the length of the "gender" database field. It also ensures that
fields without text, but with spacing, are recognized and eventually the correct output is generated.

First Name Last Name Gender

John Abrahams M
Theresa Johnson F
William Fremont M
Tom Cooper

IF(LEN([GENDER]) = 0, "Dear Sir, Madam", IF([GENDER] = "m", "Dear Mr." & [Name], "Dear Ms" &
[Name] ) )

The resultis:

Dear Mr John Abrahams
Dear Ms Theresa Johnson
Dear Mr William Fremont
Dear Sir, Madam

LOWER

Syntax LOWER(Text)
Description Returns all letters in the given text as lowercase.
Example LOWER ("Personalized Printing") => personalized printing

Parameter description
Text Any text expression or data field containing a text.

This function allows you to print the selected database fields in lowercase.

For example, if your database is filled out with information in capitals, you could use this expression to amend this.
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LTRIM

Syntax LTRIM(Text)

Description Returns the supplied text, stripped of all leading spaces, tabs and newline characters.
Example LTRIM("12")=>"12"

Parameter description

Text Any text expression or data field containing a text.

This function removes extra spacing (at the left side of the word) in a combination of variables (for example, when the data-
base has set a defined number of characters for each particular database field or when a database field is left empty).
MID

Syntax MID(Text, Start position,Size)

. .. Extracts characters from the supplied text, starting at the character position specified by start position and con-
Description . . . .
taining the number of characters specified by size.

Example  MID ("Personalized Printing", 5, 4) => onal

Parameter description

Text Any text expression or data field containing a text.

Start position Any numeric expression or data field containing a number (start position to get characters from).
Size Any numeric expression or data field containing the number of characters to get.

This function allows you to print a number of characters of the value in the defined database field.

With MID, you can decide which character you want to start with and how many characters from that point onwards you want
to print.

POS

Syntax POS(Text, String to find, Start position)

Description Returns the character position of a searched string in text. Returns 0 if not found.
Example  POS("Personalized Printing", " ", 1) => 13

A

Parameter description

Text Any text expression or data field containing a text.
String to find String to search for.

Start position Position to start search from.

This function allows you to search for certain character in the value of a database field. The result will be the position of the
character you are searching for.

PROPER
Syntax PROPER(Text)

Description Converts the first letter of each word to an uppercase character, and the rest to lowercase.
Example  PROPER ("PERSONALIZED printing") => Personalized Printing
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Parameter description

Text Any text expression or data field containing a text.

This function allows you to clean up improperly filled out databases or to amend all lowercase or all uppercase information.
REPLACE

Syntax REPLACE(Text, Text to find, Replace with text)
Description Looks for<Text to find> in <Text> and replaces every occurrence with <Replace with text>.
Example  REPLACE("PrintShop Mail", " ", ") => PrintShopMail

Parameter description

Text Any text expression or data field containing a text.
Text to find Any text expression or data field containing a text.
Replace with text String to replace occurrences of <Find string>. Any text expression or data field containing a text.

RIGHT

Syntax RIGHT(Text, Number of characters)
Description Returns the specified number of characters in the supplied text, counting from the right.
Example  RIGHT ("Personalized Printing", 8) => Printing

Parameter description

Text Any text expression or data field containing a text.
Number of characters Numeric expression or data field containing the number of characters to get.

Use this function to separate field content or create a unique code with parts of someone's name.

RTRIM

Syntax RTRIM(Text)
Description Returns the supplied text, stripped of all trailing spaces, tabs and newline characters.
Example RTRIM("12")=> 12

Parameter description
Text Any text expression or data field containing a text.

This function removes extra spacing (at the right side of the word) in a combination of variables. For example, you can use this
function when the database sets a defined number of characters for each particular database field or when a database field is
left empty.

STR

Syntax STR(Number)
Description Returns the supplied number as data type Text, for use with formulas involving text or text functions.
Example  STR(123.55)=> 123.55

Parameter description

Number Numeric expression or data field containing a number.
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TEXT_FILE

(Windows only)

Creating variable text blocks, such as paragraphs and bodies of letters is easier with the TEXT_FILE function. The ability to
read .RTF (Rich Text Format) and .TXT files eliminates the need to copy and paste text strings into Expression logic formulas.

Syntax TEXT_FILE(Filename)
Description Returns the contents of the TXT or RTF file<Filename>
Example  TEXT_FILE("TEST.TXT")

Parameter description

Filename Any text expression or data field containing a text which holds the Filename of TXT or RTF file.

Allows you to link variable (external) text files in .RTF or .TXT text format to your PrintShop Mail document.

TODAY

Syntax TODAY ([Number])

Returns the current date, according to the computers internal calender, formatted according to the system
regional settings.

Example  TODAY() => 20070208

Description

Parameter description
Number The amount of days added to the current date. Numeric expression or field containing a number.

This function takes no arguments. It returns the current system date (at the time the current record is printed).
The date format depends on the preferences defined in regional settings.
TRIM

Syntax TRIM(Text)

Description Returns the supplied text, stripped of all leading and training spaces, tabs and newline characters.
Example TRIM("12")=>12

Parameter description
Text String to remove leading and trailing spaces, tabs and newline characters from.

This function removes extra spacing in a combination of variables (for example, when the database has set a defined number
of characters for each particular database field or when a database field is left empty).

TRIM removes any extra spacing at the left and at the right side of the word in the database field that has been selected.

UPPER

Syntax UPPER(Text)

Returns all letters in the given text as uppercase. Use the UPPER function to ensure consistent data entry of
such things as state abbreviations or postal codes.

Example  UPPER ("Personalized Printing") => PERSONALIZED PRINTING

Description
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Parameter description
Text Any text expression or data field containing a text.

You can use this function to print the selected database field in capital letters.

If you are creating a mailing for which you need to print the names in capitals, although the names in the database are in lower-
case, perform the conversion with UPPER.
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L4 License Agreement

PrintShop Mail User Guide

ELECTRONIC END USER LICENSE AGREEMENT FOR PRINTSHOP MAIL

NOTICE TO USER: THISIS A CONTRACT. BY INSTALLING THIS SOFTWARE YOU ACCEPT ALL THE TERMS AND
CONDITIONS OF THIS AGREEMENT.

This Objectif Lune End User License Agreement accompanies the PrintShop Mail product and related explanatory materials
("Software™). The term "Software" also shall include any upgrades, modified versions or updates of the Software licensed to
you by Objectif Lune. Please read this Agreement carefully. Upon your acceptance of this Agreement, Objectif Lune grants to
you a nonexclusive license to use the Software, provided that you agree to the following:

1. Use of the Software.
You may install the Software on a hard disk or other storage device; install and use the Software on a file server for use
on a network for the purposes of:
(i) permanent installation onto hard disks or other storage devices or
(ii) use of the Software over such network; and make backup copies of the Software.

You may make and distribute unlimited copies of the Software, including copies for commercial distribution, as long as
each copy that you make and distribute contains this Agreement, the PrintShop Mail installer, and the same copyright
and other proprietary notices pertaining to this Software that appear in the Software. If you download the Software
from the Internet or similar on-line source, you must include the Objectif Lune copyright notice for the Software with
any on-line distribution and on any media you distribute that includes the Software.

2. Copyright.
The Software is owned by Objectif Lune and its suppliers, and its structure, organization and code are the valuable
trade secrets of Objectif Lune and its suppliers. The Software also is protected by Dutch Copyright Law.

3. Restrictions.
You agree not to modify, adapt, translate, reverse engineer, decompile, disassemble or otherwise attempt to discover
the source code of the Software. You may not alter or modify in any way the installer program or create a new installer
for the Software. The Software is licensed and distributed by Atlas for creating optimized print jobs.

4. No Warranty.
The Software is being delivered to you AS IS and Objectif Lune makes no warranty as to its use or performance.

OBJECTIF LUNE AND ITS SUPPLIERS DO NOT AND CANNOT WARRANT THE PERFORMANCE OR RESULTS YOU MAY
OBTAIN BY USING THE SOFTWARE OR DOCUMENTATION. OBJECTIF LUNE AND ITS SUPPLIERS MAKE NO
WARRANTIES, EXPRESS OR IMPLIED, AS TO NONINFRINGEMENT OF THIRD PARTY RIGHTS, MERCHANTABILITY,
OR FITNESS FOR ANY PARTICULAR PURPOSE. IN NO EVENT WILL OBJECTIF LUNE ORITS SUPPLIERS BE LIABLE TO
YOU FOR ANY CONSEQUENTIAL, INCIDENTAL OR SPECIAL DAMAGES, INCLUDING ANY LOST PROFITS OR LOST
SAVINGS, EVEN IF AN OBJECTIF LUNE REPRESENTATIVE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES, OR FOR ANY CLAIM BY ANY THIRD PARTY.

Some states or jurisdictions do not allow the exclusion or limitation of incidental, consequential or special damages, or
the exclusion of implied warranties or limitations on how long an implied warranty may last, so the above limitations
may not apply to you.

5. Governing Law and General Provisions.
This Agreement will be governed by the laws of the Netherlands, excluding the application of its conflicts of law rules.
This Agreement will not be governed by the United Nations Convention on Contracts for the International Sale of
Goods, the application of which is expressly excluded. If any part of this Agreement is found void and unenforceable, it
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will not affect the validity of the balance of the Agreement, which shall remain valid and enforceable according to its
terms. You agree that the Software will not be shipped, transferred or exported into any country or used in any manner
prohibited by any export laws, restrictions or regulations. This Agreement shall automatically terminate upon failure by
you to comply with its terms. This Agreement may only be modified in writing signed by an authorized officer of Objec-
tif Lune.

Objectif Lune Inc.
2030 Pie IX, Suite 500
Montréal, QC

Canada H1V 2C8

www.objectiflune.com

YOUR ACCEPTANCE OF THE FOREGOING AGREEMENT WAS INDICATED DURING INSTALLATION.

©2016 Objectif Lune Inc - 156 - PRINTSHOP MAIL [


http://www.objectiflune.com/

Contact Information

P4 Contact Information

To find an Objectif Lune office near you and for more information on our products and services, visit www.objectiflune.com.
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Trademarks

F4 Trademarks

PrintShop Mail

All trademarks referenced in this user's guide and the PrintShop Mail application, are the trademarks or registered trademarks
of their respective holder.

« Adobe,Acrobat, PostScript and all related products are registered trademark of Adobe System Incorporated.
« Theincluded Adobe ICC Profiles are copyright of Adobe System Incorporated.

o LibTIFF : Copyright (c) 1988-1997 Sam Leffler; Copyright (c) 1991-1997 Silicon Graphics, Inc.

« Apple and Macintosh are registered trademarks of Apple Computer, Inc.

« CreoVPSis a registered trademark of Creo Corporation Ltd.

« PPML is a registered trademark of PODi.

« VIPPis a registered trademark of Xerox Corporation.

o PrintStreamer is a registered trademark of Barco

« Windows, Word and Excel are registered trademarks of Microsoft in the U.S. and other countries.
« PlanetPress Suite is a registered trademark of Objectif Lune Inc.

« PrintShop Web is a registered trademark of Objectif Lune Inc.
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P4 Index

About

PrintShop Mail Design 9

Databases

Custom SQL 77

VDP 9
) ) Delimited Text Files 81
Align Objects 37 Filter 77
Anchor Objects 38 ODBC 76
Arrange Objects 37 Open 76
. Select Table 76
Automation
: Sort 77
Command Line 110
Supported Formats 78
DDE 115
- Toolbar 21
Extended Scripting 111
XML 78
HotFolder 116
DDE 115
Barcode
Data 33 Dialogs
Encoding 33 Expression Editor 119
Functions 130-138 Main 15
Object 86 Print 103
Properties 32 Print Preview 103
Supported Types 86 Printto Web 106
Type 33 DirectSmile
Bring to Front 38 Host 34
Object 91
Colors .
Properties 34
Management 47 .
. ) Variables 34
Monitor Profiles 49
_ Document
Command Line Arguments 110 .
Verify 99
Condition
Documents
Layout 31
Create 71
Constants Create from PDF 71
FALSE 140 Create from template 71
Functions 139 Print 103
TRUE 142 Publish 107
Copy Fitting 27 Save 100

Copy Objects 36 Templates 72

Creo VPS 53 Dongle
Automation 109-111, 115

v 8l Credits 13
Cut and Stack 93 Cross Platform 14
Data Fields Drivers 12

Create without database 24 Installing 12

Information 24 Upgrade 14

Panel 23 Edit

Type 24 Expression 119
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EPS
Spot Colors 76

Expressions
Building 120
Editor 119
Examples 125-126
Favorites 124
Functions 127

Operators 123
Favorite Expressions 124
Fiery FreeForm See Print Technology, FreeForm

Fonts
Location 41
Panel 25

FreeForm See Print Technology, FreeForm

Functions
ABS 142
ASC 147
Barcode 130-138
BLANK 139
CHANGED 140
CHR 143
CODABAR 130
CODE128 131
CODE39 131
CONTAINS 147
COUNTER 143

LTRIM 151

MID 151

MOD 145

MSI 135

NOT 141
Numbers 142-146
NW7 135
OBJECT_EMPTY 141
ONECODE 136
PAGE_COUNT 145
PAGE_NR 145
POS 151
POSTNET 136
PRINT 139
PROPER 151
RECORD_COUNT 146
RECORD_NR 146
REPLACE 152
RIGHT 152
ROUND 146
RTRIM 152

SGN 146

SKIP 139

STR 152

Strings 147-153
TEXT_FILE 153

DATE 148 TODAY 153

DIV 144 TOTALPAGES 146

EAN13 132 TRIM 153

EANS 132 UPCA 137

FILE_EXIST 140 UPCE 138

IF 141 UPPER 153

INT 144 VAL 146

ITF 133 YUBAR 138

JANL3 133 HotFolder 116

JANS 134

KIX 134 Image Object

Layout 139 Expression 85

LAYOUT_COUNT 144 PDF 85

LAYOUT_NR 145 Static 83

LEFT 149 Variable 84

LEN 150 Images

Logical 140-142 Properties 29

LOWER 150 Source 30
©2010 Objectif Lune Inc - 162 - PRINTSHOP MAIL i |



Supported Formats 65
Two-Colors 30

Imposition
Bleed Margins 58
Crop Marks 58
Folding Lines 59

Kerning See Text, Kerning
Keyboard Shortcuts 65

Layout
Repetition 93
Skip 31
Verify 99

Layouts
Action 31
Basics 61
Bleed Margins 58, 64
Condition 92
Crop Marks 58, 64
Duplicate 61
Folding Lines 59, 63
Guide Lines 62
Insert 61
Name 30
Number of Copies 31, 96
Page Setup 72
Panel 22
Paper Size 31
Paper Tray 31, 94
Properties 30
Remove 62
Repeat 57
Size 30,73

Linking text objects 38
Lock Objects 38

MacOS
Installing 12
Keyboard Shortcuts 67

Move Objects 35

Objects
Align 37
Anchor 38
Arrange 37
Barcode 86
Copy 36

DirectSmile 91
Image 83
Lock 38

Move 35
Paste 36

PDF 85

Resize 36
Select 34
Text 83

Operators
AND 140
OR 142

Operators in expressions 123

Page Setup 72
Imposition 58
Stapling 106
Subset Finishing 105

Panels
Data Fields 23
Fonts 25
Layouts 22
Properties 26
Variables 22
Verification Results 25
Warnings 24

Paper Trays 94

Paragraph
Align 42
Style 42

Paste Objects 36

PDF
Multipage 30
Print Technology 52
Print to Web 105

Save 105
VT-1 52

Persistent Variables 23, 92
Pipe-Delimited 81

PlanetPress Suite
Preferences 59
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Preferences
Colors 47
Defaults 60
Imposition 58
PlanetPress Suite 59
Print Job 49
PrintShop Mail Web 59
Program 46
Repetition 57

Print
Automation 109
Document 103
Duplex 57
Margins 50
Preview 103

Print Technology 50-51
Adobe PDF 52, 105
Adobe PDF/VT-1 52
AHT 53
Creo VPS 53
FreeForm 53
GDI Printing 52
Optimized PostScript 51
Options 104
PPML 54
PrintStreamer 56
Standard PostScript 51
VDX 55
VIPP 56

Print To Web
Dialog 106

Printers
Drivers 14
Install 14

PrintShop Mail Web
Login 59
Preferences 59
Printto 106
Publish to 107
Server 59

PrintTo Web
PDF 105

Properties
Barcode 32
Common 26

DirectSmile 34
Frame Group 26
Images 29
Layout 30
Layout Size 73
Object Group 26
Panel 26

Printing Group 27
Text 27

Variables 31

Publish
Documents 107

Records
Browse 24

Remove Empty Lines See Text, Remove Empty Lines
Repetition 57

Resize Objects 36

Restore Default Program Settings 60

Save Document 100

Save PDF 105

Scripts for Automation 111

Select
Objects 34
Print Technology 51

Send to Back 38
Settings See Preferences
Skip Empty Lines See Text, Remove Empty Lines

Software
Configure 46-47
Credits 13
Install 11
Language 46
Maintenance Contract 13
Upgrade 13

Spot Colors 74
Standard Toolbar 17

Stapling 106
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Style
Paragraph 42
Text 40

Tab Stops 43

Templates
Create 72
Modify 72

Text

Align See Paragraph, Align

Alignment 27

Content Group 27
Copy Fitting 27

Font 41

Formatting 40

Kerning 41

Link together 38
Properties 27

Remove Empty Lines 28
Style 40

Text Database 81
Text Formatting Toolbar 17
Text Link Toolbar 19

Text Objects
Add 83

Toolbars
Database 21
Objects 18
Standard 17
Text Formatting 17
Text Link 19
Tools 19
View 20

Tools Toolbar 19
Tracking See Text, Kerning

Variables 91
Category 31
Create 91
Currency 32
Date 31
DirectSmile 34
Edit Expression 23
Email 31
External file 153

From data fields 91
Number 32

Panel 22

Persistent 23, 31,92
Properties 23, 31
Text 31

Verification Results
Panel 25
Perform Verification 99
Save 25

View Toolbar 20

Warnings
Panel 24

Windows

Driver Output See Print Technology, GDI Printing

Installing 11
Keyboard Shortcuts 65

XML 78
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